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Chapter 1: Introducing HostExplorer
Hummingbird HostExplorer™ is a comprehensive PC-to-host connectivity 

product that delivers mainframe data to the desktop without the overhead 
of legacy protocols. HostExplorer connects desktop computers to IBM 
mainframes and IBM-compatible systems, to IBM midrange systems (the 
AS/400 family), and to ASCII character systems using Telnet.

The terminal emulation components (Telnet, TN3270, TN5250, and 
TN3151) provide fast access to corporate data and run with Windows NT/
95/98/2000/Me operating systems across corporate intranets and the 
Internet. 

HostExplorer uses Kerberos, which provides the necessary network tools to 
secure information systems across an entire enterprise.

HostExplorer Applications

HostExplorer includes the following applications:

HostExplorer TN3270     Emulates IBM mainframe terminals (including 
3179G, 3472G, 3278, and 3279 models), runs 3270 applications, and 
transfers files between a host machine and your PC using the IND$FILE file 
transfer application.

HostExplorer TN5250     Emulates IBM AS/400 terminals and runs 5250 
applications. 

5250 File Transfer Wizard     Lets you transfer files between a PC and an 
AS/400 host. If you transfer a file from the host to your PC, you can specify 
standard SQL statements to execute in the file. For more information, see 
“Transferring Files Using the 5250 File Transfer Wizard” on page 49.

FTP     Lets you connect to a remote FTP server and transfer files between 
computers. FTP is only supported under TCP/IP transports. You cannot use 
this application with DECnet or IPX/SPX. A server implementation of the 
FTP protocol must run on the remote computer to allow for FTP 
communication. The remote computer is the FTP server (host); and the PC 
running the Hummingbird FTP application is the FTP client.
3
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FTP for Windows Explorer     A client implementation of the File Transfer 
Protocol. It lets you transfer both text (ASCII) and image (binary) files 
between your PC and a remote computer running a server implementation 
of FTP. You can also use it to perform file and directory management on 
your PC and a remote computer. For more information, see “Chapter 6: 
FTP for Windows Explorer” on page 59.

LPQ     Returns the status of the print queue on either a UNIX system or 
another PC running any line-printer daemon.

LPR     Lets you print PC files to any host on a TCP/IP network running 
LPD. The LPR window displays a separate window for each printer queue to 
which you are connected.

Macro & Profile Converter     Lets you convert Wall Data RUMBA or 
Attachmate EXTRA! macros into Hummingbird Basic macros and 
Attachmate Extra! profiles into HostExplorer session profiles. For more 
information, see “Converting WallData Rumba Macros” on page 100 and 
“Converting Attachmate Extra! Macros and Profiles” on page 100.

PrintExplorer     Emulates IBM mainframe LU1/LU3 printers with 
TN3270E-capable host systems and 3812 printers with TN5250E-capable 
host systems.

Telnet     Emulates the DEC VT420 video terminal and includes support for 
VT52, VT100, VT101, VT102, VT220, VT320, VT420, ANSI, SCO ANSI, 
and IBM 3151.

WyseTerm     Emulates Wyse-50 and Wyse-60 terminals. 

Hummingbird Neighborhood     An extension of Windows Explorer that 
lets you access and manipulate the profiles and folders associated with 
Hummingbird applications such as HostExplorer, 5250 File Transfer 
Wizard, and FTP for Windows Explorer. Hummingbird Neighborhood is 
fully embedded within Windows Explorer. For more information, see 
“Introducing Hummingbird Neighborhood” on page 3.
4
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Introducing Hummingbird Neighborhood

Hummingbird Neighborhood, like Windows Network Neighborhood, is 
fully embedded within Windows Explorer.  As an extension of Windows 
Explorer, you can use Hummingbird Neighborhood to access and 
manipulate the profiles and folders associated with Hummingbird 
applications, such as HostExplorer and FTP for Windows Explorer.

Hummingbird Neighborhood provides the following features:

Windows Support     Hummingbird Neighborhood has the same look and 
feel of Windows Explorer and lets you copy and paste, drag-and-drop, 
delete, and open existing profiles. These features are especially useful when 
you use either FTP for Windows Explorer to drag and drop files  between 
multiple FTP servers, or when you use HostExplorer to launch multiple 
remote host connections.

Shortcut Support     Hummingbird Neigborhood lets you create shortcuts 
to remote FTP files, directories, or any other item within the 
Neighborhood.

Hummingbird Neighborhood Location     Hummingbird Neighborhood 
lets you select My Computer or Desktop as the location for the 
Hummingbird Neighborhood icon. To make this selection, run hntune.exe 
from the product installation directory.

Setting Hummingbird Neighborhood Options
There are a number of options you can select to determine how 
Hummingbird Neighborhood performs. You can make these options 
specific to HostExplorer, FTP for Windows Explorer, or both.

To set the Hummingbird Neighborhood options:

1 Launch Windows Explorer.

2 In the left pane of the window, click Hummingbird Neighborhood.

3 On the View menu, click Hummingbird Neighborhood Options. The 
Hummingbird Neighborhood Options dialog box opens. 

4 Click one of the following six tabs and configure the various options. 
Click OK when finished.
5
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• General—Lets you select values for display and confirmation 
choices.

• FTP General—Lets you specify and select values for viewing files, 
anonymous FTP connections, and other general FTP operations.

• FTP Transfer—Lets you specify values for file name conversion and 
select the file transfer method.

• FTP Cache—Lets you set the size limit of the local cache and the 
length of time that cache items remain on your local PC.

• HostExplorer—Lets you select either the Quick Connect or 
Connect with Host Prompt option.

• Sounds—Lets you specify sound files to be played on completion of 
certain events.

Accessibility

Hummingbird products are accessible to all users. Wherever possible, our 
software was developed using Microsoft Windows interface standards and 
contains a comprehensive set of accessibility features.

Keyboard shortcuts     All menus have an associated keyboard shortcut. To 
access any menu, press Alt and the underlined letter in the menu name as it 
appears on the interface. For example, to access the File menu in any 
Hummingbird application, press Alt+F; to access the Tools menu in 
HostExplorer, press Alt+L.

Once you have opened a menu, you can access a menu item by pressing the 
underlined letter in the menu item name, or you can use the arrow keys to 
navigate the menu list. For menu items with an associated keyboard 
shortcut, the shortcut is listed on the menu to the right of the item.

Directional arrows     Use the directional arrows on the keyboard to 
navigate through menu items or to scroll vertically and horizontally. You 
can also use the directional arrows to navigate through multiple options. 
For example, if you have a series of radio buttons, you can use the arrow 
keys to navigate the possible selections.
6



Chapter 1: Introducing HostExplorer
Tab key sequence     To navigate through a dialog box, press the Tab key. 
Selected items appear with a dotted border. You can also press Shift+Tab to 
go back to a previous selection within the dialog box. 

Spacebar     Press the Spacebar to toggle check boxes on and off or to select 
buttons in a dialog box.

Esc     Press the Esc key to close a dialog box without implementing any new 
settings.

Enter     Press the Enter key to select the highlighted item or to close a dialog 
box with the new settings. You can also press the Enter key to close all About 
boxes.

ToolTips     ToolTips appear for all functional icons. This feature lets users 
use Screen Reviewers to make interface information available through 
synthesized speech or through a refreshable Braille display.

Microsoft Accessibility Options
Microsoft Windows environments contain accessibility options that let you 
change how you interact with the software. This feature can add sound, 
increase the magnification, and create sticky keys.

To access the Microsoft Windows Accessibility options, open Control Panel 
and click Accessibility.

If you installed the Microsoft Accessibility components for your Windows 
system, you can also find other Accessibility tools on the Start menu under 
Programs/Accessories/Accessibility.

To add the Accessibility components:

1 In Control Panel, double-click Add/Remove Programs. 

2 On the Setup tab, select the Accessibility Options check box and click 
Apply.

3 Click OK.
7
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Hummingbird Information Resources

Hummingbird provides the following sources of information regarding 
your product. 

Documentation Resources
Your product documentation set consists of both print and online sources. 

Manuals     Hummingbird manuals contain conceptual information on 
your product; procedural information on installing and using the product 
and related applications; and some manuals contain programming 
reference, interface reference, and troubleshooting information. 

All manuals are available in print and online. The online versions require 
Adobe Acrobat Reader 5.0 and are installed only if you do a Complete 
installation.Your Hummingbird product comes with the following manuals:

HostExplorer User's Guide

HostExplorer Deployment Wizard Administrator's Guide

HostExplorer Programmer’s Guide (in .pdf format only)

Hummingbird Basic Language Programmer's Guide

Online Help     The online Help is a comprehensive, context-sensitive 
collection of information regarding your Hummingbird product. It 
contains conceptual and reference information, and detailed, step-by-step 
procedures to assist you in completing your tasks. 

Release Notes     The release notes for each product contain descriptions of 
the new features and details on release-time issues. They are available in 
both print and HTML. The HTML version is automatically installed when 
you install the software. Read the release notes before installing your 
product. 
8
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Technical Support
You can contact the Hummingbird Technical Support department Monday 
to Friday between 8:00 a.m. and 8:00 p.m. Eastern Time.    

Mailing Lists and User Groups
For tips, additional help, and contact with other Hummingbird users on all 
operating systems, subscribe to Hummingbird Exposé Online or join the user 
group dedicated to your Hummingbird product. 

Subscribing to Hummingbird Exposé Online
Hummingbird Exposé Online is an electronic mailing list and online 
newsletter. It was created to facilitate the delivery of Hummingbird 
product-related information. It also provides tips, help, and interaction 
with Hummingbird users.

To subscribe to Hummingbird Exposé Online:

1 Open your web browser and type the following address:

http://www.hummingbird.com/expose/about.html

Hummingbird Ltd.
1 Sparks Avenue, North York, Ontario, Canada M2H 2W1

Canada and the USA International

Technical Support: 1-800-486-0095
+1-416-496-2200

General Enquiry: 1-877-FLY-HUMM

Main: +1-416-496-2200

Fax: +1-416-496-2207

E-mail: support@hummingbird.com

FTP: ftp.hummingbird.com

Online Request Form: www.hummingbird.com/support/nc/request.html

Web Site: www.hummingbird.com/about/contact.html
9
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2 In the Subscribe section, type your full name, e-mail address, and 
language preference. Then click Subscribe.  

To subscribe to the Mailing List or User Group:

1 Open your web browser and type the following address:

http://www.hummingbird.com/support/usergroups.html

2 On the User Groups and Mailing Lists page, click a product link.

3 On the Archives page, scroll down to the Subscription Instructions. 

4 In the Online Subscriptions section, type the name you want to display 
on the User Group and your e-mail address.

5 Click Subscribe. The browser opens a confirmation page to tell you your 
subscription was successful. You can now post messages to the User 
group. See posting instructions in Joining a User Group below.  

To search the mailing list archives:

Go to the following web site:

http://www.hummingbird.com/support/usergroups.html

Joining a User Group through E-mail
The user group is an unmoderated electronic mailing list that facilitates 
discussion of product-related issues and UNIX issues to help users resolve 
common problems and to provide tips, help, and contact with other users.

Note: To discontinue your subscription, in the Unsubscribe 
section, type your e-mail address then click Unsubscribe.

Note: To discontinue your subscription, in the Online 
Unsubscriptions section, type your e-mail address then click 
Unsubscribe.
10
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To join a User Group:

1 Send an email to listserv@hummingbird.com. Leave the Subject line 
blank.

2 In the body of the e-mail message, type the following:  

subscribe hostexplorer-users Your Name

To post a message to a User Group:

Create an e-mail and send it to the following address:

hostexplorer-users@hummingbird.com

Kerberos Security

Kerberos is a network authentication protocol that provides the necessary 
network tools to secure information systems across an enterprise. Based on 
client/server identification, Kerberos uses a key-distribution model and a 
secure password to restrict access to classified accounts. 

For more information about Kerberos security, go to the following URL:

http://web.mit.edu/kerberos/www/
11
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Chapter 2: Installing HostExplorer
Overview

The Hummingbird Setup Wizard (beginning with version 7.0) supports 
Windows Installer technology. Setup Wizard is based on three standard, 
top-level user interfaces or modes: installation, administration, and 
advertisement. Each defines a different installation path and user interface 
flow. 

The following sections in this chapter provide:

• an overview of the technology

• an outline of the installation requirements and preparations

• installation procedures and program maintenance

• advanced implementation scenarios

For more information, see 
see “Preserving User 
Profiles” on page 46. 

• a procedure for migrating user profiles from earlier versions

For information about updating products (version 7.x or greater), see 
“Updating the Product” on page 47.

Windows Installer Technology
For more information about 
Windows Installer, see the 
documentation available in 
the MSDN online library at 
msdn.microsoft.com

The Windows Installer service is an operating system component that acts 
as a setup engine. The installer includes:

• an operating system-resident installation service

• a standard format for component management

• a management API (such as Hummingbird Setup Wizard) for 
applications and tools

Windows Installer copies 
files onto the hard disk, 
modifies the registry, 
creates shortcuts on the 
desktop, and displays 
dialog boxes that prompt 
for user input.

Windows Installer consists of a client-side installer service (Msiexec.exe) 
and a Microsoft Software Installation (.msi) package file. The installer uses 
information in the package file to install the Hummingbird product. 
Msiexec.exe is called by Hummingbird Setup Wizard and uses a dynamic-
link library (.dll) to read the package files, apply transformation (.mst) 
files, and incorporate options supplied by Setup Wizard.

Note: You cannot preserve user profiles for products before 
version 6.2.
15
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For more information, see 
“Multi-Language Support” 
on page 19.

Windows Installer changes the registered file type of .msi files so that 
double-clicking the file runs Msiexec.exe with the .msi file. Each .msi 
package file contains a relational database that stores instructions and data 
required to install (and uninstall) the program.

The installer eliminates the need to run a setup engine on each target 
computer. Since installations are run through this common engine, the 
operating system can keep track of installation databases.

The key benefits of this technology are:

• efficient management of shared resources

• consistent installation rules

• easy customization

• choice of what pieces of the application are installed

• the ability to diagnose and repair problems at run-time

These and other benefits are outlined below:

Consistent Installation and Setup Rules     Windows Installer ensures all 
setup rules are implemented by the operating system. To follow those rules 
and avoid problems, a Hummingbird application describes itself in the 
standard Windows Installer format. The installer then performs the 
installation duties on behalf of the application.

Restores computer state if installation fails     Windows Installer tracks 
changes made to the system during the installation process. If the 
installation fails, the installer restores the system to its initial state.

Note: Double-clicking an .msi file that requires language 
translation produces an error message (Error 2803). Instead, run 
Hummingbird Setup Wizard (setup.exe) and select the 
appropriate setup language in the user interface.
16
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Prevents program conflicts     Conflicts occur, for example, when an 
installation operation updates a dynamic-link library (.dll) file shared by 
an existing program (sometimes replacing a newer .dll with an older one), 
or when an uninstall operation deletes a .dll file shared by another 
program. This might cause the computer to stop responding. The installer 
enforces installation rules that help prevent such conflicts.

Diagnoses and repairs corrupted or damaged files     Windows Installer 
can determine whether an installed program has missing or corrupted files. 
The installer repairs the program as necessary by replacing only those files.

Reliably uninstalls existing programs     Windows Installer reliably 
uninstalls any program it previously installed. All the associated registry 
entries and program files are removed, except for those shared by other 
software.

For more information about 
Sconfig for Windows 
Installer, see the “System 
Administration—Sconfig 
and Jconfig” chapter in 
this manual.

Supports Hummingbird Sconfig     Sconfig is an advanced system 
administration tool that lets administrators customize the Setup Wizard 
program.

Hummingbird Setup Wizard
Hummingbird Setup Wizard is the interface displayed by Windows 
Installer. Setup Wizard does the following:

• uses the Windows Installer service to maintain the applications and 
resources installed on the computer

• determines the correct path to specific components

• ensures that applications do not point to missing files

The Windows Installer service views all applications as three logical 
building blocks: products, features, and components. For more details 
about these terms, see the following sub-sections.

Products
A product represents a single Hummingbird product such as Exceed, NFS 
Maestro, or HostExplorer. Products consist of one or more features. Each 
product is described to the Windows Installer service in the form of a single 
package file (.msi) or installation database.
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Products do not own any resources directly, but they do have globally-
unique identifiers known as Product Codes. These enable the service to 
identify applications that are clients of a given component. Windows 
Installer service maintains a list of client products for each component. 
Product Codes let the service determine if a given product is already 
installed on a particular computer.

Features
Features are the individual pieces of an application that you can choose to 
install. Typically, they represent the functional features of an application. 
When you select Custom in the Setup Wizard program, the interface 
provides you with a tree that is composed of features (and sub-features). An 
example of a feature is X Server or Traceroute.

Components
A component is the smallest and most fundamental of the three logical 
building blocks. A component is a collection of files, registry keys, and other 
resources that are all installed or uninstalled together. When a given 
component is selected for installation or removal, all of the resources in that 
component are either installed or removed.

Components are invisible to the user; Hummingbird Setup Wizard manages 
whatever components make up a given Hummingbird application. 
Examples of components include single files, a group of related files, COM 
objects, registration, registry keys, shortcuts, resources, libraries grouped 
into a directory, or shared pieces of code. 
18



Chapter 2: Installing HostExplorer
Multi-Language Support
Hummingbird Setup Wizard can perform installation for the following 
languages:

1 English (United States) is the default installation language. Some Hummingbird 
products are available only in English. For more information, see the table on  
page 20.

Each language has an associated .mst transform file. Depending on the 
language selected, Setup Wizard applies the appropriate .mst file to the 
original .msi (which initially does not contain any user interface).

You can by-pass Setup Wizard and apply a language transformation using 
the following command line syntax:

For more information about 
Msiexec command line 
options, see the Windows 
Installer documentation in 
the MSDN online Library at 
msdn.microsoft.com
or on CD-ROM via 
subscription.

msiexec /i “path” TRANSFORMS=filename.mst

where path is the path to the .msi file, and filename.mst is the appropriate 
transform file listed in the table above. For example, the following applies 
an English transformation to Exceed:

msiexec /i “Hummingbird Exceed.msi” TRANSFORMS=1033.mst

Language Transform File

German 1031.mst

English1 1033.mst

Spanish 1034.mst

French 1036.mst

Italian 1040.mst

Portuguese 2070.mst
19



HostExplorer™ User’s Guide
The following are the multi-language support options for Hummingbird 
products:

Preparing to Install

System and shared files currently in use cannot be updated. Close all 
applications before proceeding with the installation.

Product Support Language(s)

Exceed German, English, Spanish, French, 
Italian, Portuguese

Exceed 3D

Exceed XDK

Exceed PowerSuite

Hummingbird Connectivity Security Pack

HostExplorer

HostExplorer Deployment Wizard

NFS Maestro Client

NFS Maestro Server

NFS Maestro Solo

NFS Maestro Gateway

Hummingbird Inetd English only

Hummingbird FTP for Windows Explorer

Note: Before installing on Windows NT/2000, it is recommended 
that you log on with Administrator authority. You also require write 
access to the Windows system directory and registry. If necessary, 
consult your system administrator.
20
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Hummingbird connectivity products (version 7.0 and later) use Windows 
Installer. It is included with Windows 2000 and Windows Me. If Windows 
Installer is not present on your Windows 95, Windows 98, or Windows NT 
4.0 operating system, then Hummingbird Setup Wizard installs and 
configures the service.

If Windows Installer is present on the operating system, Setup Wizard 
checks the version. If necessary, Windows Installer is updated.

Installation Requirements
You can preserve user 
profiles from version 6.2 of 
Hummingbird products. 
For more information, see 
“Preserving User Profiles” 
on page 46.

The following table outlines installation requirements for Hummingbird 
connectivity products:

1 Approximate free hard disk space required for a Complete installation of all 
program features.

2 Administrator privileges are required to install some portions of the product.

Note: The first time Hummingbird Setup Wizard installs and 
configures Windows Installer, you may be prompted to restart the 
machine. Installation continues after your system restarts.

Product Operating 
System

Disk 
Space1 Other Requirements

HostExplorer Windows 95

Windows 98

Windows Me

Windows NT2 
(service pack 4 
or later)

Windows 20002

30 MB

Note: For some installation scenarios, Windows NT 4.0 requires 
Internet Explorer 4.01 or greater, and Windows Desktop Update 
(shell32.dll version 4.72.3110.0). See “Advertised Product” on 
page 40.
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Third Party Software
JRE consists of the Java 
Virtual Machine, the Java 
platform core classes, and 
supporting files. 

Certain third party software must be installed to run some Hummingbird 
products. The Sun Java Runtime Environment (JRE) is required to run Java 
programs.

For example, you must install JRE before installing the following product 
sub-features:

• Systems Administration—Jconfig (client)

• Systems Administration—Jconfig Daemon

Hummingbird Master Setup lets you install third party add-on(s) such as:

• Adobe Acrobat Reader

• Sun Java 2 Runtime Environment

• Microsoft SNA Server (for Windows NT/2000)

• IntranetWare for SAA Client
22
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Choosing a Setup Type
For an illustration of setup 
types, see the dialog box 
on page 29.

Hummingbird Setup Wizard prompts you to choose either a Typical, 
Custom, or Complete setup type. For assistance with choosing a setup type, 
consult the following quick reference table:       

Hummingbird Sconfig
Sconfig is an advanced system administration tool that lets administrators 
customize the Setup Wizard program. For more information, see the 
“System Administration—Sconfig and Jconfig” chapter in this manual.

Setup 
Type

Function Recommended for: More information:

Typical • standard features

• no feature or 
feature directory 
changes

• new users • see “Typical” on 
page 30

Custom • control over feature 
and directory 
changes

• advanced users 
and system 
administrators

• users with 
restricted disk 
space

• see “Custom” on 
page 32

Complete • everything is 
installed in default 
directories

• users without disk 
space restrictions

• see “Complete” on 
page 33

Note: All setup types allow you to change the destination folder 
(also known as the root home directory). However, this change 
affects all feature directories.
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Installation Directories
Hummingbird Setup Wizard installs program-specific and user-specific 
files to the directories described below.

Setup Wizard supports the Uniform Naming Convention (UNC) so you can 
begin path specifications with \\ in place of the disk drive to specify a 
shared directory on a file server. For example:

\\machine_specification\share_name

Installation Description Location/Type

Destination 
folder

Program files install into the 
destination folder (also known 
as the root home directory). It is 
recommended that you use the 
default directory: 

C:\Program Files\
Hummingbird\Connectivity\
Version\

However, you can specify a 
different directory.

Location: a remote network 
drive or a local hard drive. 

Can be a read-only directory.

User 
directory

User files install into the user 
directory.

These files are configuration 
files or related files that your 
Hummingbird product can 
change.

There are two kinds of user 
directories and user files. For 
more information, see “Installed 
Files” below.

Warning: Warning: Warning: Warning: Do not make a user 
directory read-only.

Location: a remote network 
drive or a local hard drive.

Current user:
<Application Data>\Hummingbird\Connectivity\Version

All users:
<Common Application Data>\Hummingbird\Connectivity\Version
24



Chapter 2: Installing HostExplorer
where machine_specification is the name of the computer to which you 
are connecting, and share_name is the name of the shared directory. If you 
use UNC names to install to a Novell server, you must install the OS/2 
support patch on the NetWare server as NetWare servers do not support 
UNC paths.

Installed Files
User files for Hummingbird connectivity products fall into two categories:

• per-machine

• per-user (current user and “All Users”)

Per-machine files are local 
so that key operating 
system components, such 
as device drivers and 
services, can reliably 
access them during login.

Per-machine files are those application or service files that, when changed, 
affect all users of the computer. An example is the inetd.ini file. If you 
change inetd.ini to stop the Telnet daemon from running, then regardless 
of which user is logged onto the computer, the Inetd service rejects Telnet 
connections.

Per-user files are all application or service files that, when changed, affect 
only the user who is making the change (that is, the currently logged in 
user). An example of a user-specific file is exceed.cfg. If you configure 
exceed.cfg with Xconfig to use a certain Display, then other users of the 
machine are not affected. 

The following are the per-machine file locations:

Note: Only the user who installs the product has access to those 
user files in the current user directory. 

Operating 
System

Per-Machine—File Location

Windows
95/98/Me

C:\Windows\System\Hummingbird\Connectivity\<Version>\

Windows 
NT 4.0

Windows 
2000

C:\Winnt\System32\Hummingbird\Connectivity\<Version>\
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Current User versus “All Users”
For Windows NT/2000 platforms, Hummingbird Setup Wizard prompts 
you to choose between installing the product on the computer for the 
currently logged in user, or for all users. For the current user, shortcuts are 
created in the appropriate user profile folder, along with copies of all other 
user files. For all users (anyone who uses the computer), shortcuts are 
created in the “All Users” profile folder, along with copies of all other user 
files.

The following are the default locations for user files: 

Operating 
System

Per-User Files—Default Location (Current User)

Windows 95/
98/Me

C:\Windows\Application Data

Windows 95/
98/Me (user 
profiles 
enabled)

C:\Windows\Profiles\%USERNAME%\Application Data

Windows NT 
4.0

C:\Winnt\Profiles\%USERNAME%\Application Data

Windows 2000 C:\Documents and Settings\%USERNAME%\Application Data
(hidden)

Operating 
System

Per-User Files—Default Location (All Users)

Windows 95/
98/Me

C:\Windows\Application Data

Windows 95/
98/Me (user 
profiles 
enabled)

C:\Windows\Profiles\All Users\Application Data

Windows NT 
4.0

C:\Winnt\Profiles\All Users\Application Data

Windows 2000 C:\Documents and Settings\All Users\Application Data
(hidden)
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Installation and Maintenance

This section describes basic installation procedures and setup types:

• personal installation—such as one user installing on one computer

• setup types—typical, custom, complete

• administrative installation—systems administrators create an image of 
the product at a network location

For examples of how to implement these procedures, see “Typical 
Installation Scenarios” on page 39.

Personal Installation
Autorun launches the Hummingbird Master Setup application when you 
insert the CD into your drive. If Master Setup does not launch 
automatically, run Msetup.exe from the root directory of the CD.

To configure Windows Installer and prepare Setup Wizard:

1 In the Hummingbird Master Setup application window, you can select 
options to install third party add-ons, register online, or view release 
notes. Otherwise, click Install Product, then Personal Installation. 

2 If you are prompted, select a setup language and click OK. English is the 
default.    

Note: For certain products, English is the only supported 
language. For more information, see the table on page 20. When 
selected, the language applies to all subsequent users installing 
Hummingbird products on the PC.
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3 Your Hummingbird product prepares Setup Wizard, checks the 
operating system, and checks the current Windows Installer version.

• If necessary, the version is updated and the Setup Wizard continues.

• If Windows Installer is not present on your operating system, Setup 
Wizard installs the service. Click Restart System to continue 
installing the product.  

Setup Wizard reboots the computer. This is necessary only the first 
time Windows Installer is configured and installed on your 
Windows 95/98 or Windows NT operating system.

4 After configuring Windows Installer and preparing to install, Setup 
Wizard proceeds to the Welcome dialog box. Click Next.  

The Next button is dimmed 
if the terms of the license 
agreement are not 
accepted.

5 Read the licensing agreement. If you select the option that indicates the 
terms are acceptable, then click Next.

6 The Customer Information dialog box opens. Type the appropriate 
information, select an installation option (all users, current user), and 
click Next.

Note: To quit installation, click Cancel in any Setup Wizard dialog 
box. Your computer is not affected if you do this before the Setup 
Wizard copies files. To review or change settings in a previous 
dialog, click Back.

Note: Failure to read or understand the License Agreement does 
not affect the terms and conditions of the agreement.
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Destination Folder is the 
same as the home 
directory (a term familiar to 
users of version 6.2 and 
earlier products). 

7 The Destination Folder dialog box opens. Accept the default installation 
folder for the product, or click Change to open a dialog box for 
browsing to an alternate location. Click Next.  

8 The Setup Type dialog box opens. Select a setup type and click Next. 

For more information, see 
“Typical” on page 30 and 
“Complete” on page 33.

• For Typical and Complete setup types, a dialog box opens and 
indicates Setup Wizard is ready to begin installation. Click Install.

For more information, see 
“Custom” on page 32.

• For Custom setup type, a Custom Setup dialog box opens. Customize 
the installed program features and click Next.

A dialog box indicates Setup Wizard is ready to begin installation. 
Click Install.

9 A dialog box opens and indicates installation is complete. Click Finish.  

For information about product modification, repairs, or removal, see 
“Program Maintenance for Personal Installations” on page 34.

Note: Some product features are not affected by changes to the 
destination folder.
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Setup Types
The following sections describe options that determine what product 
(program) features are installed.

Typical
Complete setup type 
includes all the features 
listed in the table on 
page 30.

Selecting this setup type means that standard features are installed to 
default destination folders. In contrast to the Complete option, only the 
essential features of the product are installed. 

Typical setup type usually requires less disk space than the other types. The 
following table lists features installed and those not installed with this setup 
type:       

Features (and Sub-Features) Not installed with Typical

Accessories Finger1

Host Editor2

Hummingbird Basic1, 3

Launch Pad1

Network Time1

NSLookup1

Ping1

Remote Tools1

Tar1

TraceRoute1

Whois1

Command Line Utilities3

HostExplorer Command Line Utilities FTP1, 3

Hummingbird Neighborhood2, 3

[FTP for Windows Explorer2, 3, 
HostExplorer Profile Type2 (3270, 
5250, Telnet)2, PrintExplorer2]

HostExplorer Development Kit1 2

LPQ1

LPR2, 3

WyseTerm1
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1 The feature or sub-feature can be advertised.
2 Installing the feature or sub-feature requires Administrator privileges.
3 You cannot run the feature from a network location.

Hummingbird Inetd2, 3 Finger Daemon2, 3

FTP Daemon2, 3

LP Daemon2, 3

Telnet Daemon2, 3

Time Daemon2, 3

Xstart Daemon2, 3

Bootp Daemon2, 3

Trivial FTP Daemon2, 3

Trivial Name Daemon2, 3

Online Documentation Hummingbird Basic Language 
Programmer’s Guide1 

HostExplorer User’s Guide1  

HostExplorer Programming Guide 

System Administration Jconfig Daemon (Java Component)3

Hummingbird Update3

SOCKS Information1

Jconfig (Java Component)1, 3

Sconfig1 

Features (and Sub-Features) Not installed with Typical
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Custom
This setup type lets you select the program features to install and where to 
install them. This setup type is recommended for advanced users and 
administrators. When you click Next in the Setup Type dialog box, the 
following dialog box opens:   

You can view more information about features and perform the following 
customization:

• Expand a feature category by clicking the plus icon  to view a tree of 
features or sub-features. Similarly, click the minus icon  to collapse 
the feature tree.

• Click a feature icon to display a pop-up menu of icons and install 
options (see above). Click a pop-up menu icon. The icon in the feature 
tree changes according to your selection. Click Help to view a dialog box 
with tips.
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• Click Change to open the Change Current Destination Folder dialog box 
and install the feature to a folder other than the default.  

• Click Space to open a dialog box listing all local drives (logical 
partitions) and mapped drives on the machine. It provides detailed 
information about available disk space.

Complete
The Complete option 
installs all features listed in 
the table on page 30.

This setup type requires the most disk space and installs all product features 
to the default destination folder:

C:\Program Files\Hummingbird\Connectivity\<Version>\

Click Change to open a browse dialog box and install the program to 
another destination directory.

Note: For some product features (such as Hummingbird Inetd), 
the Change button is disabled and you cannot specify an 
installation folder.
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Program Maintenance for Personal Installations
Program maintenance lets you modify, repair, or uninstall existing 
Hummingbird products and features (version 7.x). 

To launch Hummingbird Setup Wizard in maintenance mode:

1 You can open Program Maintenance by running Msetup.exe from the 
product CD. Alternatively, double-click Add/Remove Programs in 
Control Panel, select the Hummingbird program, and click Add/
Remove. The Welcome dialog box opens.

2 In the Welcome dialog box, click Next. The Program Maintenance dialog 
box opens. 

For more information about maintenance options, see the following 
procedures.

To modify the install state of program features:

1 In the Program Maintenance dialog box, select Modify and click Next.

For more information, see 
“Custom” on page 32.

2 The Custom Setup dialog box opens. Expand the feature tree and change 
the install state, as necessary. Click Next.
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3 Setup Wizard prompts when it is ready to modify the program. Click 
Install and the install state of program features changes according to 
your specifications.

4 Installation (modification) proceeds to completion. Click Finish to exit.

To repair a program:

1 In the Program Maintenance dialog box, select Repair and click Next.

2 The Ready to Repair the Program dialog box indicates Setup Wizard is 
ready. Click Install to repair errors such as missing or corrupt files, 
shortcuts, and registry entries.

3 Program repair proceeds to completion. Click Finish to exit.

To remove a program:

1 In the Program Maintenance dialog box, select Remove and click Next.

2 The Remove the Program dialog box indicates Setup Wizard is ready. 
Click Remove to uninstall the program.

3 Program removal proceeds to completion. Click Finish to exit.

Administrative Installation
Autorun launches the Hummingbird Master Setup application when you 
insert the CD into your drive. If Master Setup does not launch 
automatically, run Msetup.exe from the root directory of the CD.

Note: With Windows Installer, you can uninstall (remove) only one 
program (product) at a time. Ensure that all programs associated 
with the product you are uninstalling are closed.
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Administrative installations let you create a centralized image of the 
product. This means that many users can install the product without the 
original CD media. There are two types of administrative installations:

Copy Image     This installation creates a language-specific image at a 
network location, but in all other respects, this image is the same as the 
contents of the original CD. Running Setup.exe from a Copy Image is the 
same as a personal installation. For more information, see the procedure 
“Personal Installation”, from pages 27 to 29.

Shared Image     This installation creates a language-specific image for 
running applications from the network. When an application is marked 
“Run from Network”, only the user and system files are installed to the local 
computer. All other files remain on the Shared Image server. Running 
Setup.exe from a Shared Image is called a workstation installation (see 
page 45). This is similar to a personal installation, except advertisement (see 
“Advertised Product” on page 40) is not available and features are set to run 
from the network.

All Hummingbird products support Administrative—Copy Image 
installation. Administrative—Shared Image installation is available for the 
following products:

• Exceed

• Exceed 3D

• Exceed XDK

• Exceed PowerSuite

• HostExplorer

• NFS Maestro Client

• NFS Maestro Solo  

Note: An administrative installation only copies files. The product 
is not installed to the network location (server), nor does it make 
changes to the server. Only the network location folder is 
modified.
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To run Setup Wizard in Administrative mode:

1 Run Msetup from the product CD. In the Hummingbird Master Setup 
application window, you can select options to install third party 
add-ons, register online, or view release notes. Otherwise, to run Setup 
Wizard, click Install Product, then click Administrative Installation.

Alternatively, from the product directory on the CD, run:

setup /a

2 Select a setup language and click OK. This language will apply to all 
installations from the copied image or shared image.

3 Your Hummingbird product prepares Setup Wizard, checks the 
operating system, and checks the current Windows Installer version.

• If necessary, the version is updated and the Setup Wizard continues.

• If Windows Installer is not present on your operating system, Setup 
Wizard installs the service. Click Restart System to continue 
installing the product.
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Setup Wizard reboots the computer. This is necessary only the first 
time Windows Installer is configured and installed on your 
Windows 95, Windows 98, or Windows NT 4.0 operating system.

4 After configuring Windows Installer and preparing to install, Setup 
Wizard proceeds to the Welcome dialog box. Click Next.

5 The Network Location dialog box opens. Accept the default installation 
folder for the product or click Change to open a dialog box for browsing 
to an alternate network location. 

6 Click Next and the Network Location Type dialog box opens. Select a 
network location type.   

7 Click Next. The Ready to Install Network Image dialog box opens.

8 Click Install. Installation of the network image proceeds to completion.

Note: To quit the installation, click Cancel in any Setup Wizard 
dialog box. Your computer is not affected if you do this before the 
Setup Wizard copies files. To review or change settings in a 
previous dialog, click Back.
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Typical Installation Scenarios

This section describes installation scenarios. The conditions and parameters 
affecting implementation in your environment may vary from these 
examples.

Personal Installations  
Administrators, or users who do not have Administrator privileges 
(Windows NT/2000), or “Any User” in Windows 95/98, are able to perform 
personal installations for HostExplorer. FTP for Windows Explorer, 
Hummingbird Inetd, and Hummingbird NFS Maestro Client Gateway 
require Administrator privileges for personal installations in Windows NT/
2000. However, “Any User” in Windows 95/98 can install these products or 
features.

This type of installation 
applies to all Windows 
platforms, but not 
Windows NT 4.0 Server—
Terminal Server Edition or 
Windows 2000 Advanced 
Server with Terminal 
Services enabled.

Personal—With Administrator Privileges
This scenario assumes:

• you are logged in to the PC as the (local) Administrator

• the product CD is available locally or on the network

To launch a personal installation as Administrator:

1 Launch Setup Wizard in installation mode by one of the following 
methods:

For more information about 
creating a server image, 
see “Silent Installation” on 
page 41.

• from the command line, run Setup.exe on the product CD or from 
a server image

• from the product CD, run Msetup.exe

2 In the Customer Information dialog box under Install this application for, 
select one of the following options:

• Anyone who uses this computer (all users)

• Only for me (username)—applicable to the current user  

Note: These options are available only in Windows NT/2000, 
provided that you are logged in to the PC as Administrator.
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3 If you are prompted, select a language for the installation. English is the 
default.  

4 Dialog boxes provide information and prompt for input.

5 In the Setup Type dialog box, select Typical, Custom, or Complete. 
Installation proceeds to completion.

Installing onto a Terminal Server
For information about installing Host Explorer onto a Terminal Server, see 
the next chapter.

Advertised Product
Applies to all Windows 
platforms, but not 
Windows NT 4.0 Server—
Terminal Server Edition or 
Windows 2000 Advanced 
Server with Terminal 
Services enabled. 
Windows NT 4.0 requires 
Internet Explorer 4.01 
(SP1) or greater, and 
Windows Desktop Update 
(shell32.dll version 
4.72.3110.0 or later).

Advertisement (install on demand or deferred installation) means all 
features of a product are available even if they are not installed on the 
computer. This scenario assumes:

• you are logged in to the PC as the (local) Administrator

• the product CD is available locally or on the network  

To advertise a product and all its features:

1 Launch Setup Wizard in advertisement mode by one of the following 
methods:

• on the command line type E:\setup /V/jm for all users or 
E:\setup /V/ju for the current user—where E:\ is the CD-ROM 
drive

Note: For certain products, English is the only supported 
language. For more information, see the table on page 20. When 
selected, the language applies to all subsequent users installing 
Hummingbird products on the PC.

Note: Not all product features can be advertised.
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• run Msetup.exe from the product CD  

2 Select the Complete setup type.

Shortcuts and registry 
entries exist on the 
computer, but files are not 
installed.

3 A Hummingbird product icon is installed on the PC desktop, and in the 
Windows program group (on the Start menu), for each feature.  

Silent Installation
A silent installation runs in the background. This scenario assumes:

• you are logged in to the PC as the (local) Administrator

• the product CD is available locally or on the network   

To run a silent installation:

1 Launch Setup Wizard from the command line using the following 
syntax:

E:\setup /S /V/qn [/lnnnn]

where E:\ is the CD-ROM drive. The following describes options: 

Note: For a deferred installation, the product CD must be in the 
drive and the drive must be accessible.

Note: Shortcuts for features requiring Administrator privilege will 
not launch correctly if the user does not have the required 
privileges to install the feature. For more information about these 
features, see the table on page 30.

Note: This scenario describes a local installation.

Option Description

/S Specifies a silent installation.

Note: Note: Note: Note: S is upper-case.
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2 Installation proceeds to completion.

Microsoft Systems Management Server (SMS)
An Administrator can use SMS to manage network computers, distribute 
software from a central location, and perform a variety of other system 
management tasks. The Administrator can install a package of products 
simultaneously on multiple computers.

Requirements:

You can get the latest 
service pack for SMS from 
the Microsoft web site. 

• SMS version 2.0 with service pack 2 (or greater)

• SMS Client (installed on each client computer) supplied with SMS 
Server

• Windows Installer on the client computer

A package contains source 
files for the program and 
various details for directing 
the software distribution 
process.

To distribute a product using SMS, the Administrator must create a package 
definition file according to SMS instructions. 

For convenience, Hummingbird provides a default package definition file 
for all products. There are three default scenarios in each package definition 
file:

• Typical 

/V/qn /V passes parameters to Msiexec.exe.

Note: Note: Note: Note: There are no spaces between the /V and /qn options and 
that V is upper-case. If necessary, you can put quotes around a 
character string. For example: /V”parameter space”

/lnnnn Overrides the default English language installation where nnnn is 
the transform file name.

Note: Note: Note: Note: For nnnn, type only the number but not the .mst extension.

Option Description

Warning!  Do not confuse the package definition file extension 
(.pdf) with the Adobe file format (pdf—portable document 
format).
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• Silent—Typical

• Silent—Complete

When a package is run through SMS, it prompts you to select one of these 
options (scenarios). Use the following command line parameters to apply 
modifications or create new package definition files: 

For more information about 
Msiexec command line 
options, see the Windows 
Installer documentation 
available in the MSDN 
online library at 
msdn.microsoft.com

For example, a complete silent installation of a Hummingbird product in 
Italian would look like this:

msiexec /i "Hummingbird Product.msi" TRANSFORMS=1040.mst INSTALLLEVEL=150 /q

Refer to Microsoft documentation for command line parameters, switches, 
and other information required for Windows Installer and Systems 
Management Server.

Shared Installation
This type of installation 
applies to Windows NT/
2000 platforms, but not 
Windows NT 4.0 Server—
Terminal Server Edition or 
Windows 2000 Advanced 
Server with Terminal 
Services enabled.

This advanced installation creates a server image of the Hummingbird 
product and saves it to a network location.

Command Line 
Parameter

Description

/i Installs or configures a product.

/q Sets user interface level (silent).

INSTALLLEVEL=150 Does a complete install.

TRANSFORMS=nnnn.mst Specifies the product language where nnnn is the 
transform file name.

Note: On Windows NT 4.0—Terminal Server Edition, shared 
installation is not possible. For more information, see “Installing 
onto a Terminal Server” on page 40.
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To launch a shared installation:

1 Launch Setup Wizard in administration mode by one of the following 
methods:

• from the command line using the syntax:

E:\setup /a

The /a flag launches the 
executable file in 
administrative mode.

where E:\ is the CD-ROM drive.

• run Msetup.exe from the product CD. In the Hummingbird Master 
Setup application window, click Install Product, then Administrative 
Installation.

The language will apply to 
all network installations 
from this server.

2 If you are prompted, select a language for the installation. English is the 
default. 

3 Click Next in the Welcome dialog box.

4 In the Network Location dialog box, type a path to an accessible network 
location (server) or click Change to open a browse dialog box. Click 
Next.

5 In the Network Location Type dialog box, select Shared Image. Click Next.

6 When Setup Wizard is ready, click Install.

7 All of the required files are installed to the specified network location.

8 Users wanting to use this product must perform a workstation 
installation.

Note: For certain products, English is the only supported 
language. For more information, see the table on page 20. Once 
selected, the language applies to all subsequent users installing 
Hummingbird products on the PC.
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Workstation Installation
This scenario requires an existing shared image installation. The product is 
installed to network workstations from the shared image located on a 
network server. Certain features are set to run from this network location.

To launch a workstation installation:

Users can install products 
from the shared image in 
the context of either the 
Standard/Personal or 
Standard/Personal with 
Administrator Privileges 
scenarios.

1 Run Setup.exe from the network location.

2 For details about this part of the procedure, see “Personal Installation” 
beginning at step 3 on page 28. 

3 Installation proceeds to completion.

Hummingbird Sconfig
Sconfig (Setup configuration) lets you customize the installation of software 
on local and network machines. Use it to customize the folders installed by 
Setup Wizard, determine what is installed (as well as limit functionality or 
optimize disk space), and simplify user input. For more details, see the 
“System Administration—Sconfig and Jconfig” chapter in this manual.

Note: This type of installation will not start on Windows NT 4.0—
Terminal Server Edition.

Note: In the Custom Setup dialog box, the install state of certain 
features (and sub-features) are by default set to run from the 
network. For workstation installations that are cross-platform (for 
example, installing from a shared image on a Windows NT/2000 
server to a 95/98 workstation), features that contain platform-
specific components are set to run locally on the workstation, not 
from the server.
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Preserving User Profiles

Hummingbird Setup Wizard does not preserve user profiles for products 
before version 6.2. You must manually uninstall all such products before 
installing version 7.x.

Version 6.2 User Profiles
You can preserve user profiles for version 6.2 Hummingbird products. If 
you are upgrading the same (single) product from version 6.2 to version 7.1, 
Setup Wizard will back up user profiles and automatically uninstall the 
version 6.2 product.

User profiles for multiple version 6.2 products can be preserved, but the 
products are not automatically uninstalled. These must be uninstalled 
manually before installing version 7.1. For more information, see the 
following procedure.

General procedure:

1 After launching Hummingbird Setup Wizard, version 6.2 products are 
detected.

User files are stored in the 
current user’s Application 
Data folder under MigBack.

2 Setup Wizard reports that user files are saved for each product.

3 This part of the procedure varies depending on the number of products 
detected: 

4 If Setup Wizard does not detect any older product versions, you are 
prompted to click one of the following buttons:

Yes—to restore the version 6.2 profiles previously saved

No—to use the default 7.x profiles and settings

Single product (upgrade): Multiple products:

a) The product is uninstalled. 
You are prompted to restart.

b) Launch Setup Wizard again.

a) You are informed that these 
must be uninstalled 
manually. Setup Wizard exits.

b) Uninstall the products.

c) Launch Setup Wizard again.
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5 Installation of the version 7.x Hummingbird product proceeds to 
completion. Your version 6.2 profiles are available when you run the 
version 7.x product.

Version 7.0 User Profiles
Hummingbird version 7.1 products will automatically replace a previously 
installed 7.0 version of the same product. All settings are preserved in a 
backup location, and those settings that are applicable to the newly installed 
features of version 7.1 are migrated.

In cases where an upgrade is not possible, the version 7.1 product installs 
side-by-side with existing products. 

Updating the Product

WebUpdate options for 
your Hummingbird product 
are preset. For update 
options, right-click the 
Hummingbird product 
entry in the WebUpdate 
dialog box and select from 
the drop-down menu.

If necessary, you can modify connection settings for updating the product. 
Select WebUpdate Settings in the System Administration folder of the 
Hummingbird Connectivity program group. Make the appropriate changes 
in the WebUpdate dialog box as required.

Note: Some products do not support side-by-side installation.

If version 6.2 to 7.0 migration was disabled to allow side-by-side 
installation of a product, an upgrade from version 7.0 to 7.1 is 
possible, but the 7.0 settings are migrated instead of the 6.2 
settings.

Note: The WebUpdate application is not available if you 
performed a personal installation without Administrator privileges. 
Instead, an HTML file is created that links to a Web site for 
Hummingbird updates.
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To update the product:

1 Click Update Hummingbird Product in the System Administration folder 
of the Hummingbird Connectivity program group. 

2 If an update is available, you are prompted to install it. Click Yes.

3 The update is downloaded. Setup Wizard prepares the setup process.

4 You are informed when Setup Wizard is ready. Click Next.

5 Installation proceeds to completion.

Registering

Online registration is available by:

• running Msetup from the product CD, then clicking Register Online

• completing and registering the form at the following URL:

http://www.hummingbird.com/register/

Alternatively, complete the registration card provided in the product 
package and mail it to Hummingbird Ltd.

After registering, you and your organization are recognized as a licensed 
product owner with all rights and privileges. This makes you eligible to 
receive a wide range of customer services, such as a free subscription to our 
quarterly newsletter, Exposé Online, as well as notification of software 
upgrades and new products. If you and your organization move to a new 
location, complete and mail the change of address card included in the 
product package. This ensures you will continue receiving update notices 
and other important information.

Note: You can also select the Hummingbird product entry and 
click Check for Update in the WebUpdate dialog box.
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Chapter 3: Installing onto a Terminal Server
Overview

This chapter explains how to install and uninstall a Hummingbird product 
on Windows NT4 Terminal Server Edition, Windows 2000 Server, and 
Advanced Server with Terminal Services enabled.

The following procedure assumes:

• you are logged onto the Terminal Server as the Administrator

• the product CD is available locally or on the network

A Terminal Server installation is a two-stage process that consists of creating 
an administrative copy image of HostExplorer on the Terminal Server, and 
installing the Hummingbird product onto the Terminal Server from the 
newly-created copy. 

Installing HostExplorer on a Terminal Server

Stage 1: Creating an Administrative Copy Image
You must apply the appropriate product-specific transform to 
Hummingbird HostExplorer 7.1 before the product can be installed on a 
machine with Terminal Server capabilities.

To create an Administrative Copy Image on the Terminal Server:

1 From the product directory on the CD, run the following command 
from a command prompt.

setup /a /v”TRANSFORMS=HostExTSE.mst”

Warning!  When creating the Administrative Copy Image, you 
must apply the HostExTSE.mst Transform.
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2 Select a setup language and click OK.

3 Your Hummingbird product prepares Setup Wizard, checks the 
operating system, and checks the current Windows Installer version.

• If necessary, the version is updated and the Setup Wizard continues.

• If Windows Installer is not present on your operating system, Setup 
Wizard installs the service. Click Restart System to continue 
installing the product.

Setup Wizard reboots the computer. This is necessary only the first 
time Windows Installer is configured and installed on your 
Windows NT 4.0 Terminal Server Edition operating system.

4 After configuring Windows Installer and preparing to install, Setup 
Wizard opens the Welcome dialog box. Click Next.

5 The Network Location dialog box opens. Accept the default installation 
folder for the product or click Change to browse to an alternate network 
location. A folder with the default name Admin is created on the 
terminal server. The Administrative Copy Image will be placed in the 
Admin folder.

6 Click Next. The Ready to Install Network Image dialog box opens.

Note: The language you select during this setup process will be 
the language of the administrative image.

Note: To quit the installation, click Cancel in any Setup Wizard 
dialog box. Your computer is not affected if you do this before the 
Setup Wizard begins copying files. To review or change settings in 
a previous dialog, click Back.

Note: Each user has private shortcuts, registry entries, and user 
files. User files are copied from the Admin folder. Each user must 
have at least read access to the Admin folder installation point.
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7 Click Install. Installation of the Administrative Copy Image proceeds to 
completion.

Stage 2: Personal Installation
After creating an Administrative Copy Image, an administrator can install 
personal installations of HostExplorer onto the Terminal Server from this 
image.

To install HostExplorer onto the Terminal Server:

1 From the command line, change the directory to C:/Admin and run

setup.exe

where C:\Admin is the name of the drive and folder where the 
Administrative Copy Image is located.    

2 Click OK. 

3 Setup Wizard opens the Welcome dialog box. Click Next.

Note: The Administrative Copy Image must be readable by all 
users who are granted permission to use HostExplorer.

Note: The Admin folder and its contents must remain available 
during the lifetime of HostExplorer on the terminal server. Multiple 
terminal servers can share the same Admin folder.

Warning!  Installing from Add/Remove Programs should be 
avoided. When in installation mode, Windows Terminal Server 
Edition caches values written into the HKEY_CURRENT_USER registry 
hive. This defeats the purpose of the per-user installation and can 
cause problems with display assignment.
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4 Read the Licensing Agreement. If you select the option that indicates 
the terms are acceptable, then click Next. 

5 The Customer Information dialog box opens. Type the appropriate 
information, select an installation option (All Users, Current User), and 
click Next.

Destination Folder is 
synonymous with home 
directory (the directory in 
which the product is 
installed). 

6 The Destination Folder dialog box opens. Accept the default installation 
folder for the product or click Change to browse to an alternate location. 
Click Next.  

7 The Setup Type dialog box opens. Select a setup type and click Next.   

Note: Failure to read or understand the License Agreement does 
not affect the terms and conditions of the agreement.

Note: Some product features are not affected by changes to the 
destination folder.
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• For Typical and Complete setup types, a dialog box opens and 
indicates Setup Wizard is ready to begin installation. Click Install.

• For Custom setup type, a Custom Setup dialog box opens. Customize 
the installed program features and click Next.

A dialog box indicates Setup Wizard is ready to begin installation. 
Click Install.

You can perform this 
procedure later by using 
the Performance 
application in Xconfig.

8 A dialog box opens and indicates installation is complete. Click Finish.  

Upon completion of Stage 2, the per-user installation of the Hummingbird 
product is enabled and HostExplorer will be automatically installed into the 
appropriate user profile the next time each user logs on. 

For more information about 
setting up access 
permissions, see 
Hummingbird User 
Manager Help.

If users are granted product access permission through a Hummingbird 
Product User Group, HostExplorer will automatically be installed into the 
appropraite user profile the next time user group members log on. 
Alternatively, HostExplorer will automatically uninstall from profiles of 
users who are not user group members. HostExplorer7_Users is the default 
group name for HostExplorer users.  

Uninstalling HostExplorer from a Terminal Server

Only administrators can remove Hummingbird HostExplorer from the 
Terminal Server using the Add/Remove Programs option.  The Add/
Remove Programs procedure removes the binary files from the Program 
files folder and prevents existing users from using HostExplorer. Existing 
personalized user settings and shortcuts will be removed automatically for 
each user when each user next logs on.

Note: The Hummingbird product installed on each user’s profile 
will use the setup type that the administrator chooses in the Setup 
Type dialog box.
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The following conditions must be met before disabling UsrSetup and 
removing the UsrSetup file from the machine:

• You are not planning to install Exceed, Exceed 3D, Exceed XDK, Exceed 
PowerSuite, or HostExplorer again.

• The Terminal Server personal installation has been uninstalled using 
the Add/Remove Programs options. After this uninstallation, when a 
user logs on, customized settings and user files are automatically 
uninstalled from his/her user profile. Only after this process is complete 
can you disable UsrSetup and remove the UsrSetup file. 

If the above conditions have been met, you can disable UsrSetup.

To disable UsrSetup:

1 From the Terminal Server command line, run the following command:

%WINDIR%\System32\Hummingbird\Connectivity\UsrSetup /unregserver

2 Remove the UsrSetup file from the Terminal Server machine.

Note: Disabling UsrSetup is an optional procedure.
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Chapter 4: Connecting to a Host Using Session Profiles
For a full description of 
session profiles and what 
you can do with them, see 
“Managing Session 
Profiles” on page 63.

This chapter describes the different ways you can connect to a host with 
HostExplorer. It begins with a brief description of session profiles, which 
you must create before you can connect. The chapter then describes your 
various connection options.

Creating Session Profiles

A session profile is a file that contains information (host domain name or IP 
address and host terminal type) needed to connect to a host. Before 
connecting to a host, you simply create a session profile by entering this 
information. When you open HostExplorer, all session profiles are 
displayed in the Open Session dialog box. 

Session profiles contain default settings that control session functionality 
and appearance. You can access and customize the default settings before or 
after you connect to a host.

You need to create a session profile before you can connect to a host.

To create a profile:

1 In the HostExplorer Open Session dialog box, open the folder where you 
want your profile to reside.

2 Click the Create New Profile icon. 

3 In the Profile Name box, type a name for your profile. The profile name 
cannot contain any of the following characters:

\ / : * ? “ < > |

4 In the Profile Type list, click the host operating system that you intend to 
contact.

5 In the Connect By list, choose a connection method.

6 In the Host Name box, type the host domain name or IP address.

After you have created a session profile, you can connect to the host to 
which it is configured. For more information, see the following section.
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Establishing Connections

For more information about 
creating a session profile, 
see “Creating Session 
Profiles” on page 59. For 
more information about 
session profiles in general, 
see “Managing Session 
Profiles” on page 63.

In order to connect to a host successfully, you need to create a session profile 
first. After you have created a session profile, you can connect to a host in 
the following ways:

• From Hummingbird Neighborhood—All session profiles are listed 
inside Hummingbird Neighborhood; you can connect to a host by 
double-clicking one of these profiles.

• From the desktop—You can launch HostExplorer directly from the 
desktop and then choose a session profile to create a connection.

• From the command line—You can launch HostExplorer directly from a 
command line and then choose a session profile to create a connection.

• With a modem (for TN3151 and Telnet connections only)—You can 
launch HostExplorer and use a modem to establish a connection with a 
host.

• To available hosts—If there is a possibility of an unavailable host, you 
can specify multiple hosts to which HostExplorer attempts to connect 
until an available host is found.

To connect to a host from Hummingbird Neighborhood:

1 On your desktop, double-click the Hummingbird Neighborhood icon to 
launch Hummingbird Neighborhood.

2 Locate the profile that is configured for the host to which you want to 
connect.

3 Double-click the profile.

When the host logon screen displays, you can log on and start working.

Note: To automate a connection, you can create a shortcut. For 
more information, see “Creating Connection and Login Shortcuts” 
on page 85.
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To connect to a host from the desktop:

1 On the desktop, double-click the HostExplorer icon.

2 In the Open Session dialog box, double-click the profile that is 
configured for the connection you want.

When the host logon screen displays, you can log on and start working.

To connect to a host from the command line:

1 On the Windows Star t menu, click Run.

2 In the Open box, type the full path to the HostExplorer executable, 
enclosing it in quotation marks. For example, the default path is:

“C:\Program Files\Hummingbird\Connectivity\version\
HostExplorer\HostEx32.exe”

where version is the version number of your Hummingbird product.

You can click Browse to browse for the executable.

3 Click OK.

4 In the Open Session dialog box, double-click the profile that is 
configured for the connection you want.

When the host logon screen opens, you can log on and start working.

To connect using a modem (TN3151 and Telnet only):

1 In the Open Session dialog box, right-click a profile and click Properties. 
The Session Profile dialog box opens.

2 Double-click Session and click Host.

3 In the Connect By list, click Modem.

4 In the Telephone Number box, type the telephone number of the host to 
which you want to connect.

5 Select the Use Area Code and Country Code check box.

6 In this area, select the country and type the area code.

7 In the Modem list, select the modem you want to use.
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8 Configure any additional properties in the dialog box. For example, you 
can configure the line properties by clicking Configure Line.

9 Click OK.

10 In the Open Session dialog box, click Connect.

When the host logon screen opens, you can log on and start working.

To connect to an available host:

1 In the Open Session dialog box, right-click a profile and click Properties. 
The Session Profile dialog box opens.

2 Double-click Session and click Host.

3 In the Host Name box, type the name of each host, separated by a 
semicolon, and click OK.

4 In the Open Session dialog box, click Connect.

Automating a Remote Host Connection
For information about 
automating connections 
with Quick-Keys, see 
“Working with Quick-Keys” 
on page 144.

You can automate the steps to launch HostExplorer by creating a 
HostExplorer icon and adding it to your desktop. 

To add an icon to the desktop:

1 In the Open Session dialog box, right-click a profile and click Create 
Shortcut.

2 In the Browse for Folder dialog box, browse to the desktop and click OK.

Note: This procedure assumes that you have installed and 
configured a modem for the host that you want to call. For modem 
installation instructions, refer to the Microsoft Windows 
documentation.

Note: HostExplorer attempts the connections according to the 
order of the host names entered.
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To remove an icon from the desktop:

1 On the desktop, right-click the icon and click Delete.

2 Click Yes to confirm the deletion.

Disconnecting From a Host
You can disconnect from a host by clicking Disconnect on the File menu. 
Before disconnecting, you must log off the host system. 

If the host system prematurely disconnects, you can use the default 
disconnect setting, Keep Session Window Open, to keep the session window 
open when the session is terminated. You can also change the disconnect 
options.

To change the disconnect action:

1 On the Options menu, click Edit Session Profile. The Session Profile 
dialog box opens.

2 Double-click Session and click General.

3 In the Upon Disconnect from Host  list, click one of the following options:

• Close Session Window—Closes the session window when the 
connection is terminated.

• Keep Session Window Open—Keeps the session window open.

• Restart Session—Forces HostExplorer to re-connect to the host.

• Show Open Session Dialog—Opens the Open Session dialog box. 
This option lets you reconnect to another session without having to 
re-launch the program. This option works only if the host 
terminates the only open window.

Managing Session Profiles

For information about 
creating profiles, see 
“Creating Session 
Profiles” on page 59.

After creating a session profile, you can perform the following actions:

• configure them

• save them

• move, copy, delete, or rename them
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Configuring Session Profiles
You can convert 
Attachmate Extra! profiles 
into HostExplorer profiles. 
For more information, see 
“Converting Attachmate 
EXTRA! Macros and 
Profiles” on page 153.

You can access session profile settings either before or after you connect to a 
host. Session profile settings, located in the Session Profile dialog box, let 
you customize components of the session window and the functionality of 
HostExplorer features.

To access session profile settings before connecting:

1 In the Open Session dialog box, right-click a session profile and click 
Proper ties. The Session Profile dialog box opens.

2 Double-click a folder to access the settings you want to customize.

To access profile settings after connecting:

1 On the Options menu, click Edit Session Profile. The Session Profile 
dialog box opens.

2 Double-click a folder to access the settings you want to customize.

Saving Session Profiles
While connected to the host, you can update and save the most recent 
changes you made to the current session profile, or you can rename the 
profile to create a new one.

When you close a session, the default setting, Save Profile on Window Close 
(located in the Session Properties dialog box), saves any changes you made 
to the session profile. If you want to experiment with settings without the 
risk of saving them when you exit, you can remove the default save setting. 

To save a session profile:

1 On the File menu, select Save Session Profile. The Save Profile dialog box 
opens.

2 Do one of the following:

• To save the changes to the current session profile, click Save.

• To save the settings as a new session profile, type a new name and 
click Save.
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To change the save setting:

1 On the Options menu, click Edit Session Profile. The Session Profile 
dialog box opens.

2 Double-click Session and click General.

3 Clear the Save Profile on Window Close option.

Editing Session Profiles
To select multiple items at 
once, hold down Shift or 
Ctrl while clicking profiles 
or folders.

After you have created session profiles, you can reorganize them in the 
following ways:

• create folders to contain them and move them

• copy them

• delete or rename them

To create a new folder to contain session profiles:

1 In the Open Session dialog box, right-click in an empty area of the pane 
and click New Folder. The new folder appears with a temporary name.

2 Type a name for the new folder and press Enter.

To move a session profile or folder:

1 In the Open Session dialog box, right-click the session profile or folder 
you want to move and click Cut.

2 Open the folder into which you want to move the session profile or 
folder.

3 Right-click in the pane and click Paste.

Note: After you remove this setting, you must click Save Session 
Profile on the File menu to save any changes when you close your 
session.
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To copy a session profile or folder:

1 In the Open Session dialog box, right-click the session profile or folder 
you want to copy and click Copy.

2 Open the folder in which you want to place the session profile or folder.

3 Right-click in the pane and click Paste.

To delete a session profile or folder:

1 In the Open Session dialog box, right-click the session profile or folder 
you want to delete and click Delete.

2 Click Yes to confirm the deletion.

To rename a session profile or folder:

1 In the Open Session dialog box, right-click the session profile or folder 
you want to rename and click Rename.

2 Type the new name and press Enter.

Closing a Session
When you close a session, you are terminating the connection with the host 
system. To ensure that you close any active processes on the host, it is 
recommended that you log off before closing your session. 

To close a session:

1 Log off from the host (recommended).

2 On the File menu, click Close Session.

3 Click Yes to confirm the session termination.

Note: A profile name cannot contain any of the following 
characters: \ / : * ? “ < > |
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Chapter 5: Editing in the Host Window
This chapter describes how you can edit host data using copy, paste, cut, 
and some word-processing features; you can also customize the edit settings 
in the Edit Settings dialog box. 

Some edit settings are specific to the terminal. For example, settings in the 
Edit folder are not available when you are connected to a UNIX host.

Before you edit host data, consider the following factors:

• Have you modified the mouse settings? Some functions are possible 
only with the default mouse settings.

• Is the location to which you want to copy the text protected or 
unprotected?

• What is the host operating system?

Cutting, Copying, and Pasting Text

You can use the cut, copy, and paste features for any unprotected area of the 
screen.

To cut, copy, and paste text:

1 In the host session window, select the block of text you want to cut or 
copy.

2 On the Edit menu, click either Cut or Copy.

3 Position your cursor in the unprotected area of the screen where you 
want to paste the text.

4 On the Edit menu, click Paste.
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Dragging Text to a New Location

This feature is available only on mainframes and AS/400 systems, and 
functions only in an unprotected area of the screen.

In addition, the following procedure is possible if you have not modified the 
default mouse settings. To restore default settings, in the Mouse category of 
the Edit Settings dialog box, click Reset All.

To drag a block of text to a new location:

1 In an unprotected area of the host session window, select the block of 
text that you want to move.

2 Do one of the following:

• To move the text, drag the selected rectangle to the new location.

• To place a copy of the text at the new location, hold down the Ctrl 
key and drag the selected rectangle to the new location.

Enabling Auto Copy

When you enable Auto Copy, all text that you select is automatically copied 
and pasted to the Clipboard.

To enable Auto Copy:

1 On the Options menu, click Edit Session Profile. The Session Profile 
dialog box opens. 

2 Double-click Editing and click General.

3 Select the Auto Copy Selected Text option.

4 Click OK. 
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Using Entry Assist and Word Wrap

HostExplorer provides two editing features, Entry Assist and Word Wrap, 
that you can use to make your editing tasks more efficient.

Entry Assist
Entry Assist, available only in TN3250 and TN5250 sessions, provides 
word-processing features for editing text in memos, letters, and reports. 
With Entry Assist enabled, you can use Word Wrap, Tab Stops, and Margin 
options.

Entry Assist also provides a cursor position indicator in the Operator 
Information Area (OIA). As you move the cursor, its row and column 
position is indicated. For example, in a model 2 terminal, a value of 1/1 
represents the upper left-hand corner, and a value of 24/80 represents the 
lower right-hand corner. When you enable End-of-line and Tab Stops, a 
horizontal arrow appears next to the DOC indicator. The DOC indicator 
appears in the lower-right corner of the OIA when you enable Entry Assist.

Word Wrap
With Word Wrap enabled, text at the right-hand margin wraps down to the 
next available line. In modes other than Insert mode, you must clear the 
next line before typing.

Word Wrap can work within preset margins or use the field width as the 
value for the left and right margins. This lets you use Word Wrap within 
different systems without resetting the margins. 

To enable Entry Assist and Word Wrap:

Press Ctrl+E to toggle 
Entry Assist on and off. 
Press Ctrl+W to toggle 
Word Wrap on and off.

1 On the Options menu, click Edit Session Profile. The Session Profile 
dialog box opens.

2 Double-click Editing and click Entry Assist.

3 Select both options: Entry Assist Enabled and WordWrap Enabled. 

4 To set tab stops, type a numeric value in the Tab Stops box. You can also 
click in any unprotected area of the screen and click Set.
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Chapter 6: Customizing Terminal Peripherals
This chapter describes how you can customize your hardware and window 
components. 

You can simplify and automate repetitive tasks by customizing the mouse, 
toolbar, and keyboard. You can also enhance the session display by assigning 
color schemes and Windows bitmaps to the session window and terminal 
screen.

Customizing the Mouse

You can remap mouse buttons to perform different functions, choosing to 
save your changes to a profile or only to the current session. For example, 
you can configure the right-click action to perform any of the available 
functions listed in the Mouse category of the Terminal folder. 

The following table shows the default mouse settings and their associated 
actions.

To remap a mouse button:

1 On the Options menu, click Edit Session Profile. The Session Profile 
dialog box opens.

2 Double-click Terminal and click Mouse.

Mouse Setting Action

Click Moves the cursor to the pointer location.

Double-click Selects the word at the current pointer location.

Shift+click Expands the currently selected area. If an area of text is 
not selected, it selects the rectangular area between the 
cursor and the mouse pointer.

Right-click 
(mainframe and AS/
400)

Moves the cursor to the pointer location and transmits the 
data. This option is useful in programs compliant with 
System Application Architecture (SAA).

Right-click (UNIX) Pastes any Clipboard data to the current pointer location.
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3 In the Mouse Action list, click an action.

4 In the Function Group list, click the group to which you want to add the 
new mouse action.

5 In the Function list, click the function that you want to map to the 
mouse action.

6 Click Set to apply the changes.

Customizing the Keyboard

To reset the currently 
mapped mode, click Clear 
Entry. To reset all modes 
for the current key, click 
Default. To reset all keys to 
their default values, click 
Reset All.

Using the graphical keyboard utility, you can remap keys to personalize 
your keyboard, then use the keyboard file while working on multiple hosts. 
You can map and assign the keys on your PC keyboard to different values, 
functions, Quick-Keys, and macros. 

Keyboard mapping is useful if you require a key that does not exist on your 
keyboard or if you are more familiar with a terminal keyboard (such as a 
DEC VT220 keyboard) and want to remap your PC keyboard to its 
specifications. 

To remap a key:

1 On the Options menu, click Keyboard Mapping. The Keyboard Map dialog 
box opens.

2 Select a mode for the new key. For example, if you want to remap a key 
in Shift mode, select Shift.

3 In the Function Group list, choose a function group.

4 In the Function list, drag a function to a key in the keyboard mapping 
area. This deletes the old key mapping and maps the new function.  
Values for the selected key are displayed in the Description area.

Note: Your changes apply only to the current session. To save 
changes for other sessions using the current profile, click Save 
Session Profile on the File menu. Then select a profile and click 
Save.
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5 Click Save to open the Save Keymap dialog box.

6 In the Save Keymap dialog box, enter a name for the keyboard file, and 
click Save.

7 In the Keyboard Map dialog box, click OK.

Reconfiguring an Existing Keyboard

You can use the default keyboard files as templates to create custom files. 
After modifying a default keyboard file, save the file with a new name so 
that the default keyboard is preserved.

To reconfigure an existing keyboard file: 

1 On the Options menu, click Edit Session Profile. The Session Profile 
dialog box opens.

2 Double-click Terminal and click Keyboard. 

3 In the Keymap list, select Default. 

4 Click Keyboard Mapping. 

5 Make the necessary changes.

6 Click Save to open the Save Keymap dialog box.

7 Type a new name and click Save. 

The new keyboard file now displays in the Keymap list.

To enable a new keyboard file:

1 On the Options menu, click Edit Session Profile.

2 Double-click Terminal and click Keyboard.

Note: To restore the original keyboard mappings, click Reset All. 
To restore the mapping for only one key, click the key and click 
Default.
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3 In the Keymap list, click the keyboard file you want.

4 Click OK. The current session then uses the selected keyboard file. 

Customizing the Toolbar

The default toolbar contains buttons that execute menu commands. You 
can configure buttons on the default toolbar to simplify tasks by remapping 
them to execute different commands. You can also create and maintain 
several toolbars that are designed specifically for tasks in a session or  
designed generically for use in other sessions. 

A toolbar button is defined by all of the following:

• the command line that is executed when you click it

• its graphic or icon

• its context-sensitive ToolTip

Button-Related Tasks
You can perform the following procedures to customize the buttons on a 
toolbar.

To add a new toolbar button: 

1 On the Tools menu, click Toolbars. The Toolbars dialog box opens.

2 On the Toolbars tab, select the toolbar to which you want to add a 
button. The toolbar appears in the workspace.

3 Click the Functions tab and select a Function Group.

Note: To use this keyboard file with other sessions using the 
current profile, click Save Session Profile on the File menu. Then 
click the profile to which you want to save the keyboard file.
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4 In the Function box, drag an individual function to the toolbar in the 
workspace. A button is created with that function assigned to it.

5 Click OK.

To delete a toolbar button:

1 On the Tools menu, click Toolbars. The Toolbars dialog box opens.

2 In the host session window, right-click the toolbar button that you want 
to delete and click Delete Button.

3 Click OK.

To move a toolbar button:

1 On the Tools menu, click Toolbars. The Toolbars dialog box opens.

2 In the host session window, position the cursor over a button.

3 Drag the button to a new location.

4 Click OK.

To change the toolbar button caption:

1 On the Tools menu, click Toolbars. The Toolbars dialog box opens.

2 In the host session window, right-click the button that you want to 
change and click Edit Caption. The Edit Caption dialog box opens.

3 Type the new caption and click OK. The new caption is assigned to the 
toolbar button.

4 Click OK.

Note: To restore the default settings, click Reset.
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To change the image of a toolbar button to one supplied by HostExplorer:

1 On the toolbar, right-click the button that you want to change and click 
Customize. The Toolbars dialog box opens.

2 In the host session window, right-click the button, point to HostExplorer 
Images, and click one of the images in the display. The toolbar button 
image changes to the one that you selected.

3 Click OK to close the dialog box.

To change the image of a toolbar button to a customized one:

1 Create an image that you want to use for the toolbar button using a 
graphics illustration program such as Microsoft Paint. The graphic 
must have with the following properties:

• format—bitmap

• size—16 X 16 pixels

• image color—16 color

• background color—RGB (192, 192, 192)

2 Place the image in the HostEx\Toolbar directory where the user files are 
stored on your machine. For the appropriate directory path for your 
platform, refer to the list of default locations for user files in the section, 
“Current User versus “All Users”” on page 26. 

3 In the host session window, open the Toolbars dialog box.

4 On the Options tab, click the browse button next to the User Customized 
Image File box. The Browse dialog box opens.

5 Browse to your image and click Open.

6 Click Apply and leave the Toolbars dialog box open.

7 In the host session window, right-click the button that you want to 
change.

8 Point to User Customized Images and click the image that you want to 
use. The toolbar button image changes to the one that you selected.

9 Click OK.
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To change the display of a toolbar button:

1 On the Tools menu, click Toolbars. The Toolbars dialog box opens.

2 In the host session window, right-click the button that you want to 
change.

3 Point to Style and click one of the following items:

Default—Displays only the toolbar button image. This is the default.

Image Only—Displays only the toolbar button image. 

Label Only—Displays only the caption of the toolbar button.

Image and Label—Displays both the image and the caption of the 
toolbar button.

4 Click OK to close the dialog box.

To increase the size of the toolbar buttons:

1 On the Tools menu, click Toolbars. The Toolbars dialog box opens.

2 On the Options tab, select the Large Icons option.

3 Click Apply.

4 Click OK to close the dialog box.

Toolbar-Related Tasks
For quick access to frequently used features, you can create new toolbars 
and map commands and characters to the toolbar buttons. You can also 
customize existing toolbars in various ways.

To create a toolbar:

1 On the Tools menu, click Toolbars.  The Toolbars dialog box opens.

2 On the Toolbars tab, click New.

3 Type a name for the toolbar and click OK. The toolbar name is added to 
the Toolbars pane, and the toolbar itself appears in the workspace.

4 On the Functions tab, choose a function group. You can then drag 
individual functions onto the new toolbar to create buttons.

5 Repeat step 4 for each function that you want to add to the toolbar.
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To insert a separator on a toolbar:

1 Right-click a button to the right of where you want the separator.

2 Click Inser t Separator.

To move a toolbar:

1 Position the cursor either over a handle (the double separator lines on 
the extreme right and left of the toolbar) or over a blank area of the 
toolbar (not near a button).

2 Drag the toolbar to the location you want.

To turn off the ToolTips:

1 On the Tools menu, click Toolbars. The Toolbars dialog box opens.

2 On the Options tab, clear the Show ToolTips on Toolbars option.

3 Click Apply.

4 Click OK.

To hide a toolbar:

1 If the toolbar is anchored to the margin, drag it to the terminal screen.

2 Position the cursor over the title bar.

3 Right-click the title bar and click Hide.

To redisplay a toolbar:

1 On the Tools menu, click Toolbars. The Toolbars dialog box opens.

2 On the Toolbars tab, select the toolbar you want to reappear.

3 Click Apply.

4 Click OK.

Note: The toolbar is attached by default to the top margin of the 
terminal screen. You can position the toolbar along any margin of 
the session window, anywhere within the terminal screen, or 
anywhere on the Windows desktop. 
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Restoring Button and Toolbar Default Settings
If you want to undo any customization changes, you can restore both the 
button and toolbar settings to their original defaults.

To restore default settings: 

1 On the Tools menu, click Toolbars. The Toolbars dialog box opens.

2 On the Toolbars tab, select the toolbar that you want to restore.

3 Click Reset.

Customizing the Session User Interface

There are several ways to customize the session window and terminal 
screen. You can design the window and screen peripherals to be specific to 
the current session or for generic use in other sessions. 

Additionally, the Track menu provides quick access to frequently used 
session functions (menu options; action, editing and Quick-Keys; and 
unique characters). You can configure the Track menu to execute commands 
that are specific to a session.

To modify font attributes:

1 On the Options menu, click Edit Session Profile. The Session Profile 
dialog box opens.

2 Double-click Display and click Fonts.

3 Click Select Font. The Session Font dialog box opens.

4 In the dialog box, assign the desired attributes. For best resolution, use 
bitmap fonts.

5 Click Apply.

6 Click OK.
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To modify cursor attributes:

1 On the Options menu, click Edit Session Profile. The Session Profile 
dialog box opens.

2 Double-click Display and click Cursor.

3 In the Cursor Type list, click an option to assign a shape to the cursor. 

4 In the Cursor Mode list, click an option to assign either Blink or Solid 
mode.

To modify session component colors:

1 On the Options menu, click Edit Session Profile. The Session Profile 
dialog box opens.

2 Double-click Color and click General.

3 In the Scheme list, click a color scheme.

4 Click Apply.

To assign a Windows bitmap pattern between the session window and the 
terminal screen:

1 On the Options menu, click Edit Session Profile. The Session Profile 
dialog box opens.

2 Double-click Display and click Workspace.

3 Select the Show Bitmap For Workspace's Background option.

4 In the Bitmap File box, browse to your Windows bitmap directory. For 
example:

C:\winnt

5 Select a bitmap.

Note: These changes affect the session window, terminal screen, 
toolbar, and title bar. To implement these changes for future 
sessions, click Save Session Profile on the File menu. Then click 
the profile to which you want to save the changes.
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6 Click Apply.

To eliminate the border between the window and the screen:

1 On the Options menu, click Edit Session Profile. The Session Profile 
dialog box opens.

2 Double-click Display and click Fonts.

3 Select the Force Exact Terminal Window Size option and click OK.

To specify text for the title bar:

1 On the Options menu, click Edit Session Profile. The Session Profile 
dialog box opens.

2 Double-click Session and click Window Title.

3 In the Window Title box, type the desired Special Identifier variable(s).

4 Click OK.

Customizing the Track Menu
You can customize the Track menu in two steps: first, you map it to a mouse 
action, then you assign functions. 

In the following procedure, you map the Track menu to appear when you 
right-click. 

Note: The default color of the area between the session window 
and the terminal screen is grey. If the Windows bitmap pattern 
does not display after you make the changes, do the following: in 
the Font category of the Display folder, clear Force Exact Terminal 
Window Size.

Note: By default, the color of the border between the session 
window and the terminal screen is gray. If you choose not to 
eliminate this border, the border increases when you enlarge the 
session window.
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To map the Track menu to the mouse:

1 On the Options menu, click Edit Session Profile. The Session Profile 
dialog box opens.

2 Double-click Terminal and click Mouse.

3 In the Mouse Action list, click Right Single Click.

4 In the Function Group list, click System Commands.

5 In the Function list, click Show-Track-Menu.

6 Click Set.

With the menu mapped to a mouse action, you can now use the following 
procedure to customize the menu.

To customize the Track menu:

1 On the Options menu, click Edit Session Profile. The Session Profile 
dialog box opens.

2 Double-click Terminal and click Track Menu.

3 In the Function Group list, click an option.

4 In the Function list, click an option.

5 Click Append.

Changing the Language
When you change the language for a 3270 or 5250 session, HostExplorer 
automatically applies the correct keyboard ID, code page, and character set. 
You can have multiple sessions running using different languages. 

To change the language:

1 On the Options menu, click Edit Session Profile. The Session Profile 
dialog box opens.

2 Double-click Terminal and click Language.

3 In the Language list, select a language.

4 Click OK.
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Customizing the UNIX Session User Interface

The UNIX host provides features that are unique to the UNIX environment. 
These features let you customize the session window and terminal screen in 
ways that are not possible on a mainframe or AS/400 host. 

Scrollback Buffer
The Scrollback buffer is a zone that lets you scroll through data that has 
scrolled off the terminal screen. Once enabled, you can search the scrollback 
zone for text strings. You can set a value between 1 and 9,999 as the number 
of lines maintained within the zone. To disable the Scrollback buffer, set the 
number to zero.

Compose Sequences
To view a list of the 
compose sequences, see 
the HostExplorer online 
Help.

A compose sequence is a combination of two keys pressed sequentially to 
create a special character not available on the keyboard. Using compose 
sequences, you can enter special characters on a UNIX terminal screen. 

Compose sequences work only in Compose (CMP) mode. When you start 
Compose mode, the CMP indicator appears in the status line. Some 
compose sequences are available when you use both the ISO Latin-1 or DEC 
Supplemental UPS (User-Preferred Supplemental) character set; other 
compose sequences are available to specific character sets. 

To search the Scrollback buffer:

1 On the Edit menu in a UNIX session, click Find.

2 Type the text for which you want to search.

3 Specify the search direction.

4 To search for text containing the same case, select Match Case.

5 Click Find Next.

Note: If the text string exists, the line containing the text moves to 
the top of the screen. If the text string is on the current screen, the 
line does not move.
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To hide the Scrollback buffer:

The following procedures 
apply only to the Telnet 
terminal type.

1 On the Options menu, click Edit Session Profile. The Session Profile 
dialog box opens.

2 Double-click Display and click General.

3 In the Lines Available in Scrollback box, change the value to 0.

To start Compose mode and create a character:

1 Press Alt+F8. This key combination displays the CMP indicator in the 
status line. 

2 Press the two-key combination that defines the special character.

To change the character sets:

1 On the Options menu, click Edit Session Profile. The Session Profile 
dialog box opens.

2 Double-click Terminal and click Character Set.

3 Select the User-Preferred Supplemental (UPS) character set you want to 
use.

4 Select the National Replacement Character (NRC) set you want to use.

5 Click OK. 

To modify screen dimensions:

1 On the Options menu, click Edit Session Profile. The Session Profile 
dialog box opens.

2 Double-click Display and click Screen Layout.

3 Do one of the following:

• On the Default Screen Width menu, click a screen width.

• Click Custom and type a value in the Columns box.

4 Type a value in the Row box and click OK.
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To set tab stops:

1 On the Options menu, click Edit Session Profile.

2 Double-click Display and click Tab.

3 Click in the Tab Stop box.

4 Click the screen where you want to set a tab stop and click Set.
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Chapter 7: Transferring Files
This chapter describes how to transfer files between your PC and 
mainframe, AS/400, and UNIX systems.

• Mainframe transfers—To transfer mainframe data, use Telnet. 
HostExplorer uses proprietary protocols on top of the TN3270 
connection. Transfers are initiated from within the session.

• AS/400 transfers—To transfer unstructured data, use FTP for Windows 
Explorer; these transfers are initiated from within Hummingbird 
Neighborhood. To transfer structured data, use the 5250 File Transfer 
Wizard; these transfers are initiated from within the wizard.

• UNIX transfers—To transfer UNIX data, use Telnet or FTP for 
Windows Explorer. For Telnet transfers, HostExplorer uses protocols 
such as Xmodem, Ymodem, Zmodem, and Kermit; these transfers are 
initiated from within the session. FTP for Windows Explorer transfers 
are initiated from within Hummingbird Neighborhood.

For mainframe and UNIX transfers, you can use either your hard drive or 
the Clipboard as the source or destination for the transferred data. If you 
use the Clipboard as the destination when you download host data, you can 
then paste the data directly to a Windows application.

This chapter also describes troubleshooting techniques for problems related 
to PC-to-host interactions in HostExplorer. You can use the following 
features for isolating problems:

• logging session activity using the Trace utility

• logging session activity using a command-line trace

Transferring Files to and from a Mainframe

The IND$FILE protocol lets you transfer files between your PC and VM/
CMS, TSO, MUSIC/SP, and CICS host systems.

To transfer files to a mainframe:

To stop a transfer, click 
Cancel in the file transfer 
dialog box.

1 On the Transfer menu, click Send File to Host.

2 In the Source list, click either Disk or Clipboard, depending on where the 
data currently resides.
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3 In the Scheme list, select one of the available file-transfer schemes.

4 In the Local File Name box, type the name of the file you want to upload 
or browse to its location.

5 In the Host File Name box, type the name of the file you want to create 
on the host. This option varies according to the scheme (CICS, CMS, or 
TSO) you selected.

6 In the Minidisk box, specify the intended mainframe location for the file.

7 If you want to use a template to format the file, click Templates and 
specify a template; click OK when finished.

8 To start the transfer, click OK.

To receive files from a mainframe:

1 On the Transfer menu, click Receive File from Host.

2 In the Scheme list, select one of the available file-transfer schemes.

3 In the Host File Name box, type the name of the file you want to 
download from the host. This option varies according to the scheme 
you select.

4 In the Destination list, click either Disk or Clipboard as the download 
destination.

5 In the Local File Name box, type the name of the file you want to create 
or overwrite on your PC.

6 If you want to use a template to format the file, click the Templates 
button and specify a template; click OK when finished.

7 To start the transfer, click OK.

Transferring Files to and from AS/400

To transfer files between your PC and an AS/400 system, you can use either 
FTP For Windows Explorer for unstructured data or the 5250 File Transfer 
Wizard for structured data.
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FTP For Windows Explorer is included with HostExplorer; it lets you 
connect to an FTP server and transfer the necessary files. For more 
information, see "Chapter 8: FTP for Windows Explorer" on page 105.

The 5250 File Transfer Wizard provides a series of dialog boxes that let you 
configure the settings for a file transfer profile; you can use the wizard to 
create a profile from scratch or create one based on an existing profile. 
When the profile is complete, the wizard begins the transfer. If you are 
transferring files from a host to your PC, you can also use the wizard to 
specify SQL statements for the transfer.

Transferring Files Using the 5250 File Transfer Wizard
If you want to transfer files containing structured data to or from an AS/400 
system, use the 5250 File Transfer Wizard. The options in the wizard depend 
on whether you transfer files to a host or from a host.

PC-to-AS/400 File Transfers Using the Wizard
To launch the 5250 File Transfer Wizard, on the Windows Start menu, 
navigate to the HostExplorer program group, and click 5250 File Transfer. 

The Welcome To 5250 File Transfer Wizard dialog box opens. In this dialog 
box, choose whether you want to create a new transfer profile or use an 
existing one. If you want to use an existing one, you can specify the name 
directly in the dialog box or browse to its location. Click Next when finished.
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The General Setup dialog box appears, as shown below.

After you have configured the necessary options, click Next. The PC File 
Setup dialog box opens for PC-to-AS/400 transfers, as shown below.

Choose the direction 
of the transfer.

Type the name or IP 
address of the host.

Type your ID and 
password on the AS/400.Choose the host code 

page used to translate 
data from PC or AS/400 
format to the destination 
format.

Choose to keep record 
of the transfer in the 
trace file that you 
specify.

Specify the path to 
the source file (the 
one you want to 
transfer).Use a Field Description 

File (FDF), an ASCII file 
that describes the 
structure of data in a 
PC file; if you do not 
select this check box, 
the wizard assumes 
the presence of a 
Source Physical file.

Choose the type of file 
to send to the AS/400; 
choose No Conversion 
to send or receive 
binary data. This option 
is disabled when you 
use an FDF, since the 
file type is embedded in 
the FDF.
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After you have configured the necessary options, click Next. The Host File 
Setup dialog box opens for PC-to-AS/400 transfers, as shown below.

After you have configured the necessary options, click Next. The 5250 File 
Transfer Wizard Complete dialog box opens. Use this dialog box to save all of 
the settings from the wizard into a transfer profile (which you can reuse at a 
later time), or you can begin the transfer immediately.

AS/400-To-PC File Transfers Using the Wizard
On the Windows Start menu, navigate to the HostExplorer program group, 
and click 5250 File Transfer to launch the 5250 File Transfer Wizard. 

The Welcome To 5250 File Transfer Wizard dialog box opens. In this dialog 
box, choose whether you want to create a new transfer profile or use an 
existing one. If you want to use an existing one, you can specify the name 
directly in the dialog box or browse to its location. Click Next when finished.

Specify the full path to 
the destination library/
file (member) on the 
AS/400.

Specifies how and 
where the wizard 
places the uploaded 
data.

Set the permissions on 
the destination file.Type a description of 

the member or file on 
the AS/400; this text 
appears as a ToolTip 
when you rest the 
cursor on the member 
or file in the host tree.

Select the type of file to 
create on the AS/400; 
select Data for a 
database file and 
Source for a text file.

Specify the record 
length of the AS/400 
(member).

Specify the path to a 
template file on the AS/
400 for the destination 
file; this option is 
available when you 
select Create File And 
Member for the AS/400 
Object.
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The General Setup dialog box opens, as shown below.

After you have configured the necessary options, click Next. The PC File 
Setup dialog box opens for AS/400-to-PC transfers, as shown below.

Choose the direction 
of the transfer.

Type the name or IP 
address of the host.

Type your ID and 
password on the 
AS/400.

Choose the translation 
code page.

Choose to keep 
record of the transfer 
in the trace file that 
you specify.

Note: Field Description Files are not mandatory for downloads 
from an AS/400 host to your PC. However, if you want to 
manipulate the downloaded data and then upload it back to the 
host, you need to use an FDF when you upload to preserve the 
structure.
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In the PC File Setup dialog box for an AS/400-to-PC transfer, you can click 
Field Format to open the Field Format Options dialog box. Use this dialog box 
to specify how to format any date, time, or decimal fields in the file being 
transferred.

Specify the path to the 
destination file.Use a Field Description 

File, an ASCII file that 
describes the structure 
of data in a PC file.

Choose the type of file 
to transfer; choose No 
Conversion to send or 
receive binary data. 
This option is disabled 
when you use an FDF.

Remove trailing spaces 
in all fields in the file.

Specify an action when 
the wizard tries to create 
a destination file that 
already exists on the PC.
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You can also specify the character set and character sort sequence used in 
any SQL sorts on the file being transferred. To do this, click Misc in the Field 
Format Options dialog box.

Select how to format 
Date fields in the file 
being transferred.

Select the separator for 
Date fields.

Select how to format 
Time fields.

Select the separator for 
Time fields.

Set a flag on the AS/400 
to ignore decimal errors 
in the file; if you do not 
choose this option, the 
wizard cannot transfer 
files that contain 
decimal data errors.

Type the name of 
the user-specified 
sort table; this 
option is available 
when you choose 
User Specified 
Table for the Sort 
Sequence.

Specify the 
character set to use 
for any SQL sorts on 
the file

Select the language to use for the 
file; this option is available when 
you choose User Specified Table 
for the Sort Sequence.

Select the separator used 
for decimal numbers.

Select a language 
(character set) for 
the file; this option 
is available when 
you choose 
Shared Weight 
Table or Unique 
Table Weight Table 
for the Sort 
Sequence.
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After you have configured the necessary options in the PC File Setup dialog 
box for AS/400-to-PC transfers, click Next. The Host File Setup dialog box 
opens for AS/400-to-PC transfers, as shown below.

After you have configured the necessary options in the Host File Setup dialog 
box, click Next. The 5250 File Transfer Wizard Complete dialog box opens. Use 
this dialog box to save all of the settings from the wizard into a transfer 
profile (which you can reuse later), or you can begin the transfer.

Transferring Files to and from UNIX

To stop a transfer, click 
Cancel in the file transfer 
dialog box.

To transfer files between your PC and a UNIX host, the host computer must 
support Xmodem, Ymodem, Zmodem, or Kermit protocols. These 
protocols consist of a set of file transfer rules that your PC and the host 
system follow when transferring files. 

Before you can transfer files between your PC and a UNIX host, you require 
the following information:

• Which transfer protocol does the host support?

• What transfer information does the host require?

• What command is required to initiate the host's transfer program? The 
command you use (SZ, RZ, SX, RX, Kermit) is system-specific.

Specify the path to a 
library/file (member) on 
the AS/400.

Type SQL statements 
to select specific 
table data from the 
file.

Enable the transfer of 
records that contain 
missing fields, such as 
fields containing a NULL 
value.

Customize the SQL 
statements to be used 
on the file being 
transferred; in the 
dialog box, each type 
of SQL statement has 
its own tab, letting you 
build and customize 
each statement in turn.
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Protocols

Zmodem     The most efficient file-transfer protocol. It provides faster file 
transfers, auto-download capabilities, batch file transfers, and protection 
for 16-bit and 32-bit Cyclical Redundancy Check (CRC). It also allows both 
the sender and the receiver to initiate file transfers. Additionally, it provides 
security between program applications while eliminating file-transfer 
errors. 

Xmodem     Includes Xmodem-1K. File transfers with Xmodem require 
that each byte sent must remain unchanged and that the transfer must 
occur on a clear 8-bit channel. Data is transferred in 128-byte or 1024-byte 
(1K) packet sizes. Each packet is assigned a packet number and sent one at a 
time. Because packet sizes have fixed lengths, a file using padded bytes is 
rounded up to the next packet. For error detection, sent packets include 
Checksum or CRC bytes. Packets are sent in sequence, allowing the receiver 
to verify if a packet was sent or if it is out of order. 

Ymodem     Supports batch-file transfers and can send the file name and file 
size before the actual file data.

Kermit     The least efficient file-transfer protocol. Use it when the receiver 
does not support X/Y/Zmodem software. Kermit sends batch files with the 
name and time stamp of each file in small packet sizes. The packets contain 
fields that mark their beginning, length, type, and sequence number.

To transfer files to a UNIX host:

1 On the UNIX host, initiate the host transfer program; for more 
information, see the documentation for your host's file transfer utility.

2 On the Transfer menu, click Send File to Host. The Upload Files dialog box 
opens.

3 Click Add Files and browse to the location of your files.

4 Select one or more files and click Open.

5 In the Protocol list in the Upload Files dialog box, click the supported 
protocol for the file transfer.

6 Click Options to view and/or modify any of the transfer options. 

7 To start the transfer, click OK.
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To receive files from a UNIX host:

1 On the UNIX host, initiate the host transfer program; for more 
information, see the documentation for your host's file transfer utility.

2 On the Transfer menu, click Receive File from Host. The Download Files 
dialog box opens.

3 In the Receive Path box, specify a path; click the browse button to locate 
a file.

4 In the Protocol list in the Download Files dialog box, click the supported 
protocol for the file transfer.

5 Click Options to view and/or modify any of the transfer options.

6 To start the transfer, click OK.

Logging Session Activity

If you encounter problems related to PC-to-host interactions, you can use 
either the Trace utility or a command-line trace to find a solution. 

Creating a Trace
A trace is a diagnostic tool that logs PC-to-host interactions to the 
Hostex.trc file located in your Root directory (the directory in which the 
software is installed).

The trace utility captures all keystrokes, commands, and selections on 
menus and in dialog boxes, and it records all communication activity. After 
you have reproduced the steps that caused the problem, you can view and 
analyze the logged data.

To enable a trace, press Ctrl+Shift+T.  This key combination starts 
recording events to the Hostex.trc file.

Note: If you modified default keyboard mappings, this procedure 
may not work. To reset the default settings, open the Keyboard 
Mapping dialog box, select the letter T on the keyboard and press 
Default.
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To start a command line trace:

1 On the Windows Star t menu, click Run.

2 Browse to the following location:

C:\Program Files\Hummingbird\Connectivity\version\
HostExplorer\HostEx32.exe

where version is the version number of your Hummingbird product.

3 Add the following command line options:

-d -p

4 Add the profile name and folder extension separated by a dot. For 
example: 

test.3270

The following is an example of the full command line syntax:

C:\Program Files\Hummingbird\Connectivity\version\
HostExplorer\HostEx32.exe –d –p test.3270

where version is the version number of your Hummingbird product.
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Chapter 8: FTP for Windows Explorer
This chapter describes how to transfer files between your PC and an 
FTP server.

FTP for Windows Explorer is a client implementation of the File Transfer 
Protocol that lets you transfer both text (ASCII) and image (binary) files 
between local and network drives and FTP servers.

FTP for Windows Explorer includes the following features:

• Full integration with Windows Explorer

• Complete drag-and-drop and copy/paste features

• Support for Solaris, SunOS, AIX, Windows NT/2000, AS/400, VMS, 
VM/CMS, MVS, and VM/VPS

• Local caching of directory listings so that you can browse directories 
offline and improve overall performance

• Synchronization of files between a PC and a remote server

• Live editing so that you can automatically edit files through an 
associated application and save the changes back to the server

• Desktop shortcuts to remote files and folders

• Advanced scripting and support for OLE Automation

Creating and Managing FTP Profiles

To transfer files with FTP for Windows Explorer, you need an FTP profile. 
These profiles are necessary for a connection to a host; they contain such 
settings as user name, password, and host type. 

You can create a new profile from scratch, or you can edit the settings of an 
existing one. If you no longer need a profile, you can delete it.

To create an FTP profile:

1 Launch Windows Explorer.

2 In the left pane of the window, click Hummingbird Neighborhood.

3 Double-click the New FTP Profile icon. The FTP Site Properties dialog box 
opens.
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4 Click the General tab.

5 In the Host Address box, type the host address or IP address.

6 Type your user name, password, and initial directory in the appropriate 
text boxes.

7 In the Account box, type your account and click OK. You can select the 
Anonymous check box as an alternative to entering your account.

To edit, rename, or delete an FTP profile:

1 Launch Windows Explorer, expand the Hummingbird Neighborhood 
directory tree, and expand the FTP directory tree.

2 Right-click the FTP profile that you want to edit, rename, or delete and 
do one of the following:

• To edit the settings of the profile, click Properties and make the 
desired changes.

• To rename the profile, click Rename and type a new name.

• To delete the profile, click Delete.

Connecting to an FTP Server

Connections to an FTP server require an FTP profile to supply the necessary 
parameters; if you have not yet created a profile, see “Creating and 
Managing FTP Profiles” on page 107.

After you have established a connection, you can choose a transfer mode 
depending on the type of file you want to transfer.

You can also select the 
profile and click Connect 
and Disconnect on the 
toolbar.

To connect to an FTP server:

1 Launch Windows Explorer, expand the Hummingbird Neighborhood 
directory tree, and expand the FTP directory tree.

2 Locate the FTP profile that you want to use to launch the connection.

3 Double-click the profile.
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If the profile does not contain a valid IP address, user name, and password, 
FTP for Windows Explorer prompts you to supply the missing information.

To disconnect from an FTP server:

1 Launch Windows Explorer and expand the Hummingbird 
Neighborhood directory tree.

2 On the toolbar, click Connect and Disconnect.

Setting the FTP Transfer Mode
Before you begin to transfer files, you can specify one of the following three 
FTP transfer modes:

• ASCII—Transfers the files as ASCII text.

• Binary—Transfers the files in pure binary form.

• Auto Select—Lets FTP for Windows Explorer determine which of the 
above two modes is the best mode for the selected file.

To set the default transfer mode:

1 Launch Windows Explorer.

2 In the left pane of the window, click Hummingbird Neighborhood. The 
Hummingbird Neighborhood dialog box opens.

3 On the View menu, click Hummingbird Neighborhood Options.

4 Click the FTP Transfer tab.

5 In the File Transfer Mode list, select the desired transfer mode.

6 Click OK.

To override the default transfer mode for specific FTP profiles:

1 Launch Windows Explorer, expand the Hummingbird Neighborhood 
directory tree, and expand the FTP directory tree.

2 Right-click the desired FTP Profile and click Properties.

3 Click the Other tab.

4 Select the desired upload transfer mode for this profile.
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5 Select the desired download transfer mode for this profile.

6 Click OK.

Tracing FTP Sessions
FTP for Windows Explorer provides a tracing feature that lets you monitor 
or debug an FTP server connection. You can specify a trace file through the 
Hummingbird Neighborhood options; all information about the FTP 
server connection is then copied to this trace file.

To select a trace file:

1 Launch Windows Explorer.

2 In the left pane of the window, click Hummingbird Neighborhood.

3 On the View menu, click Hummingbird Neighborhood Options. The 
Hummingbird Neighborhood dialog box opens.

4 Click the FTP General tab.

5 Browse to the trace file that you want to use and click Open.

6 Click OK.

To enable tracing:

1 Launch Windows Explorer and expand the Hummingbird 
Neighborhood directory tree.

2 Right-click an FTP profile and click Enable Tracing.

3 Establish an FTP server connection.

Uploading and Downloading Files

After you have connected to an FTP server, you can upload files to the server 
or download them from the server. You can upload or download files in two 
ways: by copying and pasting or by dragging and dropping. To stop the file 
transfer at any time, click Cancel in the Transfer dialog box. To view the 
details of the transfer, click Show Details.
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To upload a file:

For information on 
establishing an FTP 
connection, see 
“Connecting to an FTP 
Server” on page 108.

1 Establish an FTP connection.

2 In the Exploring window, do one of the following:

• Right-click the file(s) that you want to transfer and click Copy. 
Navigate to the remote folder location, right-click the folder, and 
click Paste.

• Select and drag the file(s) to the desired location.

To download a file:

1 Establish an FTP connection.

2 In the Exploring window, do one of the following:

• Right-click the file(s) that you want to transfer and click Download. 
Click the Browse button to navigate to the local folder location, and 
click Save.

• Select and drag the file(s) to the desired location.

To transfer files between different servers:

1 Establish an FTP connection.

2 In the Exploring window, right-click the file(s) that you want to transfer 
and click Copy.

3 Right-click the new server destination and click Paste.

Viewing Files
FTP for Windows Explorer provides a View feature that lets you open a 
remote file for viewing; when you choose this option, FTP for Windows 
Explorer saves the file in a temporary directory on your PC and opens it. If 
there is no program associated with the file, FTP for Windows Explorer uses 
Notepad to display the file.
111



HostExplorer™ User’s Guide
To view a file:

1 Establish an FTP connection.

2 In the Exploring window, right-click the file that you want to view and 
click View.

Renaming and Deleting Files
After you have established an FTP connection, you can rename or delete 
files.

To rename a file:

For information on 
establishing an FTP 
connection, see 
“Connecting to an FTP 
Server” on page 108.

1 Establish an FTP connection.

2 In the Exploring window, right-click the file you want to rename and 
click Rename.

3 Type the new file name and click OK. 

To delete a file:

1 Establish an FTP connection.

2 In the Exploring window, right-click the file you want to delete and click 
Delete.

3 Click Yes to confirm the file deletion

Synchronizing Files

FTP for Windows Explorer lets you synchronize files and directories to and 
from a remote FTP site. This feature lets you maintain sets of local and 
remote files that must always have the same content; when changes are 
made to the master file, the mirror file is updated automatically. The files 
and directories to be synchronized must first be set up as synchronization 
items in the Hummingbird Neighborhood Wizard.
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To set up synchronization items:

1 Launch Windows Explorer, expand the Hummingbird Neighborhood 
directory tree, and expand the FTP directory tree.

2 Select the FTP profile where the appropriate file or directory is located.

3 Right-click the file or directory and click Synchronize. The Edit 
Synchronization Item Properties dialog box opens. 

4 In the Local Filename/Directory box, type the full path for the local file or 
directory, or click File or Directory to select the file or directory.

5 Set the Synchronization Direction by selecting one of the following 
options:

• To PC—Sets the file on the remote server as the master file. When 
synchronized, the file on your PC changes to always mirror the 
remote file.

• To Remote—Sets the file on your PC as the master file. When 
synchronized, the remote file on the server changes to always 
mirror the local file.

• Not Set—Saves the settings but does not synchronize the files.

6 Click OK to close the dialog box.

The wizard displays information about the newly synchronized files and 
directories.

To synchronize files:

For information on 
establishing an FTP 
connection, see 
“Connecting to an FTP 
Server” on page 108.

1 Establish an FTP connection. The Exploring window opens.

2 On the toolbar, click SynchWiz. The Hummingbird Neighborhood 
Synchronization Wizard dialog box opens.

3 In the Synchronization list, select the desired file.

4 Click Synchronize.

5 Click OK.
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Managing Directories for FTP

FTP for Windows Explorer lets you create, delete, and manipulate 
directories, just as you would individual files.

To create a directory:

1 Launch Windows Explorer and expand the Hummingbird 
Neighborhood directory tree.

2 Expand the FTP directory tree and open the appropriate FTP profile.

You can also click the New 
Folder button on the 
toolbar.

3 On the File menu, click New Folder.

4 In the text box, type the new folder name and click OK.

5 Click Yes to confirm the directory creation.

To delete a directory:

1 Launch Windows Explorer and expand the Hummingbird 
Neighborhood directory tree.

2 Expand the FTP directory tree.

3 Right-click the directory that you want to delete and click Delete.

4 Click Yes to verify the directory removal.

Adding a Directory to the Send To Menu
The “Send To” function in Windows Explorer provides a quick method of 
transferring files to designated directories (folders). You can add a 
Hummingbird Neighborhood FTP directory to the Send To menu.

To add a folder to the Send To menu:

1 Launch Windows Explorer and expand the Hummingbird 
Neighborhood directory tree.

2 Expand the FTP directory tree and open the appropriate FTP profile.

3 Right-click the appropriate folder and click Add To ‘Send To’ Menu.
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FTP Directory Caching

FTP for Windows Explorer maintains a cache of FTP directories and file 
names on your local machine, so you can view the directory listing without 
establishing a server connection. FTP for Windows Explorer automatically 
updates the local cache when you make changes on the remote host that 
affect the file system. Only pointers to the files, not the contents of the files, 
are stored in the local cache.

FTP for Windows Explorer also lets you select how often the cache is 
cleared; this clear setting works regardless of whether you have made 
changes to the file system on the remote host. The setting is located on the 
FTP Cache tab in the Hummingbird Neighborhood dialog box (accessible when 
you click Hummingbird Neighborhood Options on the View menu). 

To enable directory caching:

1 Launch Windows Explorer, expand the Hummingbird Neighborhood 
directory tree, and expand the FTP directory tree.

2 Right-click an FTP profile and click Properties. The FTP Site Proper ties 
dialog box opens.

3 Click the Advanced tab.

4 Select the Enable Directory Caching check box and click OK.

To clear an FTP server cache:

1 Launch Windows Explorer, expand the Hummingbird Neighborhood 
directory tree, and expand the FTP directory tree.

2 Right-click an FTP profile and click Delete Cache.

Note: You can clear individual FTP server caches or the entire FTP 
cache. The cache is not automatically updated if the remote file 
system is changed; you can press F5 to refresh a directory.

Note: When you delete an FTP server cache, FTP for Windows 
Explorer deletes the server directory that is stored locally on your 
machine.
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To clear the entire cache:

1 Launch Windows Explorer.

2 In the left pane of the window, click Hummingbird Neighborhood.

3 On the View menu, click Hummingbird Neighborhood Options. The 
Hummingbird Neighborhood dialog box opens.

4 Click the FTP Cache tab.

5 Click Clear Cache and click OK.

OLE Automation 

OLE Automation is a facility provided by Windows that permits the 
automation of tasks and the exchange of data between applications. When 
an object, such as an image file, is linked to a compound document, such as 
a spreadsheet, the document contains only a reference to the object. Any 
changes made to the contents of a linked object are seen in the compound 
document.

You can access and control FTP for Windows Explorer through OLE 
Automation. You can write OLE Automation clients using a variety of tools, 
such as Hummingbird Basic, Visual Basic, C++, and Java.

Note: When you clear the entire FTP cache, FTP for Windows 
Explorer deletes the server directories that are stored locally on 
your machine for all of the FTP profiles.

Note: The name of the automation object is HclFtp.Engine.
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Creating an OLE Script
You can code OLE Automation containers to implement all of the features 
and functions of FTP in another application that uses OLE features, such as 
Hummingbird Basic. You can work with FTP session objects to call 
functions, such as connecting to a host, transferring files from host to host, 
and so on. You can use any tool that supports OLE Automation control, 
such as Visual Basic and Visual C++.

To create an OLE Script:

1 Create the main FTP Engine object. All objects support a dual interface. 
This lets you fully use the FTP OLE features. For example:

Dim FtpEngine As Object

Set FtpEngine = CreateObject (“HclFtp.Engine”)

2 Retrieve an FTP Sessions collection. This lets you set such things as local 
drives, access permissions, and so on. For example:

Dim FtpSessions As Object

Set FtpSessions = FtpEngine.Sessions

3 Create the FTP session object. For example:

Dim FtpSession1 As Object

Set FtpSession1 = FtpSessions.NewSession

4 Set properties such as server name, user name, user account, and so on. 
For example:

FtpSession1.ServerName=”ftp.com”

5 Call session methods such as Connect to Host, User Login, Get, and so 
on. For example:

FtpSession1.UserLogin
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Chapter 9: Printing Host Data
This chapter describes how to print and log host data. HostExplorer 
provides a number of printing features.

There are a number of ways you can print and log host data. Depending on 
the print option you have selected in the Output area of the Session Profile 
dialog box, you can do the following:

• Print mainframe data to your Windows network printer.

• Print data using the PrintExplorer component; to use PrintExplorer, the 
host must support the TN3270E or TN5250E protocols.

• Capture a screen and save the data to a file; depending on the host 
system, you can capture session activity panel by panel or as one long 
file.

• Print a VT Scrollback buffer.

• Print data using HostExplorer Print Services to any LAN printer on 
your enterprise network, provided that:

• The host is a mainframe running MVS, VM, or DOS/VSE, or is an 
AS/400 system.

• The host is running a version of TCP/IP that supports the TN3270E 
and TN5250E protocols.

For more information about printing using Host Explorer Print Services, 
see the HostExplorer Print Services documentation.

Printing a Screen

You can print the screen of any host to which you are connected.

To print a screen:

1 On the File menu of the session window, click Print Screen. The Print 
dialog box opens.

2 In the Name list, choose a printer.

3 Click OK.
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Printing with PrintExplorer

For more information about 
the various PrintExplorer 
options, see the 
PrintExplorer Help.

PrintExplorer is an application that provides you with control over the 
printer and provides information about a current print job. 

To print with PrintExplorer:

1 On the Options menu of a mainframe window, click Edit Session Profile. 
The Session Profile dialog box opens.

2 Double-click Output and click PrintExplorer.

3 Click the Star t PrintExplorer Session Automatically option.

4 If you want to close PrintExplorer when you terminate the session, click 
the Close PrintExplorer Session Automatically option.

5 In the Base Print Explorer Profile box, specify a profile; click the browse 
button to search for one.

6 In the Host Name box, type the host name or IP address.

7 In the Printer LU Settings list, choose a setting.

8 Click Start Printer Now.

PrintExplorer opens; you can then choose a specific printer and configure 
print settings.

Saving Data to a File

When you save host data to a file, the data is saved to a default directory and 
file name. Before you save a screen to a file, you can specify a different 
location and file name and choose one of the following save modes:

• Overwrite—Overwrites any existing data.

• Append—Adds the new data to the end of an existing file without 
overwriting any data.
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To save data to a file:

1 On the Options menu, click Edit Session Profile. The Session Profile 
dialog box opens.

2 Double-click Output and click Save File.

3 In the Save Options list, click Overwrite or Append.

4 In the Save As Options list, click Ascii or Ansi.

5 If desired, in the Default Save Filename box, type a new directory and file 
name.

6 Click OK to save the changes and exit the dialog box.

7 On the File menu, click Save Screen to Disk.

Printing the Scrollback Buffer Contents

If you are connected to a UNIX host, you can print the contents of the 
Scrollback Buffer.

To print the contents of the Scrollback Buffer:

1 In a UNIX screen, select the text you want to print. You can scroll 
vertically to select text outside the terminal screen.

2 On the File menu, click Print Screen.

3 Click Selection and click OK.

Printing a Keyboard Mapping List

If you want to customize the functions associated with the keyboard keys, 
you can print a list of the mappings for reference.
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To print a keyboard mapping list:

1 On the Options menu, click Keyboard Mappings. The Keyboard Map 
dialog box opens.

2 In the lower-left area of the dialog box, click List Assigned Functions. The 
Current Keyboard Template dialog box opens.

3 Click Print and click OK.

Printing Using the LPR Application

You can access remote printing capabilities using the LPR (Line Printer 
Requester) application, which lets you print PC files on a host printer.

You can connect a remote printer directly to your PC as if it were a local 
printer. To provide remote host access to your PC printer, enable the LPD 
service in Inetd. This connection appears automatically in all your Windows 
applications each time you run your PC.

Setting up a Printer for LPR
Before you attempt to print, you must define your printer. How you define 
your printer depends on the location from which you are printing (PC or 
host) and the location of the destination printer (PC or host). If you do not 
define your printer properly, LPR cannot direct your file to the desired 
printer. 

Defining a Printer
The Windows products provide remote printing capabilities through the 
Line Printer Requester (LPR) application. LPR is an application that allows 
you to print PC files to any UNIX or LPD host on a TCP/IP network 
running an LPD server program. The LPR window displays a separate 
window for each UNIX or other LPD host printer queue to which you are 
connected.
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To define a printer:

1 On the Windows Star t menu, navigate to the HostExplorer program 
group and click LPR. The LPR window opens.

2 On the Printer menu, click Add Remote Printer. The Add Remote Printer 
dialog box opens.

3 In the boxes provided, type the following information:

• Host—The name or IP address of the host to which the printer is 
connected; for example, HP5SIMX.

• Queue Name—The name of the queue listed in the host's 
/etc/printcap file. This field is required.

• User ID—Your user name.
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4 If desired, select one of the following Advanced features:

• Read Host’s Queue—Automatically displays any available queue 
state information (for example, printer problems, job list, queue 
problems) from the host in the printer's window. You can also use 
the Refresh command on the Printer menu or the F5 key to update 
the hosts queue.

• Graceful Close—All data that is already queued for transmission 
will be sent, if possible, before information associated with the 
socket is released.

5 When finished, click OK.

Sending a Print Job for LPR
After you have correctly defined the printer for LPR, you can print files.

To print files to a printer:

1 On the Windows Start menu, navigate to the HostExplorer program 
group and click LPR. The LPR window opens.

2 On the File menu, click Print.

3 Browse to the file you want to print and click OK. The system 
automatically checks the printer queue, then sends the job.

Checking a Printer Queue Using LPQ

Each time you send a print job, the system automatically checks the printer 
queue. You can check the queue without sending a print job, as described in 
the following procedure.
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To check the printer queue:

1 On the Window Start menu, navigate to the HostExplorer program 
group and click LPQ.

2 In the boxes provided, type the following information:

• Host—The name or the IP address of the host whose printer queue 
you wish to view.

• Printer—The network name of the printer whose queue you wish 
to query. System Administrators sometimes name printers after the 
groups they service; for example, Documentation.

• Username—The user name in the printer queue you wish to check.

3 Click OK.

LPQ connects to the host you specified and returns information on print 
jobs pending, spooling, and printing.
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Removing or Modifying a Remote Printer

If a printer connection is no longer valid, you can remove it. If the printer 
information has changed, you can modify the printer properties. For details 
on how to remove or edit a printer connection, refer to the following 
procedures.

To remove a remote printer:

1 On the Windows Star t menu, navigate to the HostExplorer program 
group and click LPR. The LPR window opens.

2 In the window, select the printer you want to remove.

3 On the Printer menu, click Remove Remote Printer.

4 Click Yes to confirm the deletion.

To edit the properties of a remote printer:

1 On the Star t menu, navigate to the HostExplorer program group and 
click LPR. The LPR window opens.

2 On the Printer menu, click Edit Remote Printer Properties. The Edit Remote 
Printer Properties dialog box opens.

3 Edit the properties as desired. To test the printer, click Test Queue.

4 When you are satisfied with the information, click OK.
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Chapter 10: Automating and Configuring a Session
This chapter describes how to automate and configure a HostExplorer 
session. You can:

• create connection and login shortcuts

• create, run, and assign Quick-Keys

• create, edit, and run Quick Scripts

• create, edit, and run macros

Creating Connection and Login Shortcuts

You can create desktop icons and shortcuts to automate host connections at 
startup.

Automating Connections
To automate connections, you can place profiles in a Startup folder and 
then create a HostExplorer shortcut that contains a -* switch as part of the 
target string. When you double-click the shortcut, all profiles located in the 
Startup folder start automatically.

To create a Startup folder:

1 In the Open Session dialog box, make sure that you are at the top level of 
Hummingbird Neighborhood (not within a sub-folder).

2 In the upper-right corner of the dialog box, click the Create New Profile 
Folder icon. A new folder appears in the main area of the dialog box with 
a default name.

Warning!  Automating logins may cause security problems.

Note: In version 7.x of HostExplorer, a Startup folder is no longer 
created by default when you install the software. For version 7.x, 
you can manually create a Startup folder and then place profiles in 
it for automatic startup. If you are migrating from an older version 
of HostExplorer to version 7.x, the old Startup folder is left intact.
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3 For the folder name, type Startup.

4 Press Enter to save the name.

To designate profiles for automatic startup:

1 In the Open Session dialog box, right-click the existing profile(s) you 
want to designate for automatic startup and click Copy.

2 Open the Star tup folder.

3 Right-click in the main area of dialog box and click Paste.

4 In Windows Explorer, navigate to the home directory for HostExplorer, 
where home refers to the directory in which to the software is installed. 
For example:

C:\Program Files\Hummingbird\Connectivity\version\
HostExplorer\

where version is the version number of your Hummingbird product.

5 Right-click the file HostEx32.exe, click Create Shortcut, and drag the 
resulting shortcut onto the desktop.

6 On the desktop, right-click the HostEx32.exe shortcut and click 
Proper ties. The Properties dialog box for shortcut opens.

7 On the Shortcut tab, add a -* switch to the end of the target string. For 
example:

"C:\Program Files\Hummingbird\Connectivity\version\
HostExplorer\HostEx32.exe" -*

where version is the version number of your Hummingbird product.

8 Click OK.

When you double-click the shortcut on the desktop, all profiles located 
within the Startup folder start automatically. You can also place the shortcut 
in a different location if you want.
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To add an icon to the desktop: 

1 In the Open Session dialog box, right-click a profile.

2 Click Create Shor tcut. The Browse for Folder dialog box opens.

3 Browse to the desktop and click OK.

To remove an icon from the desktop:

1 On the desktop, right-click the profile that you want to remove.

2 Click Delete.

3 Click Yes to confirm the deletion.

Running Quick-Keys, Quick Scripts, or Macros at Startup
You can create a Quick-Key, Quick Script, or macro to launch the login 
script automatically each time you open HostExplorer.

For more information about:

• Quick-Keys—See “Working with Quick-Keys” on page 144.

• Quick Scripts—See “Working with Quick Scripts” on page 146.

• macros—See “Working with Macros” on page 149.

To automatically run a Quick-Key, Quick Script, or macro at startup:

1 On the Options menu of a session window, click Edit Session Profile. The 
Session Profile dialog box opens.

2 Double-click Session and click General.

3 In the Auto Star t Quick-Key/Quick Script/Macro box, type the full path 
name of the Quick-Key, Quick Script, or macro that you want to use; 
click the browse button to search for one. 

Note: If you click the browse button to search for Quick-Key or 
macro files, in the Files of Type list, select Hummingbird Basic 
Files; and to search for Quick Script files, select HostExplorer 
Quick Script Files.
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4 Click OK when finished.

5 On the File menu, click Save Session Profile. The Save Profile dialog box 
opens.

6 Select the profile or type a new name.

7 Click Save.

Automating Your Login
You can automate your login to a host by creating a Quick-Key or Quick 
Script that contains the necessary information. The procedure for creating 
an automated login Quick-Key or Quick Script depends on the type of host 
to which you are connected.

Creating an Auto-logon Quick-Key

To automate your login (5250 and, in some cases, 3270):

1 Connect to a host. For more information, see “Establishing 
Connections” on page 60.

2 On the Options menu, click Quick-Keys. The Quick-Key Editor dialog box 
opens.

3 In the Quick-Key Name box, type a name for the Quick-Key.

4 In the Assigned Quick-Key String box, type your login name (user ID), 
enclosed within quotation marks.

5 In the Function Group list, click Editing Keys.

6 In the Function list box, click Tab.

7 Click Append Function. This action adds the command to the Assigned 
Quick-Key String box.

Note: The procedure immediately below is for a 5250 connection; 
it may work for a 3270 connection as well, but it depends on the 
host operating system.
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8 Enter your password by doing one of the following:

• If you have created and saved your password already in the General 
category of the Session folder, click System Commands on the 
Function Group list. In the Function list box, click Password. This 
action inserts an encrypted format of your password into the 
Assigned Quick-Key String box.

• If you have not created and saved your password in the General 
category of the Session folder, type your password in the Assigned 
Quick-Key String box, enclosed with quotation marks.

9 In the Function Group list, click Action Keys.

10 In the Function list box, click Enter. Click Append Function when finished.

At this point, the Action Quick-Key String box should contain one of the 
following strings:

• If you have entered your password in the General category of the 
Session folder:

"user id" Tab Password Enter

• If you manually typed your password in the Append Quick-Key String 
box:

"user id" Tab "password" Enter

11 Click Set to implement the Quick-Key. 

12 Click Save to save the Quick-Key to a session profile.

To automate your login (VT):

1 Connect to a host.

2 On the Options menu, click Quick-Keys. The Quick-Key Editor dialog box 
opens.

3 In the Quick-Key Name box, type a name for the Quick-Key.

4 In the Assigned Quick-Key String box, type your login name (user id), 
enclosed within quotation marks.

5 In the Function Group list, click Action Keys.
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6 In the Function list box, click Return.

7 Click Append Function. This action adds the command to the Assigned 
Quick-Key String box.

8 In the Function Group list, click System Commands.

9 In the Function list box, click Pause. Click Append Function when 
finished.

10 Enter your password by doing one of the following:

• If you have created and saved your password already in the General 
category of the Session folder, click System Commands on the 
Function Group list. In the Function list box, click Password. This 
action inserts an encrypted format of your password into the 
Assigned Quick-Key String box.

• If you have not created and saved your password in the General 
category of the Session folder, type your password in the Assigned 
Quick-Key String box, enclosed with quotation marks.

11 In the Function Group list, click Action Keys.

12 In the Function list box, click Return. Click Append Function when 
finished.

At this point, the Action Quick-Key String box should contain one of the 
following strings:

• If you have entered your password in the General category of the 
Session folder:

"user id" Return Pause Password Return

• If you manually typed your password in the Action Quick-Key String 
box:

"user id" Return Pause "password" Return

13 Click Set to implement the Quick-Key. 

14 Click Save to save the Quick-Key to a session profile.
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Creating an Auto-logon Quick Script

To automate your login (5250 and, in some cases, 3270 and VT):

For more information on 
Quick Scripts, see 
“Working with Quick 
Scripts” on page 146.

1 In the host session window, on the Tools menu, point to Quick Script, 
and click Edit. HostExplorer Quick Script Editor opens.

2 Double-click the default header line “Untitled: Description of Quick 
Script”. The Quick Script Description dialog box opens.

3 Type a name and description for the new Quick Script file, and click OK.

4 On the Commands menu, click Declare Variable. The Declare Variable 
dialog box opens.

5 In the Variable Name box, type a name for the variable; for example, 
UserID.

6 In the Initial Value box, type your login name (user ID).

7 Click OK.

8 To declare a variable for your password, repeat steps 4 to 7.

9 On the Commands menu, click Send Variable to Screen. The Send Variable 
to Screen dialog box opens.

10 In the Variable Name list, select the variable name that you specified for 
your login name and click OK.

11 On the Commands menu, click Send Keystrokes. The Send Keystrokes 
dialog box opens.

12 In the Category list, select Editing Keys.

13 In the Mnemonic list, select Tab, and click Insert. The mnemonic appears 
in the Keystrokes box.

14 Click OK.

15 On the Commands menu, click Send Variable to Screen. The Send Variable 
to Screen dialog box opens.

16 In the Variable Name list, select the variable name that you specified for 
your password and click OK.
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17 On the Commands menu, click Send Keystrokes. The Send Keystrokes 
dialog box opens.

18 In the Category list, select Action Keys.

19 In the Mnemonic list, select Tab, and click Insert. The mnemonic appears 
in the Keystrokes box.

20 Click OK.

21 On the toolbar, click Save.

Disabling Session Options

When configuring HostExplorer, you can customize and simplify the 
session window by disabling options that you are not using. You can disable 
the menu line, individual menu items, individual toolbar commands, the 
entire toolbar, or session options.

To disable the menu line: 

1 On the Windows Star t menu, click Run.

2 Click Browse.

3 In Files of type, select All Files.

4 Browse to the HostEx directory where the user files are stored on your 
machine. For the appropriate directory path for your platform, refer to 
the list of default locations for user files in the section, “Current User 
versus “All Users”” on page 26.

5 Open the hostex.ini file.

6 Add the following command to the section [Disable.Settings]. If the 
section does not exist, add it at the end of the file. For example:

[Disable.Settings]
Display Menu = Off
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A disabled menu item 
remains visible in the user 
interface but is dimmed. 
You can remove it from 
sight entirely by adding a 
Hide parameter to the 
disable string.

To disable an individual menu item:

1 On the Windows Star t menu, click Run.

2 Click Browse.

3 In Files of type, select All Files.

4 Browse to the HostEx directory where the user files are stored on your 
machine. For the appropriate directory path for your platform, refer to 
the list of default locations for user files in the section, “Current User 
versus “All Users”” on page 26.

5 Open the hostex.ini file.

6 Add the following command to the section [Disable.Settings]. If the 
section does not exist, add it at the end of the file. For example, if you 
want to disable the Open Session item in the File menu, add the 
following:

[Disable.Settings]
Start Sessions = Off

7 To completely hide the menu item, append "Hide" to the end of the 
entry. For example:

[Disable.Settings]
Start Sessions = Off, Hide

To disable toolbar commands:

1 On the Windows Star t menu, click Run.

2 Click Browse.

3 In Files of type, select All Files.

4 Browse to the HostEx directory where the user files are stored on your 
machine. For the appropriate directory path for your platform, refer to 
the list of default locations for user files in the section, “Current User 
versus “All Users”” on page 26.

5 Open the hostex.ini file.

6 Add the following line to the section [Disable.Settings]. If the section 
does not exist, add it at the end of the file. For example:

[Disable.Settings]
Display Toolbar = Off
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To disable the toolbar:

1 With the toolbar hidden, create and save a profile. To hide a toolbar, 
right-click it and click Hide. The toolbar must be detached from the 
main window for you to hide it.

2 On the Windows Star t menu, click Run.

3 Click Browse.

4 In Files of type, select All Files.

5 Browse to the HostEx directory where the user files are stored on your 
machine. For the appropriate directory path for your platform, refer to 
the list of default locations for user files in the section, “Current User 
versus “All Users”” on page 26.

6 Open the hostex.ini file.

7 Add the following line to the section [Disable.Settings]. If the section 
does not exist, add it at the end of the file. For example:

[Disable.Settings]
Display Toolbar = Off, Hide
Category Term_Toolbar = Off

To disable a session profile category:

1 On the Windows Star t menu, click Run.

2 Click Browse.

3 In Files of type, select All Files.

4 Browse to the HostEx directory where the user files are stored on your 
machine. For the appropriate directory path for your platform, refer to 
the list of default locations for user files in the section, “Current User 
versus “All Users”” on page 26.

5 Open the hostex.ini file.
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6 Add the following line to the section [Disable.Settings]. If the section 
does not exist, add it at the end of the file. For example:

[Disable.Settings]
Category Session_General = Off

Working with Hotspots

Hotspots designate text strings or regions on the host screen. Text hotspots 
can contain intervening blanks, meaning they can consist of more than one 
word; they can occur anywhere on the screen and can contain a preceding 
and/or trailing blank. Region hotspots are rectangular areas you can define. 
HostExplorer lets you define hotspot schemes: you define a scheme and 
then add however many text or region hotspots you want to that scheme.

Assigning Hotspot Functions
When selected, these hotspots execute predefined functions. You can assign 
hotspots to any action, editing, or character key, and have them execute 
system commands, macros, Quick-Keys, and Quick Scripts. Hotspots are 
global functions and are not profile-specific.

After you have created a hotspot, you can click the hotspot text or region 
and watch as the predefined action is executed. For example, many 
electronic mail packages have the PF key legend at the bottom of the screen. 
The format is usually as follows: PF2:Read, PF3:End, and so on. In the 
Session Profile dialog box, if the Show Hotspots option in the General 
category of the Display folder is selected, you can click the PF2 text on the 
screen to execute the PF2 action automatically.

Note: For more information about which session options you can 
disable, see the Security Settings topics in the Reference section 
of the HostExplorer Help.
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The following text strings are automatically recognized as hotspots with n 
representing any digit:

• Program Function Keys—PFn, PFnn, Fn, Fnn.

• Program Attention Keys—PAn, An.

For example, the PF1, PF2, F1, F12, PA1, PA2, A1 text strings are 
automatically recognized as hotspots.

Overlapping Hotspots
If hotspots overlap, you can define the order in which they are displayed. 
The hotspots nearest the top of the current hotspot scheme take precedence 
over those below. You can manipulate the order at any time.

To create a hotspot scheme:

1 On the Options menu, click Edit Session Profile. The Session Profile 
dialog box opens.

2 Double-click Hotspots and click General.

3 Click New. The Save Scheme As dialog box opens.

4 In the Scheme Name box, type a name for the scheme and click OK.

To create a new hotspot:

1 On the Options menu, click Edit Session Profile. The Session Profile 
dialog box opens.

2 Double-click Hotspots and click General.

3 Choose a scheme and click Add.

Note: Hotspots that do not display because of overlapping 
cannot be executed.
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4 Choose a hotspot type (Text or Region) and do one of the following:

• For a text hotspot, type the text you want to include in the hotspot 
in the Hotspot Text box. This text doubles as the name for the 
hotspot.

• For a region hotspot, type the name you want for the hotspot in the 
Hotspot Name box.

5 Specify options for the hotspot.

6 Click Next.

7 Specify a function group, function, and ToolTip text.

8 Click Finish.

To edit a hotspot:

1 On the Options menu, click Edit Session Profile. The Session Profile 
dialog box opens.

2 Double-click Hotspots and click General.

3 Select a scheme and select the hotspot you want to edit.

4 Click Edit.

5 Configure the settings on both tabs.

6 Click OK to save the settings and exit the dialog box.

To change the order of hotspots:

1 On the Options menu, click Edit Session Profile. The Session Profile 
dialog box opens.

2 Double-click Hotspots and click General.

3 Select a scheme and select the hotspot you want to move.

4 Click the Move Up or Move Down button to place the hotspot in the 
position you want.
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To display a hotspot:

On the View menu, click Hotspots. This setting applies to both text and 
region hotspots.

To delete a hotspot:

1 On the Options menu, click Edit Session Profile. The Session Profile 
dialog box opens.

2 Double-click the Hotspots folder and click the General category.

3 In the Scheme list, select a scheme.

4 Select the hotspot that you want to remove and click Delete.

Working with Quick-Keys

For information about 
automatically running a 
Quick-Key on startup, see 
“Running Quick-Keys, 
Quick Scripts, or Macros at 
Startup” on page 133.

Quick-Keys are multi-functional, global shortcuts that can store text and 
commands. You can use Quick-Keys to execute a sequence of commands 
automatically.

You can create a Quick-Key using a combination of text, keys, and 
commands. Quick-Keys are global and system-wide. They are not profile-
specific and do not affect the host.  

To create a Quick-Key:

1 On the Options menu, click Quick-Keys. The Quick-Key Editor dialog box 
opens.

2 In the Quick-Key Name box, type a name for the Quick-Key.

3 In the Function Group list, select a function group.

Note: For more information on the available Quick-Keys, see the 
Quick-Key System Commands topic in the Reference section of 
the HostExplorer Help.
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4 In the Function list box, select the individual function you want to apply 
to Quick-Key and click Append Function. The function displays in the 
Assigned Quick-Key String field.

5 Repeat step 4 until you have appended all the desired functions. 

6 Click Set to implement the Quick-Key.

7 Click Save to save the Quick-Key to a session profile.

To load a Quick-Key:

1 On the Options menu, click Quick-Keys. The Quick-Key Editor dialog box 
opens.

2 Click Load. The Load Quick-Key dialog box opens.

3 Click the Quick-Key you want to load and click OK. 

To run a Quick-Key:

For information on running 
a Quick-Key at startup, see 
“Running Quick-Keys, 
Quick Scripts, or Macros at 
Startup” on page 133.

1 On the Options menu, click Quick-Keys.

2 On the Quick-Key list, click a Quick-Key.

3 Click Run. 

Note: When creating Quick-Keys, be sure to include a timing 
delay; this delay allows the Auto Start Quick-Key to run when host 
data is received from a new session. To add a delay, do the 
following: on the Function menu, click Pause and click Append 
Function.
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Working with Quick Scripts

Unlike macros, which are statements based on the Hummingbird Basic 
programming language, Quick Scripts are made up of commands that can 
automate tedious tasks such as entering repetitive information into an order 
entry form, or entering your user name and password into a login screen. 
HostExplorer lets you assign these Quick Scripts to keyboard mappings, 
mouse actions, hotspots, toolbar buttons, and the track menu.

HostExplorer provides a Quick Script Editor which is used to create and 
modify Quick Scripts. Quick Script Editor has the following functions and 
capabilities:

• declares variables

• creates labels

• branches to other labels and functions

• views Quick Script details

• creates pop-up messages

For example, you can:

• Modify timeouts and delays to account for slower connections.

• Remove "Send Keystrokes" containing private information (for 
example, passwords) and replace with profiles variables such as 
"prompt dialogs".

Note: For more information on the available Quick Script 
commands, see the Quick Script Commands topic in the Working 
with Quick Scripts section of the HostExplorer Help.

Note: Quick Scripts are emulation-specific. For example, a VT 
Quick Script loads only when the Quick Script Editor is opened 
from a VT session.
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You can also create an Auto-logon Quick Script. To use the Auto-logon 
feature, you must create an Auto-logon Quick Script to use with each 
session, except TN5250E with telnet negotiations. For more information, 
see “Creating an Auto-logon Quick Script” on page 137.

Sample files of Quick Scripts are available in the following directory where 
the program files are stored on your machine:

HostExplorer\SDK\Samples\QuickScripts

Creating and Running Quick Scripts
You can create a Quick Script to automate tedious and repetitive tasks.

For information on using 
Quick Scripts to automate 
your login, see “Creating 
an Auto-logon Quick 
Script” on page 137.

To create a Quick Script:

1 In the host session window, on the Tools menu, point to Quick Script and 
click Edit. HostExplorer Quick Script Editor opens, displaying a new 
Quick Script with the default header line: “Untitled: Description of 
Quick Script”.

2 You can edit the header line by pressing the Enter key, or right-clicking 
the line and clicking Properties. The Quick Script Description dialog box 
opens.

3 Modify the file name and description of the Quick Script, and click OK.

To start a new Quick Script:

1 On the File menu, click New. Alternatively, you can click New on the 
toolbar. The Create a New Quick Script dialog box opens.

2 Complete the dialog box and click OK.

To run a Quick Script:

For information on running 
a Quick Script at startup, 
see “Running Quick-Keys, 
Quick Scripts, or Macros at 
Startup” on page 133.

1 In the host session window, on the Tools menu, point to Quick Script and 
click Run. The Run Quick Script dialog box opens.

2 Select a Quick Script and click OK. Alternatively, click Browse to locate 
the Quick Script file. The selected Quick Script runs.
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Converting Quick Scripts to Macros
For information on 
Hummingbird Basic 
Workbench, refer to the 
Hummingbird Basic 
Workbench Help.

In order for your Quick Script to be functional as a macro, you can convert 
it by saving it as an .ebs file. Rather than create the script in Hummingbird 
Basic, you can use Quick Script Editor to create the file. After you convert 
the file in Quick Script Editor, you can open and modify the macro in 
Hummingbird Basic Workbench (if necessary), and run it in the same way 
as any other HostExplorer macro.

To convert your Quick Script to a macro file:

1 Create a Quick Script file using the Quick Script Editor.

2 On the File menu, click Save As. The Save As dialog box opens.

3 In the Files of Type list, select HostExplorer Macro Files [*.ebs]. 
Alternatively, you can add the .ebs extension to the name of the file in 
the File Name box.

4 In the File Name box, type a name for the macro file.

5 Click Save.

You can also launch 
Hummingbird Basic 
Workbench on the 
Windows Start menu. The 
utility is located in the 
HostExplorer/Accessories 
program group.

6 If you need to modify the macro, on the Tools menu of the host session 
window, point to Macro, and click Edit. Hummingbird Basic Workbench 
opens.

7 On the File menu, click Open.

8 Navigate to the folder where you stored the converted macro file, and 
click Open.

9 Modify the macro as necessary.

10 Run the macro. For information on running macros, see the 
corresponding procedure in the section, “Working with Macros” on 
page 149.

Note: This action saves the Quick Script contents only as a macro 
file, not a Quick Script file.
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Working with Macros

HostExplorer provides macro functionality that lets you automate various 
commands and actions.

Recording and Editing Macros
Using the Macro Recorder, you can record keystrokes, mouse actions, and 
other session events; you can also record a macro at startup to include 
operations that occur prior to a connection. Then, using the Macro Editor, 
you can edit the macro and enhance functionality, such as timeouts and 
delays, to accommodate slower connections.

Using Hummingbird Macro Basic Workbench, a Microsoft VBA-
compatible Basic interpreter and compiler, you can write a macro using the 
Basic Script tool.

Migrating WinWrap to Hummingbird
In HostExplorer 6.0, the Basic Scripting Language changed from WinWrap 
Basic to Hummingbird Basic. Different coding conventions may require you 
to modify your existing scripts. Hummingbird Basic supports the BASIC 
commands with API function calls. You can use these calls to customize 
HostExplorer. The Hummingbird Basic Workbench can create, compile, 
and debug script files. The newly modified sample scripts in filelist.ebs 
and sendrecv.ebs illustrate the changes that have occurred since version 
4.0.1 counterparts. The sample scripts now support TSO and CMS file 
transfers. 

To record a macro:

1 On the Tools menu, point to Macro and click Start Recording.

2 Perform the steps that you want to record.

3 On the Tools menu, point to Macro and click Stop Recording. The Save 
Recorded Macro File dialog box opens.

4 Type a file name for the macro and click Save.
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To run a macro:

For information on running 
a Quick Script at startup, 
see “Running Quick-Keys, 
Quick Scripts, or Macros at 
Startup” on page 133.

1 In the host session window, on the Tools menu, point to Macro and click 
Run. The Browse Macro Files dialog box opens.

2 Select a macro file and click Open.

The selected macro begins to run.

To edit a macro:

1 On the Tools menu, point to Macro and click Edit. Hummingbird Basic 
Workbench opens.

2 On the File menu, click Open.

3 Select the macro that you want to edit. 

4 Make the necessary changes.

5 On the File menu, click Save and close the editor.

Converting Older Macro Scripts

When you migrate older scripts, you can reduce conversion errors.

To migrate scripts:

For more information on 
connecting to a host, see 
“Establishing 
Connections” on page 60.

1 Launch HostExplorer and establish a remote host connection.

2 Locate the script that you want to convert and change the file extension 
of the script file from .wwb to .ebs, the default extension for 
Hummingbird Basic script files.

Note: You can automatically run a macro when you launch 
HostExplorer.

Note: You can also launch Hummingbird Basic Workbench on the 
Windows Start menu. This utility is located in the HostExplorer/
Accessories program group.
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3 Explicitly declare all sub-procedures and function procedures using 
Declare statements. You must include any argument list on the 
declaration. For example:

Declare Sub ReturnToCMS

Declare Sub PressKeys( szKeyVals as String, bWaitForHost as
Integer )

4 Use OLE automation to communicate with a session. Do this by 
declaring a new object that can access the session and use the 
CreateObject function to associate this object with HostExplorer. 

5 Associate the new object with any object previously used to 
communicate with HostExplorer. For example, assume that your old 
script uses the CurrentHost method to access a session: 

Dim Host as Object

Sub Main

Set Host = CurrentHost

6 Modify the old script as follows:

Dim Host as Object

Dim HE as Object

Sub Main

Set HE = CreateObject( "HostExplorer" )

Set Host = HE.CurrentHost

7 Replace all occurrences of the word Boolean with the word Integer. 
Boolean is not a valid data type in Hummingbird Basic and the values 
-1 and 0 are used to represent True and False, respectively.

8 Replace all occurrences of the statement Exit All (which is not 
supported in Hummingbird Basic) with an Exit Sub or Exit Function 
statement (as appropriate) to force a return to the calling routine. Add 
an Exit Sub or Exit Function in each calling routine as necessary until 
control is returned to the Main sub-procedure. From there, you can exit 
the entire script using an Exit Sub statement.
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9 Decrease the size of all dialog boxes. This action is necessary because the 
units of measure used to define the size of a dialog box in 
Hummingbird Basic differs from those used in WinWrap Basic.

Converting Wall Data RUMBA Macros

HostExplorer provides a utility that lets you convert Wall Data RUMBA 
macros (.rmc files) into Hummingbird Basic macro files. The utility keeps 
the original file intact and requests a destination folder for placing the 
converted file.

You can convert individual files or entire directories.

To convert Wall Data RUMBA macros:

1 On the Windows Star t menu, navigate to the HostExplorer program 
group and click Macro & Profile Converter. The HostExplorer Profile/Macro 
Conversion Utility dialog box opens.

2 In the Conversion Type list, click Wall Data RUMBA Macros (*.RMC).

3 In the Files or Directory to Convert box, specify the file or directory you 
want to convert.

4 In the Destination Directory box, specify a destination directory in which 
to place the converted files.

5 If you are converting an entire directory and want the utility to include 
subfolders in that directory, select the Recursive Search option.

6 If you are converting an entire directory and want to be notified before 
each file is actually converted, select the Prompt Before Each Conversion 
option.

7 Click Conver t to begin the conversion.
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Converting Attachmate EXTRA! Macros and Profiles

HostExplorer provides a utility that lets you convert Attachmate EXTRA! 
macros (.ebm files) and profiles (.edp files). The utility converts .ebm files 
into Hummingbird Basic macro files, and it converts .edp files into 
standard HostExplorer session profiles (.hep files). 

The utility keeps the original file intact and requests a destination folder for 
placing the converted file. You can convert individual files or entire 
directories.

To convert Attachmate EXTRA! Macros or Profiles:

1 On the Windows Star t menu, navigate to the HostExplorer program 
group and click Macro & Profile Converter. The HostExplorer Profile/Macro 
Conversion Utility dialog box opens.

2 In the Conversion Type list, do one of the following:

• To convert a macro, choose the Attachmate EXTRA! Macros (*.EBM) 
option.

• To convert a profile, choose the Attachmate EXTRA! v6.x Profiles 
(*.EDP) option.

3 In the Files or Directory to Convert box, specify the file or directory you 
want to convert.

4 In the Destination Directory box, specify a destination directory in which 
to place the converted files.

5 If you are converting an entire directory and want the utility to include 
subfolders in that directory, select the Recursive Search option.

6 If you are converting an entire directory and want to be notified before 
each file is actually converted, select the Prompt Before Each Conversion 
option.

7 Click Conver t to begin the conversion.
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Chapter 11: Special Connections
This chapter describes how you can establish communication with a 3270 
mainframe using one of the following products:

• Microsoft SNA Server

• Novell NetWare for SAA

Microsoft SNA Server

You can establish communication with mainframes via Microsoft SNA 
Server using LU application (LUA), display, or printer logical units (LUs). 
Using configurable LUs in Microsoft SNA Server, you can run primary LU0, 
LU1, LU2, and LU3 sessions that emulate 3270 data stream.

Before you can access the host, you or your system administrator must 
configure Microsoft SNA Server connections on the link service, configure 
LUs, and assign them to users, groups, workstations, and printers. You must 
also install Microsoft SNA Server Client software on your workstation.

You can connect with an IBM mainframe via Microsoft SNA Server. This 
connection offers full support of Display and Printer Types, on single or 
multiple hosts and IND$FILE transfers.

You can find out more about configuring a Microsoft SNA Server at the 
following web site: 

www.microsoft.com/SNA/default.asp

Microsoft SNA Server System Requirements
To run Microsoft SNA Server, you require the following:

• Microsoft SNA Client software running on each client workstation. One 
client can run on either Windows 95 or Windows NT 4.0 or higher, 
while the other client must be configured to run under Windows NT.

• TCP/IP or MS Networking transport protocol installed on the SNA 
Server and on each client workstation.
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Configuring the Microsoft SNA Server Connection
After you have installed the necessary software, you can configure a 
connection using the Microsoft SNA Server.

To configure a Microsoft SNA Server connection:

1 In the Open Session dialog box, right-click a profile and click Properties. 
The Session Profile dialog box opens.

2 Double-click Session and click Host.

3 In the Connect By list, click SNA Server.

4 In the LU or Pool Name box, type the logical unit (LU) or Pool Name.

5 Click OK.

Novell NetWare for SAA

You can establish communication with mainframes via Novell's NetWare 
for SAA Server using 3270/LUx logical units (LUs). Using configurable 
3270/LUx LUs in NetWare for SAA server lets you run primary LU0, LU1, 
LU2, and LU3 sessions that emulate 3270 data stream.

Before you can access the host, you need to configure 3270/LUx LUs on the 
server using Novell Directory Services (NDS) configuration tools and assign 
them to users, groups, workstations, and printers. NDS configuration works 
only with NetWare for SAA server versions 2.2 or later, with the client 
running over a NetWare IPX/SPX stack. You must also install NetWare for 
SAA Client software on your workstation.

You can find out more about configuring Novell NetWare for SAA at the 
following web site: 

http://www-4.ibm.com/software/network/commserver/library/
publications/nwsaa.html
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Novell NetWare for SAA System Requirements
To run Novell NetWare for SAA, you require the following:

• Client Service for NetWare and transport compatible with IPX/SPX 
(Internetwork Packet Exchange/Sequenced Packet Exchange).

• A LAN adapter that supports IPX (Internetwork Packet Exchange).

• Novell NetWare Client for Windows NT or Windows 95.

Configuring the Novell NetWare for SAA Server 
Connection
After you have installed the necessary software, you can configure a 
connection using the Novell NetWare for SAA Server.

To configure a Novell NetWare for SAA Server connection:

1 In the Open Session dialog box, right-click a profile and click Properties. 
The Session Profile dialog box opens.

2 Double-click the Session folder and click Host.

3 In the Connect By list, click NetWare for SAA.

4 In the Session Name (NDS) box, type the Session Name and click OK.
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Customizing Installations with Sconfig

Many users in an enterprise maintain different development needs and 
require customized software to meet those needs. For example, some users  
may require specific features of the Hummingbird product such as Telnet 
and FTP setting files to connect to frequently used hosts, while other users 
would not. Instead, these users may require specific font settings and 
features installed with their Hummingbird product.

For more information on 
Windows Installer, see the 
installation chapter.

Sconfig is an advanced system administration tool that helps users make the 
best use of their Hummingbird software in specific networked 
environments. With Sconfig, you can customize the Setup Wizard to create 
tailored installation packages of Hummingbird software for different users. 
You can:

• Customize the directories in which the product is installed.

• Tailor the list of applications or components to be installed. You can 
alter the list to limit the functionality available to users, or to optimize 
the use of disk space.

• Simplify user input during the installation by preselecting information, 
such as the properties of the software being installed.

You can use Sconfig to package customized installations that cater to each 
user by creating a Microsoft transform file (.mst). After creating a transform 
file, you can then include those applications (and subsequent components) 
that are useful for each user.

About Windows Installer Database Files
Microsoft Windows Installer uses Microsoft Software Installation package 
files (.msi) to install the Hummingbird product. A package file is a database 
file which contains information on product components and installation 
directories.

Note: When installing the Hummingbird software on the 
administrator machine, you must choose Custom or Complete 
installation. The Sconfig utility does not install on a Typical 
installation.
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Sconfig uses the package files as a foundation for building customized 
installations. Using Sconfig, you can open any Hummingbird product 
package file, modify the settings, and save the customized settings in a  
Microsoft transform file.

Microsoft Transform Files
A Microsoft transform file makes changes to the elements of a package file. 
When a transform file is applied to a package file, it changes the behaviour 
of an installation.

Whenever Windows Installer needs to perform a customization or  a 
configuration change, it applies the transform file to the package file to 
create and change the installation database. Like the package file, the 
transform file is a relational database with information about product 
components and installation directories, but the transform file contains 
only those changes that you want to apply to the installation package. 

Instead of changing the package file, Sconfig stores all the customized 
settings in a transform file. You can then use Sconfig to open the transform 
file and make future customizations by applying your customized settings 
to an updated package file.

Working with Transform Files in Sconfig
Using a transform file, Sconfig lets you make modifications to an existing, 
preconfigured package file. When you run the Setup Configuration Wizard, 
you must first identify the package file that you want to customize. Then 
you can specify the transform file that you want to use. 

Once you have specified the transform file you want to configure, Sconfig 
opens the Setup Configuration Wizard Customization dialog box. Here you 
can begin making alterations to the installation database.

When preparing for multiple custom installations, you need to create a 
separate transform file for each user. You can then apply each transform file 
to the Hummingbird product’s package file, thus temporarily updating the 
package file and storing the changes in your customized transform file.
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When opening Sconfig you must specify the transform and package files. 
You can work with a new package file or with a preconfigured one.

To open Sconfig:

1 On the Star t menu, navigate to the Hummingbird System Administration 
folder.

2 Click Sconfig to open the wizard. A short welcome screen appears.

3 Click Next to continue.

4 Specify the package file that you want to customize and click Next.  You 
can choose a package file in one of the following ways:

• Specify a package file (.msi) that you previously configured.

• Browse for a new package file (.msi). 

5 Specify the transform file that you want to create. You can specify a 
transform file in one of the following ways:

• Specify a transform file (.mst) that you previously configured.

• Browse for a new transform file (.mst) by clicking the Browse 
button.

• Create a new one yourself. You can do this by clicking the Browse 
button.

6 Click Next to continue.

About Creating Transform Files in Sconfig
Once you have specified the package and transform files that you want to 
configure, you can open the installation database and make alterations to 
create a custom install. Sconfig opens the Setup Configuration Wizard 
Customization dialog box. In this dialog box you can make alterations to the 
transform file and create a custom install. 

Note: Sconfig is not installed in a Typical installation. It installs only 
if you choose Custom or Complete.
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Sconfig lets you customize the following:

Product Directories     The Directories option lets you customize product 
directories for the installation of the Hummingbird product. See 
“Customizing Product Directories” on page 167 for more information.

Product Features     The Features option lets you select Hummingbird 
product features for a custom install. See “Selecting Features to Install” on 
page 168. 

Files       The Files option lets you select external custom program files for 
the Hummingbird product. See “Selecting Files to Install” on page 169 for 
more information.

Product Properties       The Properties option lets you set custom properties 
to change the behavior of a custom installation package and set properties 
for Hummingbird product features.  See “Setting Product Properties” on 
page 172 for more information.

Registry      The Registry option lets you preset the Registry editor for any 
Windows operating system registry. The advantage of editing the registry 
before the installation saves time, especially when installing for multiple 
target machines. See “Setting the Registry” on page 176 for more 
information.

Custom Shortcuts      The Shortcut option lets you create custom shortcuts 
on user machines for any Hummingbird product feature added to your 
installation database. See “Setting Shortcuts” on page 179 for more 
information.

Exceed Properties      Available in Exceed, Exceed XDK, and Exceed 
PowerSuite installations, the Exceed Settings option lets you modify or 
remove properties. 

NFS Properties      Available only in NFS Maestro product and Exceed 
PowerSuite installations, the NFS Settings option lets you modify or remove 
properties for NFS Maestro.

Custom Font Directories and Servers      Available in Exceed, Exceed XDK, 
and Exceed PowerSuite installations, the Custom Font Settings option lets 
you install customized font directories and servers to the Exceed Xconfig 
utility.
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Custom Font Paths      Available in Exceed, Exceed XDK, and Exceed 
PowerSuite installations, the Font Paths Settings option lets change the order 
in which font directories/servers are loaded by X Server.

When the dialog box opens, it defaults to the Directories dialog box. You can 
browse to the other options by clicking their names on the left panel of the 
Setup Configuration Wizard.

Customizing Product Directories
The Directories dialog box lets you to specify where your Hummingbird 
product will be installed. You can set the following directories:

• Destination 

• Current User

• All Users

To customize directories:

1 In the Destination Folder box, type the directory where all non-volatile 
files will be stored.

2 In the Current User box, type the directory where all volatile files will be 
stored for the current user.
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3 In the All Users box, type the directory where all volatile files will be 
stored for all users.

Selecting Features to Install
To view the Features dialog box, click Features in the left panel of the Setup 
Customization Wizard. The Features dialog box lets you choose which 
Hummingbird product features to install. Selecting features is similar to 
customizing your product installation using Windows Installer. Choose 
features that cater to each user in your enterprise. Sconfig also lets you 
specify sub-features for each feature you specify.

Hummingbird product features can be added to, modified within, and 
removed from an installation database for different users in an enterprise. 
For quick access to these features on user machines, you can create shortcut 
icons for Hummingbird product features for users and groups. For more 
information see “Setting Shortcuts” on page 179.
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Adding a Feature to an Installation Database
Recognizing features commonly used by specific users is necessary during a 
custom installation. Some use the Hummingbird product at an 
administrative level (system administrators). These users will find features 
that monitor trace operations and troubleshoot logs to be a very important 
component of their install, while users that use the product at strictly a user 
level may not.

To add a feature, in the Features dialog box, select the check box of the 
Hummingbird product feature(s) you want to add to the install.

Modifying a Feature in an Installation Database
The Features box provides you with the flexibility to modify features by 
changing the combination of sub-features that get installed for any 
particular Hummingbird feature. Modifications become necessary when 
application requirements for a particular user change. These changes must 
then be reapplied to the package file to reflect the update. 

To modify a feature:

1 In the Features dialog box, expand the tree of the Hummingbird 
product feature(s) you want to modify.

2 Select or clear the check box of the sub-feature(s) you want to add or 
remove for that Hummingbird feature.

3 If you want to modify another feature, repeat steps 1-2.

Removing a Feature from the Installation Database
When users no longer require a feature, you can remove the product feature 
from the installation database. Removing a feature in Sconfig deletes it from 
the transform file. These changes must then be reapplied to the package file 
to reflect the update. 

To remove a feature, in the Features dialog box, clear the check box of the 
Hummingbird product feature(s) you want to remove. 

Selecting Files to Install
To view the Files dialog box, click Files in the left panel of the Setup 
Customization Wizard. 
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Sconfig lets you add, modify or remove external program files that do not 
come with your Hummingbird product. You can specify the destination 
path of a file on a user’s computer and specify a feature to install with this 
file. The Files dialog box provides you with the opportunity to accessorize 
the installation database and optimize task efficiency amongst users while 
using the Hummingbird product. 

Files can be added to, modified within, and removed from an installation 
database for different users in an enterprise.

Adding a Custom File to an Installation Database
The Files box lets you add to the installation database, external program files 
that are frequently used by users. You can add mini program files such as 
email, drawing and graphics files, or other executable files that are used by 
users to carry out routine tasks. 
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To add a file:

1 In the Files dialog box, click Add. A standard Windows Open dialog box 
opens.

2 Select a file in the dialog box and click OK. The Add/Modify File dialog 
box opens.

3 From the drop-down list, select a destination path folder. This folder 
can be a Windows Systems folder or a Hummingbird folder, depending 
upon where you want to store the file.

4 From the Install With Feature drop-down list, select a feature or select 
Always to include this file with every install and click OK. The Files box 
appears listing the added file.

5 If you want to add another file, repeat steps 1-4.

Modifying a Custom File in an Installation Database
You can modify a file in the installation database. This option provides you 
with the flexibility to change the associated feature that gets installed with 
the file and specify a new destination path for the file. These changes must 
then be reapplied to the package file to reflect the update. 
171



HostExplorer™ User’s Guide
To modify a file:

1 In the Files dialog box, select a file and click Modify. The Add/Modify File 
dialog box opens. 

2 If you want to change the destination folder in which your file gets 
stored, from the drop-down list, select a new destination path folder.

3 If you want to change the feature that the file gets installed with, from 
the Install with drop-down list, select a new feature and click OK. The 
Files dialog box appears listing the files in your installation database.

If you want to modify another file, repeat steps 1-3.

Removing a Custom File from an Installation Database
You can remove a file from the installation database when users no longer 
require that file with the installation of the Hummingbird product. 
Removing a file in Sconfig deletes it from the transform file. These changes 
must then be reapplied to the package file to reflect the update. 

To remove a file, in the Files dialog box, select a file from the list and click 
Remove.

Setting Product Properties
To view the Properties dialog box, click Properties in the left panel of the 
Setup Customization Wizard. Sconfig lets you customize which 
Hummingbird product properties install. The Proper ties dialog box lists 
required properties that are needed for product functionality and optional 
properties.You can set properties that customize Hummingbird product 
features, that control user input, and that define the installation behavior of 
the product. 
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You can also set properties for Exceed and NFS Maestro Client. However, 
these properties become available only when installing the appropriate 
package files for each of these products. Hummingbird product properties 
can be added to, modified within, and removed from an installation 
database for different users in an enterprise.

Adding a Custom Property to an Installation Database
You can add optional properties that customize Hummingbird product 
features, such as the COMPANYNAME property which includes the name of 
your organization in the product installation. You can also include 
properties that control user input during installation, such as the 
TransformSecure property which protects your transform files from user 
modification. Other optional properties define the installation behavior of 
the product, such as the ALLOWBROWSE property, which lets the product 
browse to the home directory during an install.

Set properties that make the best use of the Hummingbird software features 
and that facilitate a user’s installation session.
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To add a property:

1 In the Properties dialog box click Add. The Add Property dialog box 
opens.

2 From the drop-down list, select a property. The bottom panel of the 
dialog box provides the validation information for the property.

3 In the box, type a value for the new property and click OK. The 
Proper ties box appears listing any new properties you’ve added to the 
installation database.

4 If you want to add more properties, repeat steps 1-3.

Modifying a Custom Property in an Installation Database
After you add custom properties to the installation database, Sconfig lets 
you modify these property settings as needed. Modifications to property 
values become necessary when requirements for features and files added to 
the installation database change among users, or when existing properties 
need to be updated to reflect the current install package.
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To modify a property:

1 In the Properties dialog box, select a property.

2 Click Modify. The Modify Property dialog box opens. The bottom panel 
of the dialog box provides the validation information for the property.

3 In the box, type a new value for the property and click OK. The Property 
box appears listing your properties in the installation database.

4 If you want to modify other properties, repeat steps 1-3. 

Removing a Custom Property from an Installation Database
You can clean the installation database of properties that are no longer in 
use. Properties can become obsolete when changes amongst users occur. 
Some scenarios that may require the removal of a property include changes 
made to:

• feature requirements

• user privileges during an installation session  

• user permissions for the software

To remove a property, in the Properties dialog box, select a property from 
the list and click Remove. 
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Setting the Registry
Click the Registry option in the left panel of the Setup Customization 
Wizard to view the Registry dialog box. You can use Sconfig to customize the 
general software settings of your Hummingbird product. After your 
Hummingbird product package file installs the custom components and 
files on the target machine, it can write the custom registry keys and values 
set in Sconfig to the system registry. You establish the keys and values your 
package file writes to the system registry by setting them up in your 
transform file in Sconfig.

Hummingbird or system registry keys can be added to, modified within, 
and removed from an installation database for different users in an 
enterprise.

Adding a Custom Registry Key to an Installation Database
Sconfig lets you make necessary registry key additions to the system registry. 
Making additions to the installation database reduces administration time 
as additions are made once for all target machines that will use that 
customized install file. 
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To add a registry key:

1 In the Registry dialog box, click Add. The Add/Modify Registry Entry 
dialog box opens.

2 In the Root drop-down list, select a hive name.

3 In the Data Type drop-down list, select a data value type.

4 In the Key box, type the registry key name.

5 In the Value name box, type the registry value name. 

6 In the Value data box, type the registry data value and click OK. The 
Registry dialog box appears listing your new keys.

7 If you want to add more registry keys, repeat steps 1-6.

Modifying a Custom Registry Key in an Installation Database
Make necessary registry modifications to the system registry from Sconfig. 
Making modifications from the installation database reduces 
administration time, as modifications are made once for all target machines 
that will use that customized install file. 
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To modify a registry key:

1 In the Registry dialog box, click Modify. The Add/Modify Registry Entry 
dialog box opens.

2 If you want to change the existing hive name of the registry key, from 
the Root drop-down list, select the new hive name.

3 If you want to change the existing value type of the registry key, from 
the Data Type drop-down list, select the new data value type. 

4 If you want to change the existing name of the registry key, in the Key 
box, type the new name for the registry key.

5 If you want to change the existing registry value name, in the Value 
name box, type the new registry value name.

6 If you want to change the existing registry data for the key, in the Value 
data box, type the new registry data and click OK. The Registry box 
appears listing your registry keys in the installation database. 

7 If you want to modify other registry keys, repeat steps 1-6.

Removing a Custom Registry Key from an Installation 
Database
To remove a registry key, in the Registry dialog box, select a registry key 
from the list and click Remove.
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Setting Shortcuts
Click the Shortcuts option in the left panel of the Setup Customization 
Wizard to view the Shortcuts dialog box. This option enables quick access to 
commonly used Hummingbird components. While customizing your 
transform file in Sconfig, create custom shortcuts for Hummingbird 
product features for quick access on user machines. 

To set a custom shortcut:

1 In the Shortcut tree of the Shortcut dialog box, select and right-click the 
folder to which you want to add a new shortcut. In the menu, click Add 
Shortcut Here.

2 In the Shor tcut dialog box, into the Name text box, type the name of the 
shortcut that you want add. To rename a shortcut, select the name of 
the shortcut in the Name box and enter the new name. The name must 
appear in the format:

short name|long name

where the short name must be less than 8 characters long and followed 
by the character |, and the long name is the name of the shortcut as it 
appears on the Windows desktop. For example,

ExceedF|Exceed Finger
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3 If you want to include a description for the shortcut, into the Description 
text box, type a description for the shortcut. This appears when you 
move your mouse pointer over the shortcut icon.

4 From the Install with drop-down list, select a component for which you 
want to provide a shortcut. The installer uses the installation state of 
this component to determine whether to create or delete the shortcut.

5 From the Target drop-down list, select a destination folder of the 
component for which you want to provide a shortcut. 

6 The Default Path text box displays the destination path of the 
component for which you want to create a shortcut.

7 If you want to provide any arguments for this shortcut, type them into 
the Arguments text box.

8 In the Icon area, click Select to launch the Change Icon dialog box. In this 
box, select an icon to associate with the shortcut and click OK.

9 If you want to create another shortcut, repeat steps 1-7.

Saving the .mst File 
Once you have made your modifications to the Hummingbird product 
properties, go through the following steps to save your transform file:

1 In the Setup Configuration Wizard, click Next. The Sconfig Configuration 
Wizard Commit dialog box opens confirming that you are about to save 
your configurations to a transform file.

2 Click Next to create the transform file (.mst). This process is automatic 
and does not display on screen. The Sconfig Wizard Configuration 
Complete dialog box opens, stating that you have created your transform 
file.

Note: For advertised shortcuts, the file launched by the shortcut is 
the file associated with this feature. When you activate this 
shortcut, Windows Installer verifies that all components in the 
feature are installed before launching the file. For non-advertised 
shortcuts, the field should contain a property identifier enclosed 
by square brackets.
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3 Click Finish to exit Sconfig.

Sconfig saves your transform file in the same folder as the package file. This 
makes it easier for users to find when they want to access the file from the 
administrative installation point.

Applying the .mst File to an Install 
After you have created an transform file, you can use it to customize 
Hummingbird product installation. To do this, you must tell the setup.exe 
where to find your transform file.

To change the setup.exe:

For more information on  
installing with an .mst file, 
see the Sconfig Help.

1 In Windows Explorer, browse to the folder that contains the setup.ini
file of your Hummingbird product.

2 Open the setup.ini file.

3 On the line beginning with CmdLine, add the following text:

TRANSFORMS=”full path to the .mst file”

For example, the CmdLine for Hummingbird YourProduct would look like  
this:

CmdLine=TRANSFORMS=”c:\Hummingbird YourProduct.mst”

Where YourProduct is the Hummingbird Connectivity product you are 
customizing.

4 On the File menu, click Save then click Close.

The new CmdLine in the setup.ini file tells the setup program to 
incorporate the new transform file in the program install. When you run 
setup.exe, it uses both the original package file, and the transform file that 
you created using Sconfig. 
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Creating Multiple Custom Installations
Multiple custom installations are important for disparate users with 
different development needs.  Users demand software that makes efficient 
use of both their time and disk space. Rather than having users sift through 
a large Hummingbird product installation, use the Sconfig utility to package 
custom installations for each user.

To create another .mst file:

1 Open Sconfig and browse to a new transform file (.mst).

2 Create and save the transform file (.mst) to the administration 
installation point.

3 If you want to create more transform files for custom installations, 
repeat steps 1-2.

4 To use your new transform file (.mst), launch the Setup Wizard by using 
the following command: 

setup /v”TRANSFORMS=c:\YourTransform.mst"

This way multiple transform files can exist in one source location, without 
repeated modifications to the setup.ini file. 

Configuring Remote Hosts

Jconfig is a remote configuration tool that system administrators can use to 
configure the Hummingbird applications on any network host running a 
Jconfig Daemon. Jconfig offers a variety of configuration options. You can 
create application-specific profiles for users, install shortcuts on user 
desktops, monitor and log user activities, and send messages to user 
machines. As well, you can use Jconfig to configure remote PCs one at a 
time or to create script files that, when played, customize the configuration 
of multiple remote PCs. Jconfig can be used with many different 
Hummingbird products and applications: Exceed, HostExplorer, NFS 
Maestro, and HostExplorer Print Services.
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How Remote Configuration Works
The Jconfig three-tier system allows you to connect to a remote PC and 
configure the services available on that machine. All remote connections are 
made from the Jconfig Client to the Jconfig administration host, then 
through the administration host to other hosts running a Jconfig Daemon.

Jconfig Client     The Jconfig Client can be any Windows 2000/NT/98/95 
machine from which you perform remote configuration tasks.

Jconfig administration host     The Jconfig administration host is the 
machine through which you connect to other hosts. This machine also 
stores your Jconfig client configuration settings and the Jconfig host 
database. Your Jconfig administration host can be the same machine as your 
Jconfig Client, but you will still need to make the initial connection to the 
administration Daemon. 

Jconfig hosts     A Jconfig host is the remote PC running a Jconfig Daemon. 
You connect to this host through the administration host in order to 
configure the Hummingbird application on the remote PC.

Note: You designate the administration host. You do not need to 
install a separate daemon for this host.

Jconfig
administration host

Jconfig Client

hosts running 
Jconfig 
Daemon
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Configurable Remote Services
When you connect to a remote host, you will see a list of configurable 
services for that host. The following list describes the services you can 
configure.

Message Service     Send messages to remote hosts.

File Service      Complete many of the Windows Explorer or File Manager 
tasks on a remote host. If connections are open to multiple remote hosts, 
you can perform file operations between hosts.

Environment Settings Service     View and optionally append the list of 
environment settings to the Jconfig administration log file.

For more details on the 
configurable services, see 
the Jconfig Help.

Editor Service     Edit single text files on a remote host interactively.

System Information Service     View and optionally log system information 
or remote Java information to the administration log file.

Exceed Configuration Service     Change Exceed operating parameters as 
you would using the Xconfig application in Exceed. You can access the 
parameters stored in the default exceed.cfg configuration file, or in 
another configuration file. This service is available only when Exceed is 
installed.

Font Database Service     Change the settings of the remote font database. 
You can add, modify, and delete font directories in the database, and extract 
fonts from it. This service is available only in Exceed.

Registry Service     Add, modify, and delete items in the Windows Registry. 

INI File Service     View and modify entries in an .ini file, such as win.ini. 
You can add, modify, and delete sections or entries in the selected .ini file.

NFS Maestro Client Configuration Service     Set configuration 
parameters that are common to all of the NFS Maestro client programs. 
This service is available only when NFS Maestro is installed.

Note: The availability of each service depends on whether or not 
the corresponding application is installed on the host to which you 
are connected.
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Install Service     Install icons or shortcuts on the remote host desktop or 
menu.

Java Property File Service     View and modify the parameters stored in a 
Java property file. You must select the desired Java property file.

Host Database Service     Store host names along with their associated 
passwords. This database is also used to assign hosts to groups for 
configuration purposes. Use this database with the Jconfig scripting 
function, to apply scripts to selected groups of hosts.

Jconfig Daemon Settings Service     Change operating parameters for the 
Jconfig Daemon to which you are connected. You can change the port on 
which Jconfig monitors service requests, some logging parameters, and the 
Jconfig Daemon password.

HostExplorer Settings Service     Change the HostExplorer profile 
parameters as you would using the Options/Edit Session Profile menu item 
in HostExplorer. This service is available only when HostExplorer is 
installed.

HostExplorer Print Services     Configure profiles for printing from a host 
computer to a specific LAN printer. This service is available only when 
HostExplorer Print Services is installed.

Xstart Service     Force the host or application cache to refresh. This feature 
is available only in Exceed.

Gateway Service     Configure NFS Gateway parameters as you would using 
the NFS Maestro Gateway Access application. This service is available only 
when NFS Maestro is installed. 

Installing Jconfig
In order to use Jconfig, you must load it on the hosts in your network. The 
following section lists what parts of the Jconfig software to install on each 
tier and guides you through the installation process.

• Jconfig client—Install Jconfig client software.

• Jconfig administration host—Install a Jconfig Daemon.

• Jconfig hosts—Install a Jconfig Daemon.
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To install Jconfig on a client:

1 Run Setup for your Hummingbird product. 

2 When prompted for the type of installation, select Custom Installation 
and click Next.

3 When prompted to select the components, select Jconfig along with any 
other features you want to install. Continue with the rest of the 
installation.

To install Jconfig on an administration host and other remote hosts:

1 Run Setup for your Hummingbird product. 

2 When prompted for the type of installation, select Custom Installation 
and click Next.

3 When prompted to select the components, select Jconfig Daemon along 
with any other features you want to install. Continue with the rest of the 
installation.

Running Jconfig in a Java-Enabled Browser
You can run Jconfig in two ways, from a Windows environment or from a 
Java-enabled web browser. If you want to run Jconfig in a browser, you need 
to make some additional configurations. 

To run Jconfig from your browser:

Home—The directory in 
which the software is 
installed.

1 Set up a web server on your administration host to serve the 
JconfigApplet.html file. This file is found in the Hummingbird home 
directory. The web server should set the home directory to be either the 
root or virtual root so that all relative links and files will be valid. 

2 Run a Jconfig Daemon on your web server. 

3 Using a web browser, connect to the web server by typing the URL of 
the JconfigApplet.html file. The Jconfig applet currently uses Java 
Plug-In technology. This allows the applet to run using Sun 
Microsystems’ Java 2 Runtime Environment, Standard Edition (JRE) 
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instead of the web browser’s default virtual machine. The plug-in 
supports both Netscape Navigator TN (3.0 and later on Windows 95, 
98, NT 4.0, and 2000) and Microsoft Internet Explorer (4.0 and later on 
Windows 95, 98, NT 4.0, and 2000).

Opening a Configuration Session
To configure a host, you first need to open a connection. Opening a 
connection to a host consists of two steps: connecting to the administration 
host and connecting from the administration host to the PC running the 
Jconfig Daemon. The following two procedures guide you through those 
connections.

To connect to the administration host:

1 Run the Jconfig Client application. The Administrator Connection dialog 
box opens.

2 In the Administrator Workstation box, type the name or IP address for the 
administration host.

Note: If you want to run in a language other than English, modify 
the language parameter in the JconfigApplet.html file to the 
language variable you want. You can choose from the following 
variables:

• en—English

• es—Spanish

• de—German

• pt—Portuguese

• it—Italian

• fr—French
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3 In the Password box, type the password for the administration host and 
click OK.

To connect to a remote host:

1 On the Jconfig toolbar, Click Connect.

2 Select the type of connection you want to make and click Next. The 
following list describes the types of connections you can make.

• Interactive—An Interactive connection lets you connect to a single 
remote host running a Jconfig Daemon and interactively perform 
configuration activities.

• Script Driven—A Script Driven connection lets you use a script file 
to configure multiple remote PCs simultaneously. Before using this 
type of connection, you must have recorded (and compiled) a 
script as well as configured your host database. 

• Administrator Daemon—When you make an Administrator 
Daemon connection, the Administrator Daemon connects to itself 
to conduct an interactive configuration session. You can also use an 
administration connection to record a script for a script-driven 
multiple configuration, and to configure the administration host 
itself.

3 In the Workstation box, type the machine name (or IP address) of the 
host to which you are connecting. You can also browse to a machine in 
the host database.

4 In the Password box, type the password for the host to which you are 
connecting and click Finish.

Note: The passwords for initial connections to both the 
administration host and the other remote hosts are the IP 
addresses for the respective machines. We recommend changing 
connection passwords. For more information on how to change 
passwords for hosts, see “Changing the Default Password” on 
page 189.
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Configuring the Jconfig Application Settings
After you have made a successful connection, you may want to customize 
the Jconfig applet settings. Use the Options tool and the Daemon Settings 
service to configure the Jconfig settings for remote hosts. You can do the 
following:

• replace default passwords 

• customize how information from the administration host and other 
remote hosts is logged 

• modify the list of available services 

• create a database of hosts to which you frequently connect

• specify the web browser in which you want to display Help

Changing the Default Password
When Jconfig runs for the first time, it uses the IP address of the host to 
which you are connecting as the password for configuration activities. We 
strongly recommend that you change the default passwords. Use the Jconfig 
Daemon Settings service to do this.

To change the default password:

1 Connect to the remote host using Interactive Connection. 

2 On the Jconfig Available Services pane, double-click the Jconfig folder. 

3  Double-click Daemon Settings. The Daemon Settings Service appears. 

4 On the General tab, select the Change Password check box. 

5 In the New Password box, type the new password.

6 In the Confirmation box, retype the new password. 

7 Click Apply Changes on the Daemon Settings Service toolbar to make 
the new password effective.

Configuring Jconfig Daemon Settings
You can also use the Daemon Settings service to configure other server 
options for the administration host and any other remote host running a 
Jconfig Daemon.
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To access the Daemon Settings Service, double-click the Jconfig folder in the 
Available Services window. Then select the Daemon Settings service. Use the 
following tabs to configure the Jconfig Daemon options: 

The connection port is the 
port that the Jconfig 
Daemon monitors for 
requests.

General     Configure the connection port, change passwords, and display or 
hide the Jconfig Daemon window. 

Logging     Set where you want to log information from the Jconfig Daemon 
to which you are connected. You can define the name of the log file and set 
the log file to clear at startup.

Services     Edit, add, or delete services from the Available Services list. 

Configuring the Host Database
A host database file stores information for hosts to which you frequently 
connect. To specify the file you want to use as the host database, click 
Options on the Jconfig toolbar and specify the file name in the Workstation 
Database File Name box. You can then add host connections to the file using 
the Workstation Database service. If your network includes a large number of 
hosts, you can populate the host database using a script. 

To add entries to the Host Database file:

1 Connect to the Remote host using an Interactive Connection. 

2 On the Jconfig Available Services pane, double-click the Jconfig folder. 

3  Double-click Workstation Database. The Workstation Database Service 
opens. 

4 On the Workstation Database toolbar, click Add Entry. The Add Entry 
dialog box opens.

5 Type the name of the host group in the Group box. 

6 Type the name of the new host in the Workstation box.

Note: You can also use The Password Wizard to change 
passwords for multiple hosts, a selected group of hosts, or all 
hosts in the Host Database service. Changes to passwords made 
in the Password Wizard take effect immediately. To get to the 
Password Wizard, click Password Wizard on the toolbar.
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7 If you want to change the port number, click Port and type a new port 
number in the box.

8 Type the password for the new host in the Password and Confirmation 
boxes. Click OK.

9 On the Workstation Database toolbar, click Save Host Database to save 
the new entry and any other changes.

To use a script to populate the host database:

Write a Java program to use the class:

com.hcl.apps.rcfg.Services.WorkstationDb.Server.workstationDBCreator

This class has the following public methods:

// --- Creates a workstation database with the file name
JCONFIG.HDB

workstationDBCreator()

// --- Creates a workstation database with given file name

workstationDBCreator(String fileName)

// --- Adds a new entry to the database without a password

public boolean addNewEntry (String group, String workstation,
String port)

// --- Adds a new entry to the database with a password

public boolean addNewEntry (String group, String workstation,
String port, String password)

// --- Saves the workstation database to disk

public void save() throws IOException

// --- Closes the workstation database file

public void close() throws IOException
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Logging Administrative Information
To allow you to troubleshoot connections, Jconfig logs status information 
generated by the administration host to a file called jconfig.log. As well, 
many of the services available through Jconfig provide the option of logging 
information to this file. To view the log file, click Log on the Jconfig toolbar. 
You can also log information to a file other than the default file, 
jconfig.log. If you want to configure the administrative log settings, click 
Options on the Jconfig toolbar. 

Opening Jconfig Help
The Jconfig HTML Help system allows you to view context-sensitive 
information about using Jconfig. If you are running Jconfig as an 
application instead of in a web browser, you need to specify the browser in 
which you want to open Jconfig Help. To specify a browser, click Options on 
the Jconfig toolbar, and type the full path of the web browser in the Web 
Browser section of the Options pane.

Configuring the Remote Services for a Host
Once you have connected to a remote host, you can configure the services 
available to that host. The main Jconfig display area for each remote host 
tab is divided into two panes. The left pane shows the list of configurable 
services for the host, and the right pane shows the configurable options for 
the service selected. To configure a service, double-click the service. The 
configuration options appear. For information on the configurable options 
for each service, see the Jconfig Help and the Help for the corresponding 
application.

Using Scripts to Configure Multiple Hosts
You can use the Jconfig scripting option to record a sequence of 
configuration activities in a script, which you can then run to perform the 
same activities on multiple remote hosts. Click Script on the Jconfig toolbar 
to view the Scripting Wizard. The following two procedures outline the 
basic steps for using configuration scripts and how to record a script using 
the Jconfig Scripting Wizard.
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To use a script to configure multiple hosts:

1 Create a Host Database file. You need to create a Host Database file 
that contains the names and passwords of the PCs you want. To make it 
easier to configure similar PCs, you can group them.

2 Record a Script. You need to record a script that will perform the 
required configuration activities on the hosts. Perform the 
configuration steps on the administration host while running the 
Scripting Wizard.

Home—The directory in 
which the software is 
installed.

3 Compile the Script. Use a Java compiler to perform this task. You must 
compile the file in conjunction with a file that contains the required 
classes. For example, if you have recorded a script with the file name 
test.java, and you are using the Sun Microsystems JDK Java compiler, 
type the following on the command line in the home directory: 

See your Java compiler 
documentation for details 
about compiling the script 
file. 

javac -classpath .\hccljcofig.jar <userdir>\test.java

The compiler generates a file called test.class. This is the file that is 
used to perform the configuration of the remote hosts.

For more information on 
running scripts, see the 
Jconfig Help.

4 Run the Script. Go to the Connection Wizard and select the Script Driven 
option. Proceed through the subsequent steps for that process. 

To record a script:

1 On the Jconfig toolbar, click Script. The Jconfig Scripting Wizard opens.

2 In the Script Class box, type the class name of the script and click Next.

3 If you do not want the changes to apply to the remote host while you 
record, clear the Apply Changes check box. Click Next. This option is 
selected by default.

4 Select any miscellaneous settings you require and click Finish.

5 After running the Wizard, you can start one or more Jconfig services 
and perform configuration activities. As configuration progresses, the 
script tool records your actions.

6 To stop recording, click Script on the Jconfig toolbar. A message appears 
confirming that the script was recorded.
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Locking a Configuration Session
If you are going to leave your computer but do not wish to terminate the 
Jconfig application, you can lock the current configuration session so that 
only someone with the administration password can reopen the session. 
Click Lock Session on the Jconfig toolbar. The Administrator Connection 
dialog box opens. The session is locked as soon as this dialog box appears. 
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Introducing Inetd

Inetd is a super-daemon that lets you enable and disable various daemon 
services through a single application. It determines the network services to 
which your PC responds when a client makes an incoming network request. 
In Windows 95/98/Me environments, Inetd runs automatically when placed 
in the Startup folder. In Windows NT/2000 environments, Inetd is installed 
as a service. 

Instead of running separate server applications for each service, Inetd 
conserves workstation resources by continuously monitoring connection 
attempts in the background and starting the appropriate daemon upon 
receiving a network request. You can selectively enable or disable daemons 
to accommodate your local requirements. For example, you can use FTPd 
to distribute corporate files from a server. Clients would connect to the 
server and use FTP to download the files. 

Inetd handles both TCP (Transmission Control Protocol) and UDP (User 
Datagram Protocol) servers. The Inetd daemon is based on asynchronous 
notification. It uses no CPU time and only a small amount of memory 
when waiting for incoming requests. 

With Windows 95, you can restrict users’ access to your drives/directories 
with the permissions you assign in the Inetd Admin application. With 
Windows NT, if there are TelnetAccess or FTPAccess groups in the user 
administration program, the NT user must be a member of these groups to  
access the machine using Telnet or FTP. No security check is performed if 
the group does not exist, and access is allowed for every NT user account.

TCP and UDP Servers

TCP     Inetd simultaneously monitors connection requests on multiple 
ports. When it detects a request, it starts the appropriate daemon and 
screens the user.

Note: The Inetd daemon is installed in the Control Panel by Setup.
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UDP     Inetd monitors the UDP port for packets. When it detects packets, it 
uses the port number to link the packet flow to an enabled daemon. The 
connection is refused if no daemon is enabled, or if permission is denied to 
the UDP user/password.

Maintaining System Security

Users that connect to your drives and directories uisng the Inetd services are 
restricted to file access based on the permission you assigned. 

Security for Windows 95/98/Me
With Windows 95/98/Me, you assign permissions using the Inetd Admin 
application. Inetd Admin is an administration tool designed to control 
access to your files and resources.

When remote users on the network try to log onto your PC via the Inetd 
server programs, Inetd Admin screens them and determines the level of 
access. To allow anonymous FTP access to your PC via the FTP daemon, 
you must set up an anonymous user account in Inetd Admin.

Security for Windows NT/2000
Windows NT/2000 supports NTFS, FAT, and HPFS file systems. Of these, 
only NTFS file systems provide security at the file and directory level (access 
control).

Users that link NTFS drives and directories by means of the Inetd services 
are restricted to file access according to Windows NT/2000 permissions. 
Users that link FAT drives and directories using the Inetd services are not 
restricted in the exported file system. FAT file systems always use the same 
permissions for Owner, Group, and World (rwxrwxrwx).

To set NTFS file security:

1 Select one or more files in My Computer.

2 On the File menu, click Properties. The Properties dialog box opens.

3 Click the Sharing tab.
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4 Click Permissions. The Access Through Share Permissions dialog box 
opens.

5 Specify the appropriate security options. See your Windows NT 
documentation for details on setting file security. 

If you have enabled FTPd and/or Telnetd, there are some further security 
considerations. If you have local disk volumes other than NTFS volumes, 
consider the following when determining whether to allow remote users to 
have access to your local machine using FTP or Telnet:

FTP—transfers both text and binary (graphic) files between your PC 
and a remote computer running a server implementation of FTP. It can 
also perform file and directory management. 

Telnet—provides a VT220/VT320/ANSI/ Wyse 50/Wyse 60 terminal 
emulation window on a PC, UNIX, or VMS host.

FTP Security Considerations (Windows NT/2000)
The FTP daemon (FTPd) lets you set read and write access to restrict users 
writing to FAT and HPFS volumes. For FTP users, you can set access to the 
NTFS file system using the access privileges granted to specific users or 
groups in the User Manager program (the native Windows security system).

Telnet Security Considerations (Windows NT/2000)
The server application, Telnetd, cannot restrict incoming users to a 
particular local disk volume. NTFS allows for file access control under 
Windows NT/2000, whereas FAT and HPFS file systems have no security.  If 
you have a FAT or HPFS disk volume on your machine, and you enable 
Telnet access over the network, incoming users have unrestricted access to 
those disk volumes. This means they could potentially delete all files. 

Note: FTP can limit access to volumes. We recommend that you 
do not include FAT or HPFS disk volumes in the ~r or ~w 
parameters of FTPd. If there is an FTPAccess group in the user 
administration program, the NT user must be a member to access 
the machine using FTP. No check is performed if the group does 
not exist; access is then allowed for every NT user account.
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There are two solutions to this problem:

• Use only NTFS file systems on your computer.

• If you have FAT or HPFS disk volumes, do not enable Telnet access over 
the network.

Default Services

The following daemon services are provided with your software package:

Note: If there is a TelnetAccess group in the user administration 
program, the NT user must be a member of the group to 
successfully access the machine using Telnet. No check is 
performed if the group does not exist; access is then allowed for 
every NT user account.

TCP Services Daemon Description

BOOTPd Enables client workstations using Bootstrap Protocol 
to request their configuration information. For more 
information, see “BOOTPd (Windows NT/2000)” on 
page 201.

Fingerd Lets a remote user query the state of your current 
configuration. For more information, see “Fingerd” on 
page 202.

FTPd Enables users to transfer files between other 
computers and your computer. For more information, 
see “FTPd (File Transfer Protocol Daemon)” on 
page 202.

LPD Lets other workstations send print files directly to your 
PC printer, or to a network print queue on the PC. For 
more information, see “LPD” on page 204.
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BOOTPd (Windows NT/2000)
BOOTPd enables client workstations using Bootstrap Protocol to request 
their configuration information. If a client machine is configured for 
BOOTP, each time it starts, a BOOTP request is broadcast over the network. 
The BOOTP request contains the MAC (Media Access Control) address of 
the machine (physical hardware address). When BOOTPd is enabled, it 
responds to requests if the client’s MAC address is found in the Bootptab 
configuration file. The possible responses are as follows:   

Telnetd Lets Telnet clients make connections your PC. For 
more information, see “Telnetd” on page 205.

Xstartd A local X client starter daemon that enables users to 
access X clients on your PC. For more information, see 
“Xstartd” on page 206.

UDP Services Daemon Description

TFTPd Lets users transfer files to and from your PC using the 
TFTP protocol. For more information, see “TFTPd” on 
page 208.

Timed A time server that other workstations can use to 
synchronize their current date and time. For more 
information, see “Timed” on page 209.

Tnamed A Trivial Name Server that accepts incoming Trivial 
Name requests for host name resolution. For more 
information, see “Tnamed” on page 209.

Response Description

Using UDP BOOTPd sends a BOOTP reply to the client on UDP port 
67.

Using Hummingbird’s 
TCP/IP

BOOTPd sends a BOOTP reply directly to the client 
machine. 

Using another 
vendor’s TCP/IP

BOOTPd sends a BOOTP reply as a broadcast response.

TCP Services Daemon Description
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To use BOOTPd you must fulfill the following requirements:

• You must enable BOOTPd in Inetd on at least one machine in the 
network. It is best to enble BOOTPd on several machines so that if one 
machine fails to respond, the configuration information is still available 
for other machines on the network. 

• There must be a configuration file, BOOTPtab, in the home directory. 
You must use the same file on all machines running BOOTP.

• You must configure each of the client machines on the network for the 
BOOTP setting of the IP address instead of User Entered. 

All incoming BOOTP requests are written to the bootpd.log  file in the 
home directory.

Comparison to RARP     An alternate protocol, Reverse Address Resolution 
Protocol (RARP), also lets a client determine its IP address when the MAC 
(Media Access Control) address is known. The difference between RARP 
and BOOTP is that RARP is hardware, link-level protocol instead of an IP/
UDP protocol. This means that RARP can be implemented only on local 
hosts on the same subnet. 

Fingerd
Windows system 
directory—
Windows 95/98/Me: 
Windows\System, 
Windows NT/2000: 
Winnt\System32.

Fingerd enables remote users to query the state of your current 
configuration. If the remote user requests a long listing, Fingerd also 
displays the contents of the plan.hcl and project.hcl files from:

%System%\Hummingbird\Connectivity\version\Inetd

where version  is the version number of your Hummingbird product.

The plan.hcl file typically contains your contact information (phone 
number, address, e-mail, and so on), while the Project file typically contains 
information on your function or current project.

FTPd (File Transfer Protocol Daemon)
FTPd handles incoming requests to transfer files between other computers 
and your own. Many Internet nodes contain files that are generally available 
through anonymous FTP.
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When an FTP transfer is requested, the program checks for a user ID, 
password, and access rights to read, create, delete and write on the various 
server drives, before forwarding the request to FTPd. FTP requires the 
services of the TCP protocol to move files. Do not select UDP in the Daemon 
Configuration dialog box for this service.

Optional Parameters     Use the following syntax to specify the password 
files to be used to validate access:

- p password_file

Inetd Admin—provides 
access to the password 
database that controls 
access to your PC from 
external users through 
passwords and user names.

where password_file is the full path and file name of the password file you 
are using. By default, the password file is called password.hcl in the system 
directory:

%System%\Hummingbird\Connectivity\version\Inetd

where version  is the version number of your Hummingbird product.

To create a password file, use Inetd Admin.

The following optional parameters are available for FTPd in a Windows NT 
environment:

The format for specifying drives is:

-rwd:\

This limits FTP users to read/write access on the listed drive.

Specifying options in the ftpd.ini file     You can create an FTPd 
configuration file that specifies the following:

• Timeout period—Ensures that FTPd closes a connection after a period 
of client inactivity.

• Banner display—Displays a text banner when a user connects to your 
machine using FTP.

Parameter Description

-rdrives Limits FTP users to only read access on the listed drives.

-wdrives Limits FTP users to only write access on the listed drives.

-rwdrives Limits FTP users to read/write access on the listed drives.
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To specify FTP configuration options:

1 Create a file named ftpd.ini.

2 To specify a timeout period, type the following in the file:

[Inactive]
TimeOut=n

where n is the maximum number of seconds of inactivity after which 
FTPd closes a connection. If n is less than or equal to 0, the timeout 
feature is disabled.

3 To display a banner, type the following in the file:

[Custom]
Banner=BannerText

where BannerText is the text banner you want to display.

LPD
LPD (Line Printer Daemon) lets other workstations send print files directly 
to your PC printer, or to a network print queue on your PC. Print options 
are not directly configurable under Inetd, but if you want to let users print 
host files to your PC printer, you must define your default printer. See your 
Windows documentation for information about setting up the default 
printer.

Depending upon the remote host from which you want to print, you may 
need to define an entry for the printer in the /etc/printcap file on the 
remote host, or create a printer queue with the appropriate host 
administration tools. 

To configure the LPD program to use an existing printer, you must 
configure the remote host to send print jobs to a queue. The printcap file 
on the remote host links the local queue name (to which the local PC sends 
print requests) to the remote queue name (where the files are actually 
printed).
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For example, a user sends a print job to the queue hpjohn, that is actually a 
printer called hplaser connected to the remote machine john. The remote 
host between these two PCs might have a printcap entry that links these 
two queue names like this: 

HPJOHN|printer:\
:in:ttl:rp=dos-hplaser:ih=JOHN

On the remote system the queue names for the PC are defined in the form 
queueformat-printername, where queueformat is one of the following: 

• dos(ff)—If xxx is DOS, the file is printed without modification. If xxx 
ends in FF, a form feed is appended to the job if one is not already 
present.

• unix(ff)—If xxx is UNIX, linefeeds are converted to carriage returns 
and linefeeds. If xxx ends in FF, a form feed is appended to the job if one 
is not already present.

• text (ff)—If xxx is TEXT, the output is rendered. This is usually used 
for printing text files directly to PostScript printers. If xxx ends in FF, a 
form feed is appended to the job if one is not already present.

Telnetd
Telnetd is a Telnet server that lets Telnet clients make connections to your 
PC. Users can connect using the Hummingbird Telnet client, a graphical 
VT100/320 terminal emulator application, or any VT100 Telnet client.

Note: Some systems have a limit on the number of characters in 
the remote queue name. Thus, if unixff-printer-name is too 
long, use shortened prefixes (D, DF, U, UF, and T). Also, some 
systems do not allow a dash character in the remote queue name. 
For these systems, use an underscore character instead.
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In a Windows NT/2000 environment, the user must have an account on the 
Windows NT system, and have appropriate permissions in the Windows NT 
security system. Users are restricted to the protection and access rights 
specified by the system administrator for each of the Windows machines, 
drives, directories, and files.

Optional Parameters (Windows 95/98/Me)     The following optional 
parameter is available for Telnetd:

-p password_file

where password_file is the full path and file name of the password file you 
are using. Use the specified password file to validate access. . By default, the 
password file is called password.hcl, located in the following directory: 

%System%\Hummingbird\Connectivity\<version>\Inetd

where version  is the version number of your Hummingbird product. 

Xstartd
Xstartd is the local X client starter daemon. When Xstartd is enabled, other 
users can access X clients on your PC. They can connect to your PC and 
start X clients by using their Xstart application and the REXEC or RSH 
connection methods.

Note: If the user administration program has the group 
TelnetAccess, the user must be a member to successfully access 
your workstation. No check is performed if the group does not 
exist—access is then allowed for every user account.

Note: The password file is empty until you modify it with Inetd 
Admin.

Note: RSH is available only for Windows 95/98/Me. You cannot 
use the RSH protocol with Windows NT/2000.
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When using the REXEC protocol, Xstartd verifies the user name and 
password in Inetd Admin to ensure that access has been granted to the 
remote user. When the RSH protocol is used, RSH looks for the rhosts file 
in the %System%\Hummingbird\Connectivity\<version>\Inetd directory, 
where version  is the version number of your Hummingbird product. Only 
the hosts and users listed in this file can log in using Xstartd.

REXEC     When using the REXEC protocol, Xstartd verifies the user name 
and password in Inetd Admin to ensure that access has been granted to the 
remote user. 

• In Windows 95/98/Me—Use Inetd Admin to verify user names and 
passwords For REXEC, -p password_file specifies the password file to be 
used to validate access. By default, the password file is password.hcl, 
located in the following directory:

%System%\HUMMINGBIRD\Connectivity\<version>\Inetd

where version is the version number of your Hummingbird product.

• In Windows NT/2000—User names and Passwords are verified by the 
operating system itself. The user name used must belong to someone 
who uses that PC or to a fully qualified Domain user who is permitted 
to login to that PC.

RSH     RSH is available on Windows 95/98/Me. The RHOSTS file 
determines which hosts are allowed to connect to the PC and is located in 
the following directory:

%System%\HUMMINGBIRD\Connectivity\<version>\Inetd

where <version> is the version number of your Hummingbird product.

The RHOSTS file consists of one or more lines in the following format:

hostname username

where hostname represents a hostname from which RSH is allowed, and 
username represents the user ID of a user on host hostname who is allowed 
to RSH to your PC. 

Note: You must put a space between the hostname and 
username parameters.
207



HostExplorer™ User’s Guide
You can use the plus character (+) in the hostname or username fields to 
represent any host and any user. For example, to let all users with the user 
ID of John Smith on any host to RSH to your PC, specify the following:

+ JohnSmith

To include a comment in the file, begin the comment line with the number 
or pound sign (#).

TFTPd
TFTPd lets you use your PC as a TFTP (Trivial File Transfer Protocol) 
server. The TFTP server lets users transfer files to and from your PC. Any 
TFTP client program can use the TFTP server, including the DOS TFTP 
client. 

One of the major applications for TFTP is to allow diskless workstations or 
PCs with BOOT PROMs to retrieve boot images from a Windows  
workstation in conjunction with the BOOTPdw server. To prevent 
unauthorized users from accessing your PC, we suggest creating a directory 
specifically for boot image files and making only that directory available to 
TFTP clients using the -r option.  

TFTPd has an inactive timeout feature that you can use to ensure that 
TFTPd closes a connection after a period of client inactivity.

Warning!  TFTP does not require a user name and password, so 
take great care when setting up this server.

Optional Parameters Description

-r directory Specify a read directory for clients. For example, 
-rc:\bootptab

-w directory Specify a read directory for clients. For example,
-wc:\hcltcp

-o or –O Allow clients to overwrite existing files.
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To specify a timeout limit:

1 Create a file named tftpd.ini.

2 Type the following in the file:

[Inactive]

TimeOut=n

where n is the maximum number of seconds of inactivity after which 
TFTPd closes a connection. The minimum timeout is 10 seconds.

3 Save the file in the following directory:

%System%\Hummingbird\Connectivity\<version>\Inetd

where version  is the version number of your Hummingbird product.

Timed
Timed is a time server that other workstations can use to synchronize their 
current dates and times. When a machine sends a time request to your PC, 
Timed returns the current time. This is the time value since Jan 1, 1970 
GMT. You can set up workstations with the hcltime or hctime32 program 
to synchronize the date and time across the network.

Tnamed
Tnamed is a Trivial Name Server that accepts incoming Trivial Name 
requests for host name resolution. It calls the local name resolution routine, 
gethostbyname( ), then searches the main lookup paradigm specified on 
the machine.

Managing Services

Enabling and Disabling Services
You can enable and disable daemon services in the Hummingbird Inetd 
Configuration dialog box. Configuration information is stored in the file 
inetd.ini.
209



HostExplorer™ User’s Guide
To enable a service, select the service in the Inetd Service list and click Enable. 
To disable a service, select the service in the Inetd Service list and click 
Disable. To save changes, click Save.

Configuring Services

To configure a Network Service:

1 In the Hummingbird Inetd Configuration dialog box, select the service that 
you want to configure and click Configure. The Daemon Configuration 
dialog box opens.

2 Verify that the Daemon Name box contains the name of the selected 
service and that the Program Filename box contains the file name for the 
service. 

For more information about 
available parameters, see 
“Default Services” on 
page 200.  

3 In the Optional Parameters box, type optional parameters associated with 
the selected service. 

4 In the Port box, type a port number between 0 and 65535 to uniquely 
identify the service.

5 Select either the TCP or UDP protocol required for the server. If you 
select TCP, type the maximum number of servers that can be used for 
the service in the Maximum Servers box.

6 Click OK.

7 To save changes, click Save.

Adding and Deleting Services
Any of the existing servers can be configured to run on any port or run on 
more than one port at a time.

To add a service:

1 In the Hummingbird Inetd Configuration dialog box, click Add. The 
Daemon Configuration dialog box opens.

2 In the Daemon Name box, type the name of the service you want to add.

3 In the Program Filename box, type file name of the service.
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4 In the Optional Parameters box, type any optional parameters associated 
with the service. 

5 In the Port box, type a port number between 0 and 65535 to uniquely 
identify the service.

6 Select the protocol required for the server: either TCP or UDP. If you 
selected TCP, type the maximum number of servers that can be used for 
the service in the Maximum Servers box.

7 Click OK.

8 To save changes, click Save. 

To remove any or all of the services from the list of available Inetd services, 
click Delete in the Hummingbird Inetd Configuration dialog box. To save the 
changes, click Save.  

Reloading Updated Configuration Information
After making changes to the Inetd configuration, such as enabling or 
disabling a service, you can load the updated configuration without exiting 
your configuration session. To reload the Inetd configuration file, click 
Reload in the Hummingbird Inetd Configuration dialog box. 

Restoring Default Services
If your current Inetd configuration file is lost or corrupted, you can restore 
the default settings. To restore the settings, click Defaults in the Inetd 
Configuration dialog box. After you have restored the default settings, you 
can enable the services you require.

Logging Server Activity
With Windows 95/98/Me, you can record all server start and stop messages 
in a log file. To enable logging, select Connection Logging in the Hummingbird 
Inetd Configuration dialog box.

Note: To reload all network services back into the Setup menu, 
click Reload. To reload the original default settings, click Defaults.
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Inetd stores messages in the inetd.log file, located in the following 
directory:

%System%\Hummingbird\Connectivity\<version>\Inetd

where <version>  is the version number of your Hummingbird product.

With Windows NT/2000, you can send all server start and stop messages to 
the Windows NT/2000 Event Viewer Log file. To enable logging, select 
Connection Logging in the Hummingbird Inetd Configuration dialog box.

Configuration Parameters

Destination Folder
Program files install into the home directory. During setup, you can specify 
a different home directory, other than the default. For more information, 
see the Installation chapter in this manual.

BOOTPD.LOG File
All BOOTP requests and responses are recorded in the bootpd.log file in 
the default hclnfs  directory. Requests are time and date stamped to provide 
a chronological record of BOOTP events on the network. A sample segment 
from a bootpd.log file is as follows:

info(6)version 3.2

info(6)reading “c:\hcltcp\bootptab”

info(6)read 38 entries (38 hosts) from “c:\hcltcp\bootptab”

info(6)recvd pkt from IP addr 0.0.0.0 AT Tue Aug 16 08:14:44 1995

info(6)request from Ethernet address 00:60:8C:E8:CE:55

info(6)found 185.75.64.10 (pete)

info(6)vendor magic field is 99.130.83.99

info(6)sending reply (with RFC1048 options)

info(6)setarp 185.75.64.10 - 00:60:8C:E8:CE:55

info(6)recvd pkt from IP addr 0.0.0.0 AT Tue Aug 16 08:16:32 1995

info(6)request from Ethernet address 00:60:8C:E8:CE:77
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info(6)found 185.75.64.12 (bobg)

info(6)vendor magic field is 99.130.83.99

info(6)sending reply (with RFC1048 options)

info(6)setarp 185.75.64.12 - 00:60:8C:E8:CE:77

info(6)recvd pkt from IP addr 0.0.0.0 AT Tue Aug 16 08:17:57 1995

info(6)request from Ethernet address 00:60:8C:E8:CE:99

info(6)found 185.75.64.14 (roger)

info(6)vendor magic field is 99.130.83.99

info(6)sending reply (with RFC1048 options)

info(6)setarp 185.75.64.14 - 00:60:8C:E8:CE:99

You can include more detail in the log by inserting the -d option in the 
configuration for BOOTPdw. Up to four -d options (separated by spaces) 
can be inserted for increasing levels of detail. Specify the -d option(s) in the 
Optional Parameters box of the BOOTPd Daemon Configuration dialog box.

BOOTPTAB Configuration File
The bootptab file is an ASCII file that matches the client machine MAC 
address (physical hardware address) with other configuration information. 
The configuration information in the bootptab file can vary from simply 
the IP address for each machine, to a complete set of configuration 
information such as default gateway, Domain Name Server, subnet mask, 
Time Server, etc. All entries must be in the format:

xx=value

where xx is a two-letter designation for a parameter. The value is either a 
number or text entry depending upon the nature of the parameter.
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The configuration information can appear in several forms as illustrated by 
the parameter definitions listed below:

bf The name of the boot file.

bs The size of boot requests.

da The IP address of the server providing authentication (user 
name/verification) on your network.

df The name of the dump file.

dl The length of the DHCP lease.

dn The domain name for your network. For example, zyx.com.

ds The IP address of the domain name server for your network.

ef The name of the file containing further options.

gw The IP address of a gateway for your network.

ha The unique MAC address from the network adapter card located 
inside your PCs and workstations. For PCs, this address is usually 
printed on a label on the network adapter card. You can also 
attach the PC to the network, configure it for BOOTP support, 
reboot it, and then examine the bootpd.log file for the entry that 
contains the MAC address.

hd The name of the home directory.

hn Resets the host name of the recipient.

ht For almost all PC networks, the network type is Ethernet.

ip The unique IP address assigned to this PC or workstation.

lg The name of the machine that will receive log requests.

lp The IP addrss of the server providing the printing control 
function (LPD protocol).

mw The amount of time after which the boot request is ignored.

ns The IP address of a Trivial Name Server.
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See the following sub-sections for examples.

IP Address Only     In this example, the only configuration item is the IP 
address corresponding to the MAC address. One entry line is required for 
each client machine in the network.

nt The IP address of a time server using the NTP (Network time 
Protocol).

ra The reply address.

rl The name of the RLP server.

rp Leads to the root of the file system.

sa The address of the machine used for booting.

sm The four-octet, dotted, decimal, subnet mask as per the standard 
on subnetting, for example, 255.255.255.0. This field must 
precede the gateway (gw=) field, if used.

sw The name of the swap server.

tc The text string contained in this field must match a previously 
defined common configuration block, for example, hcleth. Any 
valid field can be contained in a common configuration block.

td The name of the TFTP directory.

to The time offset specified in seconds from Coordinated Universal 
Time (UTC). For example, EDT is 5 hours from 0000 UTC; 
therefore, to=18000 (5 x 60 x 60 = 18000).

ts The IP address of a server using TIME (Time Server Protocol).

vm The value of the magic cookie is 99.130.83.99. Other BOOTP 
servers can use other values in this field, but the current release of 
bootpd requires 99.130.83.99.

yd The Domain Name for the server providing NIS (Yellow Pages) 
service.

ys The IP address of the server providing NIS (Yellow Pages) service.
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pete ht=ethernet:ha=00608ce8ce55:ip=185.75.64.10

barbg ht=ethernet:ha=00608ce8ce77:ip=185.75.64.12

roger ht=ethernet:ha=00608ce8ce99:ip=185.75.64.14

Multiple Parameters     In this example, the subnet mask, default Gateway, 
Domain Name Server, Domain Name, and Time Server are returned to each 
client workstation.

pete:
ht=ethernet:ha=00608ce8ce55:ip=185.75.64.10:sm=255.255.255.0\
:gw=185.75.64.254:ds=185.75.64.5:dn=xyz.com:ts=185.75.64.5

barbg:
ht=ethernet:ha=00608ce8ce77:ip=185.75.64.12:sm=255.255.255.0\
:gw=185.75.64.254:ds=185.75.64.5:dn=xyz.com:ts=185.75.64.5

roger:
ht=ethernet:ha=00608ce8ce99:ip=185.75.64.14:sm=255.255.255.0\
:gw=185.75.64.254:ds=185.75.64.5:dn=xyz.com:ts=185.75.64.5

If you have many client machines and multiple configuration parameters, 
this form of entry can become cumbersome. Instead, you can define all of 
the common parameters just once and use a single entry for all the common 
parameters.

Multiple Parameters with a Common Parameter Block     In this example, 
all of the common parameters are defined in the hcleth:\ statement. The 
common parameters are then identified for each client by using a single 
entry, tc=hcleth. This format makes it easier to add new PCs and 
workstations to the bootptab file. 

hcleth:\

ht=ethernet:sm=255.255.255.0:gw=185.75.64.254:ds=185.75.64.5\

dn=xyz.com:ts=185.75.64.5:vm=99.130.83.99:to=18000\

da=185.75.64.5

pete tc=hcleth:ha=00608ce8ce55:ip=185.75.64.10

barbg tc=hcleth:ha=00608ce8ce77:ip=185.75.64.12

roger tc=hcleth:ha=00608ce8ce99:ip=185.75.64.14
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There can be multiple common configuration blocks, each with a unique 
name. The tc=field of the client entry can then point to the appropriate 
common configuration block.

Administering Daemon Security—Inetd Admin

All NFS Maestro and Exceed local daemons, including FTPd, Xstartd, 
Fingerd, and Lpd, are started in the Inetd application where they are listed 
as Setup options in the Inetd window. In NFS Maestro and Exceed, Inetd 
acts as the network super server daemon, enabling network services without 
their own stand-alone services.

When external users log into your daemons through Xstartd or FTPd 
programs, Inetd Admin plays a security role by screening them and 
regulating their activities.

Inetd Admin is available only for Windows 95/98/Me systems, and is 
installed in the System Administration folder of your application. Windows 
NT/2000 systems have security features equivalent to Inetd Admin.

Users and Passwords

Creating a User List
Inetd Admin is an administration tool that enables you to control access to 
the server daemons on your PC. You can assign a password for each remote 
user, specify the services the user can access (Telnet, Xstart, and FTP), and 
specify file access permissions.

Access information is stored in the Inetd password file so daemon servers 
can verify user information. By default, the password file is named 
password.hcl, and is saved in the following directory:

%System%\Hummingbird\Connectivity\<version>\Inetd

where <version> is the version number of your Hummingbird product.

Each password file entry contains a user name, an assigned password, setup 
information, and permissions.
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You can use Inetd Admin for typical user access management tasks, 
including:

• creating new user entries

• assigning access rights to new users

• modifying user access rights

• changing user passwords

• deleting user access rights

Opening a Password File
Inetd stores access rights information in a password file. By default, the 
password file is named password.hcl, and is saved in the following 
directory:

 %System%\Hummingbird\Connectivity\<version>\Inetd

where <version> is the version number of your Hummingbird product.

When you start Inetd Admin, you must specify the password file you want 
to open. To start Inetd Admin, click the Inetd Admin icon.

To open a password file:

1 Start Inetd Admin. The Open Password File dialog box opens.

2 Select the password file you want to open. The default password file is 
password.hcl. Click Open. The Username/Password Administration dialog 
box opens. 

Assigning User Names and Passwords
The first time you use Inetd Admin, you need to create a list of remote users 
who are permitted to access your PC. After you create the list of user names 
and associated passwords, you can assign access permissions.

To assign user names and passwords:

1 In the Username/Password Administration dialog box, click Add. The Add 
Username dialog box opens.

2 In the Username box, type the user name for the new user.
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Passwords are case-
sensitive.

3 In the Password box, type a password for the new user. Retype the 
password in the Confirm Password box.

4 Click OK. The User Access Rights dialog box opens.

For more information, see 
“Specifying Access Rights” 
on page 219.

5 Specify the access rights for the user and click OK.

6 In the Username/Password Administration dialog box, click Save to save 
the changes to your password file.

Changing Passwords
If users forget their passwords, the system administrator can assign new 
ones.

To assign a new password:

1 In the Username/Password Administration dialog box, select the 
appropriate user and click Modify. The User Access Rights dialog box 
opens.

2 Click Change Password. The Change Password dialog box opens.

Passwords are case-
sensitive.

3 In the Password box, type a password for a new user. Retype the 
password in the Confirm Password box. 

4 Click OK. Inetd assigns the new password.

Managing Access

Specifying Access Rights
For each user, you can specify access rights on your PC. If you give the user 
access to the FTP service, you can also specify file access privileges for up to 
10 directories.

To specify user access to your PC:

1 In the Username/Password Administration dialog box, select the 
appropriate user and click Modify. The User Access Rights dialog box 
opens.
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2 In the Services Permitted section, select the check boxes for services you 
want the user to access:

• Telnetd—The supplied Telnet daemon provides a VT320/VT100/
VT52 terminal emulation window on a host.

• FTPd—The File Transfer Protocol Daemon is a Windows server 
program that lets you handle incoming requests to transfer files 
between computers. When an FTP transfer is requested, the 
program checks for a user ID, a password, and access rights to read, 
create, delete and write on the various server drives, before 
forwarding the request to FTPd.

• Xstartd—This remote execution server implements the REXEC and 
RSH protocol. This server allows other users on your network to 
run local X clients on your PC when the local PC is running 
Xstartd.

3 Set the environment variables for users:

• Temp Directory—Specifies the temporary directory on your PC 
used to store temporary files. Set this temporary directory to full 
read/write access since many applications started using telnetd 
require temporary files. This directory must already exist on your 
PC.

• Initial Directory—Specifies the directory that is opened first when 
the FTPd or telnetd daemon application starts. Users must have 
permission to access this directory. Otherwise, the connection is 
terminated. 

• COMSPEC Var—Specifies the default command shell that starts 
when users try to access your PC. The default COMSPEC variable is 
c:\windows\command.com, although other shells may be used when 
the DOS shell has been customized. For example, you can use 
4dos.com, ndos.com, or pcdos.com.

You must assign read and write permission to Telnet users in directories 
containing command.com or the command interpreter. Otherwise, the 
system cannot change the directory when users try to execute a remote 
command.

4 If you enabled access to FTP for a user, specify file access permissions in 
the Directory Permissions section.
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Directory Permissions

To specify directory permissions:

1 In the User Access Rights dialog box, click Add. The Add Directory dialog 
box opens.

2 In the text box, type the directory name.

The conventions for specifying directories are as follows:

3 Specify file access permissions in the directory:

• Read—The remote user can open files and search directories on 
your PC. Execute permission is also required to open directories.

• Write—The remote user can edit files on your PC. Generally, users 
also need Create permission to write to files.

• Create—The remote user can create new files and subdirectories on 
your PC. Generally, users also need Write permission to create files.

Note: Do not add a backslash (\) at the end of the name, 
because only the specified directory has the specified 
permissions. You can include all subdirectories by adding a 
backslash asterisk (\*) to the directory name. 

Directory Interpretation by Directory Listings

c:\hcl The C:\HCL directory only

c:\hcl\* The C:\HCL directory and all subdirectories

c:\hcl\a* All subdirectories of C:\HCL starting with "A"

d: The entire D: disk

c The root directory of the C: disk

c:* The entire C: disk

c:\ NOTHING (ends in backslash)
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• Delete—The remote user can delete files and directories from your 
PC.

• Modify—The remote user can change file attributes on your PC.

• Execute—The remote user can run applications and open 
directories on your PC.  

4 Click OK.

Removing Access Rights
You can restrict a user’s permissions on your PC by removing specific access 
rights. There are three types of rights you can remove:

• Access to your PC—You can remove all access to your PC by deleting 
the user from your password file.

• Access to services—You can disable access to services on your PC.

• Access to directories—If the user has access to the FTP service, you can 
restrict access to directories on your PC and to the file access privileges 
within those directories. 

To remove a user from the password file:

1 In the Username/Password Administration dialog box, select the user you 
want to remove and click Delete.

2 Click Save to save changes to the password file.

Note: The permissions you specify apply only to the selected 
directory. You must repeat this process for each directory listed.

Note: If users attempt to access a service that is missing or 
disabled in Inetd, the connection is terminated. For more 
information, see Inetd Help. 
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To remove access to a service:

1 In the Username/Password Administration dialog box, select the 
appropriate user and click Modify. The User Access Rights dialog box 
opens.

2 In the Services Permitted section, clear the check box for the service you 
want to disable. Click OK.

3 Click Save to save changes to the password file.

To remove directory or file access rights:

1 In the Username/Password Administration dialog box, select the 
appropriate user and click Modify. The User Access Rights dialog box 
opens.

2 In the Directory Permissions section, do either of the following:

• Remove access to a directory by selecting the directory and clicking 
Delete.

• Remove file access rights by selecting the appropriate directory and 
clearing the check boxes for rights you want to disable.

3 When you are finished, click OK.

4 In the Username/Password Administration dialog box, click Save to save 
changes to the password file.

Granting Anonymous FTP Access
To grant anonymous FTP access rights to users connecting to your PC 
through the FTPd daemon, you must add an anonymous FTP user to your 
password file. After this account is set up, any user can access your PC by 
typing the user name anonymous, and any password. 

To create an anonymous account:

1 In the Username/Password Administration dialog box, click Add. The Add 
Username dialog box opens.

2 In the Username box, type ftp. The user name must be lower case.
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3 In the Password box, type ftp. The password must be lower case. Retype 
the password in the Confirm Password box.

4 Click OK. The User Access Rights dialog box opens.

5 Assign access privileges for anonymous FTP connections.

Warning!  Be extremely careful when assigning access rights for 
anonymous FTP. You should not allow anonymous users to delete 
files from your PC.
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Accessories

To quickly locate the online help for an Accessory, open the application and 
click help from within the application.

Finger     This application returns information about the users of a 
particular computer. You can display information about a specific user, or 
all users currently logged onto a particular computer.

Host Editor     This application lets you edit and manage a list of IP 
addresses and associated machine names. This information is contained in 
the HOSTS file on your PC. 

Hummingbird Basic     This is a command language included with 
Hummingbird products. Hummingbird Basic can be used to create scripts 
for frequently performed tasks that you would like to automate. For details, 
refer to the Hummingbird Basic Language Programmer’s Guide.

Launch Pad     This application lets you launch applications and manage 
application windows. It includes a graphical menu-building facility that lets 
you customize your environment, and a Virtual Desktop that increases the 
size of the Windows display workspace.

Network Time     This application lets you synchronize the time on your PC 
with the Network Time Server. 

NSLookup     This application finds and displays information about hosts 
in a domain.

Ping     This is a diagnostic tool that lets you quickly check the integrity of a 
network communications path and your TCP/IP configuration. Ping sends 
Internet Control Message Protocol (ICMP) echo requests to specified 
machines and displays the response in graphical form.

Remote Tools     This application is an integrated version of several UNIX 
commands—Remote Shell, Remote Exec, Remote Copy (RSH) and Remote 
Copy (REXEC). You can execute commands and copy files to or from other 
machines on the network using the RSH and REXEC protocols.

Tar     This application lets you easily transfer entire directories and their 
contents to an Archive file, usually for backup purposes. You can create local 
and remote Archive files and restore them to your PC at any time.
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Traceroute     This application shows the route that packets take to the host. 
It lets you test, troubleshoot, and manage network connections and find the 
route used to connect to a specific host.

Whois     This application lets you query the central user name directory 
service maintained by the InterNIC (Network Information Center) 
Registration Service for an entry name. The InterNIC Registration Services 
Host contains Internet information (Networks, ASNs, Domains, and POCs) 
for non-military users. For military information, use the Whois server at 
NIC.DDN.MIL or MILNET. 

System Administration

Hummingbird Inetd     Inetd is a super-daemon that lets you enable and 
disable various daemon services through a single application. It determines 
the network services to which your PC responds when a client makes a 
network request. In a Windows 95/98/2000 environment, Inetd runs 
automatically when placed in the Startup folder. The Startup folder is the 
usual location for Inetd. For more information, see “System 
Administration—Inetd and Inetd Admin”.

Jconfig     Jconfig is a remote configuration tool that system administrators 
can use to configure the Hummingbird™ applications on any network host 
running a Jconfig Daemon. Jconfig offers a variety of configuration options. 
You can create application-specific profiles for users, install shortcuts on 
user desktops, monitor and log user activities, and send messages to user 
machines. As well, you can use Jconfig to configure remote PCs one at a 
time or to create script files that, when played, customize the configuration 
of multiple remote PCs. For more information, see “System 
Administration—Sconfig and Jconfig”.

Sconfig     Sconfig is a wizard that lets you customize the installation of 
software on local and network machines. With Sconfig, you can configure 
the install in the following ways:

• Customize the folders installed by Setup.

• Tailor the list of applications or components to be installed. You can 
alter the list to limit the functionality available to users, or to optimize 
the use of disk space.
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• Simplify user input during the installation by pre-selecting information 
such as the names of the directories where the software is installed.

SOCKS Information     This link in the Star t menu launches an HTML file 
that contains information on what SOCKS is, what it does, and how to use 
it. 

Update Hummingbird     Use this application to install the latest patch to 
your product. For more information, see your installation chapter.

Web Update     Use this application to modify the connection settings for 
updating the product. This application is not available if you performed a 
personal installation without Administrator privileges. Instead, an HTML 
file is created that links to a Web site for Hummingbird updates.

Note: For more information, see “System Administration—Sconfig 
and Jconfig.”
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Installation Troubleshooting

The following are common installation issues and questions along with 
suggested solutions. For further assistance with troubleshooting issues, 
contact Hummingbird Technical Support.

Another instance of the Hummingbird Setup Wizard is 
running (Error 2803)
Solutions:

• If a product is not currently being installed, you can ignore this error 
message and run:

Setup /v"HCL_OVERRIDE_INSTANCE=1"

The message also appears if a non-privileged user tries to uninstall a 
product installed for “All Users” of the computer. In this case, the setup 
parameter does not work since only an Administrator of the computer 
can uninstall the product.

• This error message may display if installer is unable to remove a key 
created by the Setup Wizard. This may be because Setup Wizard 
encountered problems during a previous installation and the key was 
not removed.

Delete the following keys from the registry:

//HKEY_CURRENT_USER/Software/Hummingbird/Connectivity
/<version>/installer/UserIni/InstallActive=1

//HKEY_USERS/biglongnumberhere/Software/Hummingbird/
Connectivity/<version>/installer/UserIni/InstallActive=1

Problems repairing user files
If the user directory is accidently deleted, the user file may not be repaired 
properly. In this case, if a program does not start, try removing the UserFiles 
registry key in HKEY_CURRENT_USER or HKEY_LOCAL_MACHINE depending on 
whether or not the product is installed for “All Users”.
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The feature you are trying is on a network resource that is 
unavailable
Solutions: 

• Click OK in the warning dialog box and try again.

• Enter an alternate path to the folder containing the installation package 
“Hummingbird NFS XXX.msi”. Run the install again, then choose repair.

Windows installer has found incompatible software on your 
system
If you install version 7.x software (Exceed or NFS Maestro) and older 
versions of Hummingbird software exist on your system (for example 
versions 6.2 or earlier), you get the above warning message. Windows 
Installer will try to remove the older software, but in some cases this is not 
possible. Try to manually remove the software.

When trying to uninstall, Setup Wizard asks for the location 
of an .msi file
Solution: To perform the uninstall, the installation CD should be in the 
drive.

Patch - Sourcedir not found (when trying to install patch)
This means the source files are unavailable.  When installing a patch, you 
need to have the source from which you installed. The original product CD 
must be in the drive.

After installation the software does not work—services are 
not starting and/or files are missing
Solution: Ensure the Administrator account is used to perform the 
installation. For Windows NT/2000, installing HostExplorer and NFS 
Maestro Client requires Administrator privilege. Installing Exceed requires 
elevated privilege (that is, a user who is a member of the Administrator 
group).
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When trying to install the product, a message says I must 
uninstall it
Solution: You have an old version of one or more products installed. You 
will require version 7.x to install all products.

Are there other command line options for Msiexec?
For more detailed 
information about 
Msiexec command line 
options, see the Windows 
Installer documentation in 
the MSDN online Library at 
msdn.microsoft.com
or on CD-ROM via 
subscription.

The following are command line options for Msiexec:  

Option Meaning 

/i Package|ProductCode Installs or configures a product. 

/f Package|ProductCode Repairs a product. For more information about 
various flags available for this option, see the 
MSDN Library.

/a Package Administrative installation option. Installs a product 
on the network. 

/x Package|ProductCode Uninstalls a product. 

/j Advertises a product. For more information about 
various flags available for this option, see the 
MSDN Library.

/L Logfile Specifies path to log file and the flags indicate 
which information to log. For more information 
about various flags available for this option, see the 
MSDN Library.

/m filename Generates an SMS status .mif file and must be 
used with the install (-i), remove (-x), administrative 
installation (-a), or reinstall (-f) options. For more 
information about this option, see the MSDN 
Library.

/p PatchPackage Applies a patch. For more information about this 
option, see the MSDN Library.

/q Sets user interface level. For more information 
about various flags available for this option, see the 
MSDN Library.
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How does one create an installation log file (installer error 
1631)?
To generate a log file, users should run the following command:

setup /v"/I* C:\install_log.txt"

where C:\ is the path to plaintext file install_log.txt.

/? Displays copyright information for the Windows 
Installer.

/h

 /y module Calls the system API DllRegisterServer to self-
register modules. For more information about this 
option, see the MSDN Library.

 /z module Calls the system API DllUnRegisterServer to 
unregister modules. For more information about 
this option, see the MSDN Library.

Option Meaning 
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